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Preface

Preface
This preface introduces information sources that can help you use the application and this guide.

Using Oracle Applications  

To nd guides for Oracle Applications, go to the Oracle Help Center at hp://docs.oracle.com/.

Documentation Accessibility  

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website.

Contacting Oracle  

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For
information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to:
oracle_fusion_applications_help_ww_grp@oracle.com.

i

http://docs.oracle.com/
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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1  What's New in This Release

What’s New in Siebel Object Types Reference, Siebel CRM
20.1 Update  
The following information lists the changes in this revision of the documentation to support Siebel CRM 20.1 Update.

Topic Description

About the Precision and Scale Properties
 

Updated topic. Updated the descriptions of the Precision and Scale properties.
 

What’s New in Siebel Object Types Reference, Siebel CRM
19.1 Update  
No new features have been added to this guide for this release. This guide has been updated to reect only product
name changes.
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2  Overview of Using Siebel Object Types
Reference

Overview of Using Siebel Object Types Reference  
This chapter describes an overview of Siebel Object Types Reference. It includes the following topics:

• Conventions This Book Uses to Describe Object Types

• Common Object Properties

• Object Types That You Must Not Modify

• Alphabetic List of Object Types

Conventions This Book Uses to Describe Object Types  
This book uses the following conventions:

• Each object type includes a table that describes the properties that the object type includes. The Property
column in these tables includes one of the following values:

• (R) Required. You must include a value for this property.

• (O) Optional. You are not required to include a value for this property.

• (S) System. Siebel CRM creates a value that you cannot modify.

• (H) Hidden. Identies object types and properties that the Siebel Web Client does not use. Siebel CRM hides
these items in the client and does not display them in the Object Explorer in Siebel Tools. If Siebel CRM hides an
object type, then it also hides the properties of this object type. To display these hidden items and other object
types in the Object Explorer, see the topic about displaying object types in  Using Siebel Tools .

• If you spell an object name, then you must use the same spelling that this book uses for this object name.

• A constant is case-sensitive. You typically use all uppercase characters to spell it. For example, TRUE or FALSE
for a Boolean eld.

A user is a person who uses the client of a Siebel CRM application to use Siebel CRM data.

The client is the client of a Siebel CRM application.

The server is the Siebel Server, unless noted otherwise.

An administrator is anyone who uses the administrative views in the client to congure Siebel CRM.

Computer font indicates a value you enter or text that Siebel CRM displays. For example:

This is computer font

A predened object is an object that comes dened with Siebel CRM. The objects that Siebel Tools displays in the
Object List Editor immediately after you install Siebel Tools and the Siebel runtime repository but before you make any
customizations are predened objects.
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Siebel Tools can display the value for the property of an object type in one of the following ways:

• Statically in a dropdown list or dialog box.

• Dynamically in a dropdown list or dialog box.

• Text entry.

• With a check mark.

• As a link.

To view the full list of values that you can use for most properties, you can click the dropdown list that Siebel Tools
displays if you click anywhere in the value eld of the property. This book does not describe every property value you
can choose. It describes only the property values that require elaboration.

This book describes only reference information about object types. For information about how to use object types to
congure Siebel CRM, see  Conguring Siebel Business Applications .

Your Siebel CRM application might not include all the features that this documentation describes, depending on the
software modules that your company purchases.

Dierences That Exist Between the Properties Window and the
Object List Editor  
In most situations, the properties and values that Siebel Tools displays for an object denition in the Properties Window
and the Object List Editor are identical. There are some dierences:

• The Properties Window sometimes uses an abbreviated label for a property. For example, the Properties
Window uses Workow Component, and the Object List Editor uses Workow Policy Component to describe the
same property of the assignment aribute column object type.

• The Properties Window might not include every property. For example, it does not include the Project property
for some object types.

• The Object List Editor might not include every property.

If dierences exist, then this book describes Object List Editor usage unless noted otherwise.

Geing Help From Oracle  
If you require help from Oracle for using object types, you can create a service request (SR) on My Oracle Support.
Alternatively, you can phone Global Customer Support directly to create a service request or get a status update on
your current SR. Support phone numbers are listed on My Oracle Support. You can also contact your Oracle sales
representative for Oracle Advanced Customer Services to request assistance from Oracle's Application Expert Services.

Common Object Properties  
The following table describes object properties that are common for many dierent object types. Their meaning and
usage is the same for these object types. If an object type includes a property, then, for brevity, the table describes the
properties for this object type might not include this property.

4
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Property Description

Application Code
 

Reserved for future use.
 

Changed (S)
 

If you edit a record, then Siebel Tools adds a check mark in the Changed property. This check mark
indicates that you modied this object denition since the date and time that you specify in the
General tab of the Development Options dialog box. If the Changed property does not include a check
mark, then no modication has occurred. For more information, see  Using Siebel Tools .
 

Comments (O)
 

Includes text that describes the object denition. This text helps the developer to understand
how Siebel CRM uses this property. It does not aect Siebel CRM functionality in any way. It is for
documentation purposes only.
 

Description (S)
 

Includes text that describes the object denition. This text helps the developer to understand
how Siebel CRM uses this property. It does not aect Siebel CRM functionality in any way. It is for
documentation purposes only.
 

GParent, GGParent (S)
 

Species the name of the grandparent or great-grandparent object denition. Siebel Tools creates the
value that this property contains. It displays this property only in the Object List Editor and only if you
click the Flat tab in the Object Explorer.
 

ICL Upgrade Path (S)
 

Identies the releases that Siebel CRM sets for the Upgrade Behavior property to Preserve for ICL
(Incorporate Custom Layout) user interface objects. For more information about ICL, see  Siebel
Database Upgrade Guide .
 

Inactive (O)
 

If this property includes a check mark, then Siebel Tools does not compile this object denition when
you deploy your changes to the Siebel runtime repository and it does not allow other objects to
reference it.
 

Language Code (R)
 

The abbreviation for the language that Siebel Tools uses for this object denition. For example, you can
use the following value for U.S. English:
 

ENU

Module
 

Reserved for future use.
 

Object Language Locked
 

The abbreviation for the language that Siebel Tools uses for this locked object. For example, ENU for
U.S. English. For more information about object and project locking, see  Using Siebel Tools .
 

Object Locked
 

If this property includes a check mark, then the object denition is locked.
 

Object Locked by Name
 

Contains the user name of the developer who locked the object denition.
 

Object Locked Date
 

Contains the date when the developer locked the object denition.
 

Parent Name, Parent object_defn_name
(S)
 

Contains the parent name of the current object denition. Siebel Tools creates this value.
 
The Parent Business Component property of the Link object type is dierent from the parent property
for other object types. If you create a new link object, then you must enter a value in the Parent
Business Component property.
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Property Description

Project (R)
 

Identies the project that the object denition references.
 

Redo (O)
 

Describes a single-level redo of a eld modication or a record modication. The Locale Management
Utility uses this property to track locale-specic modications.
 

Repository Name (S)
 

Identies the repository that includes the object denition.
 

String Override (O)
 

A language-independent override of the String Reference property. If a value exists in the String
Reference property, then Siebel Tools uses this value instead of the value that the String Reference
property contains.
 
Siebel Tools displays a string override as property_name -String Override. For example:
 

Display Name - String Override

String Reference (R)
 

References a symbolic string.
 
Siebel Tools displays a string reference as property_name -String Override. For example:
 

Display Name - String Override

For example, the Title - String Reference property contains SBL_ACCOUNTS-1004224727-0H5 for the
Account List Applet. This string reference references a symbolic string locale. The ENU string value for
this locale is Accounts.
 

Tooltip Text
 

Obsolete. You must not use this property.
 

Translate (S)
 

The Locale Management Utility uses this property to track modications that occur to localization. This
property is for Oracle use only.
 

Upgrade Ancestor (S)
 

You can use this property to make sure that the Application Upgrader upgrades an object that you
copy in the same way that it upgrades the original object. For example, assume you make a copy of the
Account business component, and then name it ESG Account. You set the Upgrade Ancestor property
of the ESG Account business component to Account. This value congures the Application Upgrader to
upgrade the ESG Account business component in the same way that it upgrades the Account business
component.
 

Upgrade Behavior (S)
 

Determines if Siebel CRM preserves a user interface object for ICL (Incorporate Custom Layout)
handling when it does a repository merge. You can use one of the following values:
 

• Admin. The object is never eligible for ICL handling and Siebel CRM ignores it.

• Non-Preservable. The object is not eligible for ICL handling for an upgrade for the current release.
Siebel CRM might modify this value to Preserve in a subsequent release.

• Preserve. The object is eligible for ICL handling.

Oracle sets the value of the Upgrade Behavior property and the ICL Upgrade Path property for each
release. You must not modify these values.
 
For more information about ICL, see  Siebel Database Upgrade Guide .
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About the Precision and Scale Properties  
The Precision property of an object type species the total number of digits that can exist to left and right of the
decimal point for a numeric eld:

• A noninteger column can include a total of 22 digits.

• An integer column can include a total of 10 digits.

The Scale property of an object type species the maximum number of digits that can exist to the right of the decimal
point for a numeric eld:

• A numeric column can include a total of 7 digits to the right of the decimal point.

• An integer column cannot include any digits to the right of the decimal point.

For example, if the precision for a number is 6, and the scale is 2, then this eld can represent a number that uses the
following format:

9999.99

Other examples follow:

Precision 4, scale 2: 99.99
Precision 10, scale 0: 9999999999
Precision 8, scale 3: 99999.999
Precision 5, scale -3: 99999000

Formats You Can Use With an Accelerator Object Type  
This topic describes the format that you can use with an Accelerator or Accelerator Locale. A menu or toolbar item
might include a command eld. If this command eld includes a command that uses an accelerator that you dene,
then Siebel CRM uses this accelerator. You can use one of the following formats:

• modier + name

• modier_1 + modier_n + name

• accelerator

where:

• modier is Ctrl, Alt, or Shift.

• name is 0 through 9, A through Z, F 0 through 24, a key_code, or a constant.

• key_code is a three-symbol decimal code, such as 128, or a four-symbol hex number, such as 0x10.

• constant is INSERT, DEL, LEFT, RIGHT, UP, DOWN, HOME, END, PAGEUP, PGUP, PAGEDOWN, PGDN, SPACE,
TAB, or ENTER.

For example, you can use the following formats:

• Ctrl+F10

• Alt+A

• Ctrl+ INSERT

• Ctrl+Alt+0x221

The syntax is not case-sensitive.
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Modifying Undocumented User Properties  
You can only modify a user property that is documented. For example, you can modify a user property for an applet that
references the CSSFrameBrowser class. Only Oracle can create or delete a user property that is not documented. For
more information, see  Siebel Developer's Reference .

Object Types That You Must Not Modify  
This topic lists object types that Siebel CRM uses to manage the repository or that are for internal Oracle use only. You
must not modify or delete any of these objects. For help with using these object types, see the following.

You must not modify any object type that this topic lists. Any modication can adversely aect Siebel CRM performance
and operation.

Object Types That the Siebel Enterprise Integration Manager Uses 

The Siebel Enterprise Integration Manager Wizard uses the following object types:

• Aribute

• Aribute Mapping

• EIM Explicit Primary Mapping

• EIM Interface Table

• EIM Interface Table Column

• EIM Table Mapping

• Foreign Key Mapping

• Foreign Key Mapping Column

• Interface Table User Key Usage

• User Key

• User Key Aribute

• User Key Aribute Join

• User Key Aribute Tree Node

• User Key Column

Object Types That Information Access Uses  
Information access uses the following object types. Instead of modifying these objects, it is recommended that you use
the Dock Object Wizard to create a new object:

• Dock Object

8
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• Dock Object Related DObj

• Dock Object Table

• Dock Object Visibility Rule

Object Types That Server Components Use  
Server components use the following object types:

• Server Component Event Subtype

• Server Component Event Type

• Server Component Parameter

• Server Component State Value

• Server Component Statistic

• Server Component Subsystem

• Server Component Type

Miscellaneous Object Types  
You must not modify any of the following object types:

• Class

• Class Method

• Class Method Menu Item

• Class Method Menu Item Locale

• DLL

• Repository. If you migrate a repository, then you can modify the repository name.

• String (H)

• String Map (H)

• Aribute

Alphabetic List of Object Types  
The following list includes all object types that this book describes:

• Accelerator

• Accelerator Locale

• Applet Locale

• Applet User Prop

9



Siebel
Object Types Reference

Chapter 2
Overview of Using Siebel Object Types Reference

• Applet Web Template

• Applet Web Template Item

• Applet Web Template Item Locale

• Application

• Application Browser Script

• Application Event Services

• Application Find

• Application Locale

• Application Method Menu Item (H)

• Application Method Menu Item Locale (H)

• Application Server Script

• Application Toolbar (H)

• Application User Prop (H)

• Assignment Aribute

• Assignment Aribute Column

• Assignment Object

• Assignment Object Extension

• Assignment User Prop

• Assignment Criteria

• Assignment Criteria Aribute

• Assignment Criteria Aribute Locale

• Assignment Criteria Locale

• Aribute

• Aribute Mapping

• Bitmap

• Bitmap Category

• Bitmap Locale

• BusComp Browser Script

• BusComp Server Script

• BusComp View Mode

• Business Component

• Business Component User Prop

• Business Object

• Business Object Component

• Business Service

• Business Service Browser Script

10
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• Business Service Locale

• Business Service Method

• Business Service Method Arg

• Business Service Method Arg Locale

• Business Service Method Arg User Prop

• Business Service Method Locale

• Business Service Server Script

• Business Service Subsystem

• Business Service User Prop

• Class

• Class Method

• Class Method Menu Item

• Class Method Menu Item Locale

• Class User Prop

• Class User Prop Value

• Column

• Command

• Command Locale

• Content Object

• Content Object View

• Chart

• Chart Element

• Chart Element Locale

• Chart Locale

• Control

• Control Locale

• Control User Prop

• Drilldown Object

• Drilldown Object Locale

• Dynamic Candidate (H)

• Dynamic Candidate Aribute (H)

• Dynamic Candidate Component (H)

• Dynamic Candidate Component Col (H)

• Dynamic Candidate Locale (H)

• Dynamic Drilldown Destination

• Data Source (H)

11
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• DLL

• Dock Object

• Dock Object Related DObj

• Dock Object Table

• Dock Object Visibility Rule

• EIM Explicit Primary Mapping

• EIM Interface Table

• EIM Interface Table Column

• EIM Table Mapping

• Entity

• Entity Aribute (H)

• Entity Physical Relation (H)

• Entity Relation

• Entity Relationship Diagram

• External Search Engine (H)

• Field

• Field Locale

• Field User Prop

• Find

• Find Field

• Find Field Locale

• Find Locale

• Find Pick View

• Find View

• Foreign Key Mapping

• Foreign Key Mapping Column

• Help Id

• HTML Hierarchy Bitmap

• Icon

• Icon Map

• Import Aux Field

• Import Field

• Import Field Column

• Import Field Locale

• Import Field Map

• Import Key Field
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• Import Object

• Import Source

• Index

• Index Column

• Integration Component

• Integration Component Field

• Integration Component Field User Prop

• Integration Component Key

• Integration Component Key Field

• Integration Component User Prop

• Integration Object

• Integration Object User Prop

• Interface Table User Key Usage

• Join

• Join Constraint

• Join Specication

• Link

• List

• List Column

• List Column Locale

• List Column User Prop

• List Locale

• Menu

• Menu Item

• Menu Item Locale

• Message

• Message Category

• Message Locale

• Multi Value Field

• Multi Value Link

• MVF Pick Map

• MVF Pick Map UpdOnlyIfNull

• Page Tab

• Page Tab Locale

• Pager Object

• Pick List
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• Pick Map

• Pick Map UpdOnlyIfNull

• Project

• Repository

• Screen Menu Item

• Screen Menu Item Locale

• Schema Maintenance

• Screen

• Screen Locale

• Screen View

• Screen View Locale

• Server Component Event Subtype

• Server Component Event Type

• Server Component Parameter

• Server Component State Value

• Server Component Statistic

• Server Component Subsystem

• Server Component Type

• Single Value Field

• String (H)

• String Map (H)

• SVF Pick Map

• SVF Pick Map UpdOnlyIfNull

• Symbolic String (H)

• Symbolic String Locale

• System Activity Object

• Table

• Task

• Task Branch

• Task Branch Criteria

• Task Branch Criteria Value

• Task Chapter

• Task Chapter Locale

• Task Event

• Task Event IO Argument

• Task Group

14
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• Task Group Item

• Task Group Locale

• Task Locale

• Task Metric

• Task Property

• Task Step

• Task Step Context

• Task Step IO Argument

• Task Step Locale

• Text Style (H)

• Toolbar

• Toolbar Item

• Toolbar Item Locale

• Toolbar Locale

• Tree

• Tree Node

• Tree Node Locale

• Type

• User Key

• User Key Aribute

• User Key Aribute Join

• User Key Aribute Tree Node

• User Key Column

• View

• View Locale

• View Task Group

• View Task Group Locale

• View User Prop (H)

• View Web Template

• View Web Template Item

• View Web Template Item Locale

• Web Page

• Web Page Item

• Web Page Item Locale

• Web Page Item Parameter

• Web Page Locale (H)
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• Web Template

• WF Branch Connector (H)

• WF Branch Criteria (H)

• WF Branch Criteria Value (H)

• WF Process Metric

• WF Process Prop

• WF Step

• WF Step Branch (H)

• WF Step I/O Argument (H)

• WF Step Recipient (H)

• Workow Policy Column

• Workow Policy Component

• Workow Policy Component Col

• Workow Policy Object

• Workow Policy Program

• Workow Policy Program Arg

• Workow Process
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3  Siebel Object Types Reference

Siebel Object Types Reference  
This chapter describes Siebel Object Types. It includes the following topics. This is the same list of topics that the Object
Explorer displays in Siebel Tools:

• Applet Object Types

• Application Object Types

• Assignment Aribute Object Types

• Assignment Criteria Object Types

• Bitmap Category Object Types

• Business Component Object Types

• Business Object Object Types

• Business Service Object Types

• Class Object Types

• Command Object Types

• Content Object Types

• DLL Object Type

• Dock Object Object Types

• EIM Interface Table Object Types

• Entity Relationship Diagram Object Types

• External Search Engine Object Type

• Find Object Types

• Help ID Object Type

• HTML Hierarchy Bitmap Object Type

• Icon Map Object Types

• Import Object Object Types

• Integration Object Object Types

• Link Object Type

• Menu Object Types

• Message Category Object Types

• Pager Object Type

• Link Object Type

• Pick List Object Type

• Project Object Type

• Repository Object Type

• Schema Maintenance Object Types
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• Screen Object Types

• Server Component Object Types

• String Object Types

• Symbolic String Object Types

• System Activity Object Object Types

• Table Object Types

• Task Object Types

• Task Group Object Types

• Text Style Object Types

• Toolbar Object Types

• Type Object Types

• View Object Types

• Web Page Object Types

• Web Template

• Workow Policy Column Object Type

• Workow Policy Object Types

• Workow Policy Program Object Types

• Workow Process Object Types

Applet Object Types  
This topic describes the Applet object type and the object types that are children of an applet. It includes the following
topics:

• Applet

• Applet Browser Script

• Applet Locale

• Applet Message

• Applet Message Locale

• Applet Message Variable

• Applet Message Variable Locale

• Applet Method Menu Item

• Applet Method Menu Item Locale

• Applet Script (H)

• Applet Server Script

• Applet Toggle

• Applet User Prop

• Applet Web Template

• Applet Web Template Item
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• Applet Web Template Item Locale

• Chart

• Chart Element

• Chart Element Locale

• Chart Locale

• Control

• Control Locale

• Control User Prop

• Drilldown Object

• Drilldown Object Locale

• List

• List Column

• List Column Locale

• List Column User Prop

• List Locale

• Tree

• Tree Node

• Tree Node Locale

Applet  
An applet allows the user to view, enter, and modify data that the applet gets from a single business component. It
includes the following qualities:

• Occupies a section of a view

• Composed of controls, such as buons, elds, check boxes, and other types of controls, such as buons that
call a method or an ActiveX control

• Allows the user to view, enter, modify, and navigate through records

• Can display as a form, list of records, chart, business graphics, or navigation tree

• Allows data entry for a single record or through a scrolling table that Siebel CRM displays multiple records

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet

The following table describes properties that Siebel CRM uses with an applet.

Property Description

Associate Applet (O)
 

Species the name of an applet that relates data from two dierent entities. It uses a many-to-many
relationship.
 
Siebel CRM can associate rows from entity B with rows from entity A, where entity B is an association
applet that includes a many-to-many relationship and entity A is the main applet.
 
You can specify an association list applet.
 

19



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

Auto Query Mode (O)
 

You can use one of the following values:
 

• New Query. Deletes the business component search specication, deletes the predened query
for the business object, and sets the business component to Query mode. Automatically displays
the applet in Query mode.

• Rene Query. Uses the existing search specications and predened queries.

Background Bitmap (O)(H)
 

The bitmap that Siebel CRM displays in the applet background. You can specify the object denition for
any applet background bitmap.
 

Background Bitmap Style (O)(H)
 

Species how Siebel CRM arranges the background bitmap. You can use one of the following values:
 

• Center. Display the image centered in the middle of the background.

• Stretch. Stretch the image so that it covers the entire background.

• Tile. Display multiple copies of the image so that it covers the entire background.

Business Component (O)
 

Species the name of the business component that includes the data that Siebel CRM displays.
 
A view that uses an applet references a business object. This business object must include a business
object component that references the business component that includes the data that Siebel CRM
must display.
 

Class (O)
 

Species the name of a C++ class that Siebel CRM uses to manage the applet. You can use one of the
following values:
 

• CSSFrame. Form applet.

• CSSFrameChart. Chart applet.

• CSSFrameList. List applet.

• CSSFrameTree. Tree applet.

You can also use a specialized applet class. For example:
 

• CSSFrameListAachment

• CSSFrameListActivity

Default Applet Method
 

Species the method that runs if the user presses the Enter key in the applet.
 

Height (R)(H)
 

Species the vertical size of the applet in sector units. You can use one of the following values:
 

• 1

• 2

• 3

• 4

Help Identier (O)
 

Not used.
 

HTML Number of Rows (O)
 

Species the number of rows that Siebel CRM displays in a list applet. If the HTML Number of Rows
Property property is empty, then Siebel CRM uses the value of the NumberOfListRows parameter in the
application conguration le. This parameter sets the default number of rows for the list applets that
this application displays. If the NumberOfListRows parameter is also not specied, then Siebel CRM
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Property Description

sets the default value to 10. In some Siebel CRM versions, the default value for some applets might
equal seven.
 

HTML Popup Dimension (O)(H)
 

Species the dimension in pixels of the pop-up dialog box. You use the following format:
 

numberxnumber

where:
 

• x is lower case.

You cannot include empty spaces.
 
For example:
 

640x480

ICL Upgrade Path
 

For more information, see Common Object Properties.
 

Insert Applet (O)
 

Not used.
 

Insert Position (O)
 

Species the position where Siebel CRM creates a new record. You can use one of the following values:
 

• BEFORE. Before the current record.

• AFTER. After the current record.

• FIRST. After rst record.

• LAST. After last record.

Mail Address Field (O)
 

Species the default email recipient that Siebel CRM displays in the Message Properties dialog box. It
uses the list of recipients in the applet user properties. For example:
 

Email Address

Where:
 

• Email Address is a business component eld.

Mail Template (O)
 

Species the text le that Siebel CRM uses to ll in data in the default email message. It can include the
following placeholder that uses a substitution value for a eld:
 

%field%

The contents of the C:\Siebel\MSGTEMPL directory determines the list of mail templates that
are available.
 

Name (R)
 

Species the name of the applet. The name can include spaces. It must be unique among applets. Any
object that references an applet references the applet name. For example:
 

Account Form Applet

No Delete (O)
 

Species if Siebel CRM can delete a row in an applet. You can use one of the following values:
 

• TRUE. No row deletion allowed.
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Property Description

• FALSE. Row deletion allowed.

No Insert (O)
 

Species if Siebel CRM can insert a row in an applet. You can use one of the following values:
 

• TRUE. No row insertion allowed.

• FALSE. Row insertion allowed.

No Merge (O)
 

Species if Siebel CRM can merge a row in an applet. You can use one of the following values:
 

• TRUE. No row merge allowed.

• FALSE. Row merge allowed.

No Update (O)
 

Species if Siebel CRM can update a eld in an applet. You can use one of the following values:
 

• TRUE. No eld update allowed.

• FALSE. Field update merge allowed.

Popup Dimension (O)(H)
 

Species the size of the pop-up applet. This text property is valid only for association, pick, multivalue
group, and detail applets. You can use the following format:
 

W X H

where:
 

• W is the width in pixels.

• H is the height in pixels.

• X is upper-case.

• A space must precede and follow the X.

For example:
 

512 X 220

Scripted (S)
 

Species if a Siebel VB or Siebel eScript script is aached to the applet. It can include of the following
values:
 

• TRUE. Script aached.

• FALSE. No script aached.

Search Specication (O)
 

Species a conditional expression that Siebel CRM uses to restrict the records it gets from the business
component that the applet references. For example:
 

[Service Flag] = ‘Y’

For more information, see How Siebel CRM Uses an Applet Search Specication.
 

Task
 

Species the name of the Task object for an applet that a task uses. For example:
 

Asset To Contract Task

Text Style (O)(H)
 

Species a text style for all controls that the applet includes. Siebel CRM uses this value by default
only if the control does not specify a text style. If you do not specify a value for the Text Style property,
 then Siebel CRM uses the text style that the Browser species or that the .css les for the Siebel CRM
application species.
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Property Description

 

Title (O)
 

Species the text that Siebel CRM uses for the applet title. For example:
 

Account

Type (O)
 

Species the type of the applet.
 

Upgrade Behavior
 

For more information, see Common Object Properties.
 

Width (R)(H)
 

Species the horizontal size of the applet in sectors. You can use one of the following values:
 

• 1

• 2

How Siebel CRM Uses an Applet Search Specication  
An applet search specication is a search specication that resides in the Search Specication property of an applet.
If an applet includes a search specication, and if the business component that the applet references includes a
search specication, then Siebel CRM appends the applet search specication to the end of the value in the Search
Specication property of this business component. It does not use the applet search specication to override the search
specication on this business component.

If the user navigates to an applet that does not include a search specication, then Siebel CRM does not requery or use
the existing search specication except in the following situations:

• The user navigates from a parent applet to a child applet. It uses an empty applet search specication.

• Siebel CRM modies the visibility mode of the parent applet. It uses the applet search specication even if this
search specication is empty.

If multiple applets in one view reference the same business component, then you must not specify dierent applet
search specications. You must make sure all of these applets use the same search specication or that all of these
applet search specications are empty.

An applet search specication can modify the query context for a user who performs a query.

Applet Browser Script  
An applet browser script denes the browser script that an applet uses. For more information, see  Siebel Object
Interfaces Reference .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Browser Script

The following table describes properties that Siebel CRM uses with an applet browser script.
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Property Description

Browser Group (O)
 

Not used.
 

Name (S)
 

Species a unique name for the script record. For example:
 

Applet_ChangeRecord_All

You must not modify this property. To create a value for this property, Siebel Tools combines the User
Agent and Procedure properties.
 

Procedure (O)
 

Species the applet name that Siebel CRM uses to upgrade the current applet during the next
repository merge. It typically uses the ancestor applet that this property species as the source to
create a new applet.
 

Script (O)
 

Text for the function.
 

Applet Locale  
An applet locale denes a language override that Siebel CRM uses with an applet.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Locale

The following table describes properties that Siebel CRM uses with an applet locale.

Property Description

Name (R)
 

The language abbreviation that the Siebel CRM application uses. For example:
 

ENU

Title (O)
 

The text that Siebel CRM uses for the applet title for a language.
 

Applet Message  
An applet message allows Siebel CRM to combine static text with dynamic data, such as the value from a business
component eld. If you bind an applet message to an applet control, then Siebel CRM displays this message as a read-
only, translated string that includes dynamic data. For more information about conguring an applet message, see 
Siebel Business Process Framework: Task UI Guide .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Message

The following table describes properties that Siebel CRM uses with an applet message.
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Property Description

Name (R)
 

Species the name for the applet message. You can use this name and the Field picklist to bind the
applet message to a control.
 

Text Message (R)
 

Species the text message. It references a symbolic string that includes static text and placeholders for
dynamic data. A placeholder uses the following format:
 

%n

 

where:
 

• n is a number.

For example:
 

Here is the tracking number for your case: %1 

Text Message - String Override
 

Species the override message of a symbolic string. This override is for a text message.
 

Applet Message Locale  
An applet message locale denes language overrides that Siebel CRM uses with an applet message.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Message > Applet Message Locale

The following table describes properties that Siebel CRM uses with an applet message locale.

Property Description

Language Code (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Text Message (R)
 

Species the string that Siebel CRM uses for the Applet Message.
 

Applet Message Variable  
An applet message variable includes a list of business component elds and their corresponding numerical key. Siebel
CRM uses this numerical key to identify the placeholder it must replace in the parent applet message.

For example, assume the following applet message:

Here is the tracking number for your case: %1. 
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The Applet Message Variable that Siebel CRM uses for the Case Id business component eld in this example is a value of
1. At runtime, if the value of Case Id is 12-ABCX, then the Applet Message contains the following value:

Here is the tracking number for your case: 12-ABCX. 

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Message > Applet Message Variable

The following table describes properties that Siebel CRM uses with an applet message variable.

Property Description

Field (R)
 

Species a eld from the business component that the applet references.
 

Field - Language Override (O)
 

Species the language that Siebel CRM uses for a eld that is dierent from the language that the
Siebel CRM application uses.
 

Value (R)
 

Species a numeric value for the eld value that Siebel CRM replaces at runtime. This value must
correspond to one of the placeholders in the text of the parent applet message.
 

Applet Message Variable Locale  
An applet message variable locale denes a language override that Siebel CRM uses with an applet message variable.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Message > Applet Message Variable > Applet Message Variable Locale

The following table describes properties that Siebel CRM uses with an applet message variable locale.

Property Description

Field (O)
 

Species the name of an alternative eld that Siebel CRM uses if the value of the Name property is the
active locale.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Applet Method Menu Item  
An applet method menu item denes the applet menu that Siebel CRM displays if the applet is activate. You must write
script in the PreInvokeMethod event handler that examines the method string and performs an action. If this string
does not exist, then an error occurs. For more information, see  Siebel Object Interfaces Reference .
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Method Menu Item

The table below describes properties that Siebel CRM uses with an applet method menu item.

Property Description

Command (O)
 

Species the command that Siebel CRM runs if the user chooses an item in an applet menu.
 

Menu Text (R)
 

Species the text that Siebel CRM displays in the menu item.
 

Name (O)
 

Species the name of the menu item in a menu.
 

Position (R)
 

Species the position of the menu item in a menu. This value is an integer.
 

Suppress Menu Item (O)
 

Removes the menu item that the Name property identies from the applet menu. You can use one of
the following values:
 

• TRUE. Suppress the menu item.

• FALSE. Do not suppress the menu item.

Applet Method Menu Item Locale  
An applet method menu item locale denes the language override that Siebel CRM uses with an applet method menu
item.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Method Menu Item > Applet Method Menu Item Locale

The following table describes properties that Siebel CRM uses with an applet method menu item locale.

Property Description

Menu Text (R)
 

Species the text that Siebel CRM displays in the menu item for a language.
 

Name (O)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Applet Script (H)  
An applet script denes a Siebel VB script or Siebel eScript script for an applet. Starting with Siebel CRM version 7.0,
applet browser script and applet server script replace applet script.
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This object type occurs in the following location in the object hierarchy:

• Applet > Applet Script

The following table describes properties that Siebel CRM uses with an applet script.

Property Description

Name (R)
 

Species the name of the script.
 

Program Language (O)
 

Species the script programming language. You can use one of the following values:
 

• SBL. Siebel VB.

• JS. Siebel eScript.

Script (R)
 

Species the body of the script. The maximum size of this body is 16KB.
 

Sequence (R)
 

Species the order that Siebel CRM uses to compile scripts that this object contains. This property can
contain only an integer. For example, assume the Sequence property for Script A is 1 and the Sequence
property for Script B is 2. Siebel CRM compiles script Script A rst and then Script B second.
 

Applet Server Script  
An applet server script denes script for a server applet. For more information, see  Siebel Object Interfaces Reference .
Starting with Siebel CRM version 7.0, applet server script replaces applet script and applet web script.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Server Script

The applet server script uses the same properties as the applet script. For more information, see Applet Script (H).

Applet Toggle  
An applet toggle allows the user to navigate back and forth between dierent applets in the same view. For more
information, see  Conguring Siebel Business Applications .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Toggle

The following table describes properties that Siebel CRM uses with an applet toggle.

Property Description

Applet (R)
 

Species the name of the applet that Siebel CRM displays for a static toggle. For example:
 

Activity Form Applet
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Property Description

Auto Toggle Field (O)
 

Species the business component eld for a dynamic toggle. Siebel CRM examines the current value
that this eld contains to the value that the Auto Toggle Value property contains. For example:
 

Item Type BusObj Name

Auto Toggle Value (O)
 

Species the value in the business component eld for a dynamic toggle. If this eld contains the value
that the Auto Toggle Value property species, then Siebel CRM displays the applet. For example:
 

Action

Name (R)
 

Species the name of the applet that Siebel CRM displays. For example:
 

Activity Form Applet

Sequence (O)
 

Species the order that Siebel CRM uses to display this applet for a dynamic toggle. This property can
contain only an integer. For example, assume the Sequence property for Applet Toggle A is 1 and the
Sequence property for Applet Toggle B is 2. Siebel CRM displays Applet Toggle A rst and then Applet
Toggle B second.
 

Applet User Prop  
An applet user prop sends a value to the C++ code that implements specialized applet conguration. Siebel CRM
persists the value that you congure for a user property in the Siebel runtime repository. For more information, see
Object Types That You Must Not Modify.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet User Prop

The following table describes properties that Siebel CRM uses with an applet user prop.

Property Description

Name (R)
 

Species the name of the user property.
 

Value (R)
 

Species the value of the user property.
 

Applet Web Template  
An applet web template does the following:

• Identies the web template that an applet uses.

• Identies external HTML or other markup language les that dene the layout and Siebel Web Engine
interactions for an applet.
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• Includes child applet web template items that dene the mappings between controls or list columns in the
applet and placeholder tags in the web template le.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Web Template

The following table describes properties that Siebel CRM uses with an applet web template.

Property Description

Expression (O)(H)
 

Not used.
 

Name (R)
 

Species the name of this applet web template.
 

Sequence (O)
 

Species the sequence for an edit template. If a user opens multiple Edit pages, then Siebel CRM uses
the sequence number to identify each template.
 
This property can contain only an integer. The starting value for the web template sequence is 0. If
more than one template exists with the same type, then Siebel CRM uses the following sequence:
 

• 0

• 1

• 2

• And so forth

Type (R)
 

Species the mode that Siebel CRM uses for this applet web template. You can use one of the following
values:
 

• Base. Displays the applet in standard read-only mode.

• Edit. Modies existing data in a record. Used with the EditRecord method.

• Edit List. Displays a list applet in a mode where the chosen row or column is editable. You can use
the Edit List mode instead of the BASE mode for a list applet.

• New. Enters data into new records. Used with the NewRecord method.

• Query. Displays the elds that Siebel CRM searches. Used with the NewQuery method.

Web Template (R)
 

Species the web template that Siebel CRM uses to display the applet.
 

Applet Web Template Item  
An applet web template item maps a control or list column to a placeholder ID.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Web Template > Applet Web Template Item

The following table describes properties that Siebel CRM uses with an applet web template item.
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Property Description

Column Span (O)
 

Species the width of an item in a grid form applet. This width contains cells. Each cell is 8 pixels wide
and 8 pixels high.
 
This property can contain an integer that is less than or equal to 120.
 
You must not manually modify this property.
 

Column Span - Language Override (O)
 

Allows you to override the Column Span property if a language locale is active.
 
It can contain an integer that is less than or equal to 120.
 
You must not manually modify this property.
 

Control (R)
 

Species the name of the control or list column. For example:
 

Button Reorder

Expression (O)
 

Species the condition in which Siebel CRM maps this item. For example:
 
Not Siebel Sales
 

Grid Property (R)
 

Species the item type for a grid form applet. If you use the Grid Layout Editor, then Siebel Tools
automatically sets this property. You can use one of the following values:
 

• FormaedLabel

• FormaedHtml

Item Identier (R)
 

Species the ID of the swe:control tag. The Siebel Web Engine uses this property to associate a
control with a position in a web template. To populate this property, you can drag and drop a control in
the Web Applet Layout Editor.
 

Item Identier - Language Override (O)
 

Species the language that Siebel CRM uses for the item identier if this language is dierent from the
language that the Siebel CRM application.
 

Mode (O)
 

Species to use the More/Less feature. It allows an applet to display a limited set of elds. If the user
clicks More/Less, then Siebel CRM displays more elds.
 
A combo box in the toolbar allows you to switch between modes when you edit a layout.
 
You can use one of the following values:
 

• Less. Siebel CRM enters Less in the Mode property for each control you create.

• More. Siebel CRM enters More in the Mode property for each control you create.

Name (R)
 

Species the name of the item. Same as the control property.
 

Namespace - Language Override (O)
 

Not used.
 

Namespace (O)
 

Not used.
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Property Description

Row Span (O)
 

Species the height of an item in a grid form applet. This height contains cells. Each cell is 8 pixels wide
and 8 pixels high.
 
This property can contain an integer that is less than or equal to 100.
 
You must not manually modify this property.
 

Row Span - Language Override (O)
 

Allows you to override the Row Span property if a language locale is active.
 
It can contain an integer that is less than or equal to 100.
 
You must not manually modify this property.
 

Type (R)
 

Species the type of the item. To view the values you can use, click the Type property in Siebel Tools.
 

Applet Web Template Item Locale  
An applet web template item locale denes the language overrides that Siebel CRM uses with an applet web template
item.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Web Template > Applet Web Template Item > Applet Web Template Item Locale

The following table describes properties that Siebel CRM uses with an applet web template item locale.

Property Description

Column Span (O)
 

Allows you to modify the Column Span property if a language or locale is active. This property aects
the Column Span Language Override property of an applet web template item.
 

Item Identier (O)
 

Species the control ID that Siebel CRM maps to the control that the Siebel Web Template for a
language identies.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Namespace (O)
 

Not used.
 

Row Span (O)
 

Allows you to modify the Row Span property if a language or locale is active. This property aects the
Row Span Language Override property of an applet web template item.
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Chart  
A chart displays graphical data in the boundaries of an applet.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Chart

The following table describes properties that Siebel CRM uses with a chart.

Property Description

Bar Colors (O)
 

Species a list of colors for bars or pie slices in an itemized list of red, green, and blue triplets:
 

• The rst triplet species the color for the rst series.

• The second triplet species the color for the second series.

• And so on.

If the list contains more series members than triplets, then Siebel CRM repeats the list of colors.
 
You can specify up to 15 triplets. Each number in a triplet must be between 0 and 255. For example, 128
0 0, 0 128 0, 0 0 128.
 
The following value is the default value:
 

0 255 0,0 0 255,255 0 0,255 0 255,255 255 0,0 255 255,255 0 128,255 128 0,0
 255 128,128 0 255,255 255 128,128 255 255,128 128 64,128 64 128,64 128 128

Category Captions (O)
 

Species the caption for the x-axis.
 

Category Field (R)
 

For more information, see Conguring the Category Field Property of a Chart.
 

Compare (O)(H)
 

Obsolete. Do not use.
 

Data Function (O)
 

Species the operation that Siebel CRM performs on data. You can use one of the following values:
 

• COUNT. Counts the number of records.

• SUM. Sums eld values for all records in the category.

• AVERAGE. Calculates the average value for each record of the eld.

• PLOT. Plots all cell values. If a cell in the logical table does not contain a value, then Siebel CRM
sets the chart value to NULL.

If COUNT is the only data function you must apply to the chart because the Picklist Functions property
is empty, then it is recommended that you do specify a value for the Data Point Field property value.
This conguration can improve performance.
 
For more information, see Conguring the Data Function Property of a Chart.
 

Data Point Captions (O)
 

Species the caption for the y-axis.
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Property Description

Data Point Field (O)
 

Species the eld that contains the data that Siebel CRM plots on the y-axis. If you do not specify this
property, then specify COUNT in the Data Function property.
 
For more information, see Conguring the Data Function Property of a Chart.
 

Editable (O)
 

Obsolete. Do not use.
 

Invert (O)
 

You can use one of the following values:
 

• TRUE. Invert the x-axis, z-axis, labels, and titles. This conguration can be useful to display a
dierent view of the data.

• FALSE. Do not invert the x-axis, z-axis, labels, and titles.

Choosing a By picklist item modies this property except in a time period chart where it modies the
time period on the x-axis.
 

Multi Data Point (O)
 

You can use one of the following values:
 

• TRUE. Plot multiple line-graph curves on the same y-axis according to dierent source eld and
function combinations. Siebel CRM displays the name for each curve in the legend. You must also
set the following properties in the chart object denition:

◦ Data Point Field

◦ Data Function

◦ Picklist Functions

◦ Multi Data Point

• FALSE. Do not plot multiple curves.

Name (R)
 

Species the name of the chart.
 

Period (O)
 

Species a calendar period or a time period that the user denes as the default time period for this
chart. To view the values you can choose, click the Period property in Siebel Tools.
 
If you specify the Period property, then you must set the eld type of the business component eld
that supplies the values for the chart categories to Date or DateTime.
 
The user can dene any time period that the Period business component contains, such as scal
month, quarter, or year. To allow the user to dene a time period in a chart, you must add the Period
business component to the current business object.
 

Picklist Function Captions (O)
 

Species captions for the list of functions that the y-axis uses.
 

Picklist Functions (O)
 

Species the data functions that Siebel CRM lists in the Show picklist in the applet. To suppress a
function in this picklist, do not specify a string in the position of this function. For more information,
 see Conguring the Data Function Property of a Chart.
 
Siebel CRM does not specify a value for this property and does not display this picklist in the applet, by
default.
 
For example:
 

Number of Opportunities, Opportunity Revenue,

34



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

Average Revenue.

Siebel CRM associates each item you enter with a data point eld and data function in a corresponding
position in the Data Point Field property and the Data Function property. It makes this association
according to the order that you use when you enter the items in the Picklist Functions property.
 

Picklist Period Captions (O)
 

Species the captions that Siebel CRM displays for the list of date time periods that the x-axis uses.
 

Picklist Periods (O)
 

Species the time periods that Siebel CRM displays in a picklist in an applet. You enter a comma-
separated list that does not include a space after the comma. For example:
 

Month(Calendar),
Quarter (Calendar), Year(Calendar),Day,Week,Month,
Quarter,Year

If the Picklist Periods property is empty, then Siebel CRM does not display time periods in the picklist in
the client.
 
To allow the user to dene a time period in a chart, you must add the Period business component to
the current business object.
 

Picklist Type Captions (O)
 

Species the captions for the types of charts.
 

Picklist Types (O)
 

Species the chart types that Siebel CRM includes in the picklist in the applet. You enter a comma-
separated list that does not include a space after the comma. For example:
 

2dBar,3dBar

If the Picklist Types property is empty, then Siebel CRM does not display chart types in the picklist in
the client.
 
To display a 2dScaer, 3dScaer, or Combo chart, you must use the Type property. You cannot use the
Picklist Types property to display these chart types.
 
For a list of chart types that you can specify, see the description for the Type property.
 

Selection Based (O)
 

You can use one of the following values:
 

• TRUE. Chart only the currently active record that the business component contains.

• FALSE. Chart all records that the business component contains.

Series Captions (O)
 

Species the caption for the z-axis.
 

Series Field (O)
 

Species the eld that contains the data that Siebel CRM plots on the z-axis. If this property is empty,
then it maps all of the records into a single series. For more information, Conguring the Series Field
Property of a Chart.
 

Type (O)
 

Species the type of chart that Siebel CRM displays. You can use one of the following values:
 

• 2dBar, 3dBar, 2dStackedBar, 3dStackedBar, 2dLine, 3dLine, Combo, 2dHorizBar, 3dHorizBar,
 2dCube, 3dCube

• 3dClusteredBar, 2dPie, 3dPie, 2dDoughnut

• 2dScaer, 3dScaer, 2dSpline, 3dSpline
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To display a combo chart, you must specify a value in the Data Point Field property. Siebel CRM
displays the Sum (Data Function) of this eld on the y-axis and the Count for this eld on the second y-
axis.
 
To display a 2dScaer chart or a 3dScaer chart, you must specify the Coordinates property for the axis
label of the x-axis. For more information, see Chart Element.
 

Use Category MVGroup Data (O)
 

You can use one of the following values:
 

• TRUE. If the category eld is a multivalue group (MVG), then Siebel CRM gets the charting data
from this eld. If you set this property to TRUE, then you cannot use the following properties:

◦ Data Function

◦ Data Point Captions

◦ Data Point Field

• FALSE. Use the value listed in the business component.

Conguring the Category Field Property of a Chart  
If the Category Field property contains:

• The name of a business component eld. Siebel CRM gets the x-axis labels from this eld. To display these eld
values, the By picklist allows the user to choose the x-axis or the z-axis.

• A comma-separated list of eld names. Siebel CRM displays a list of elds in the By picklist in the client. The
value that the user chooses determines the eld that populates the x-axis. The rst value in the comma-
separated list is the default value. You must not use an empty space before or after a eld name. If you specify a
list of x-axis source elds, then you must not use the following properties of the chart element:

◦ Coordinates

◦ Display Format

◦ Divisions

◦ List Of Values

◦ Sort Specication

◦ Text

These properties dene the label for the x-axis. Siebel CRM can use these properties only for one x-axis eld.

If Siebel CRM creates a new business component eld that the chart references, and if it maps this eld to a Calculated
eld in another business component through a multivalue link, and if a category eld uses this new eld for the chart,
then the drilldown on the chart does not work correctly because the Calculated eld cannot preserve the context.

Conguring the Series Field Property of a Chart  
Conguration for the Series Field property of the chart is identical to conguration for the Category Field property
except that the Series Field property applies to the z-axis instead of the x-axis. For more information, see Conguring
the Category Field Property of a Chart.

36



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Conguring the Data Function Property of a Chart  
This topic describes how to congure the Data Function Property for a chart.

Conguring the Show Picklist to Display Field and Function Combinations
You can congure the Show picklist to display a list of eld and function combinations. The item that the user chooses
determines the values that Siebel CRM plots on the y-axis.

To congure the Show Picklist to display eld and function combinations

1. Enter a comma-separated list in the following properties of the chart object:

◦ Data Point Field

◦ Data Function

◦ Picklist Functions

2. Add the following list to the Data Function property. If the Data Function property is empty, or if the value that it
contains is shorter than the value that the Picklist Functions property contains, then Siebel CRM uses this same
list:

Sum,Count,Average,Plot

Conguring Siebel CRM to Plot Multiple Line-Graph Curves on the Same Y-Axis
Siebel CRM can plot multiple line-graph curves on the same y-axis according to dierent source eld and function
combinations. It displays the name for each curve in the legend.

To congure Siebel CRM to plot multiple line-graph curves on the same y-axis

1. Modify the same properties that you modify in Conguring the Data Function Property of a Chart. You also
modify the following properties:

◦ Category Field

◦ Multi Data Point

2. Make sure the Series Field property is empty.
3. In the Data Function property, enter the same comma-separated list that you add in Conguring the Data

Function Property of a Chart.

Conguring Siebel CRM to Display Two Line-graph Curves on Dierent Y-axes
You can congure Siebel CRM to plot one axis to the left of the graph and another axis to the right of the graph.

To congure Siebel CRM to display two line-graph curves on dierent y-axes

1. Specify two functions in the Data Function property of the chart object. Use a comma to separate these
functions.

The rst function denes the left y-axis and the second function denes the right y-axis.
2. Specify two elds in the Data Point Field property.
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Chart Element  
A chart element species one of the static characteristics of a chart, including title, legend, labels, chart body, or axis.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Chart > Chart Element

The following table describes properties that Siebel CRM uses with a chart element. Each property applies to only some
types of chart elements. For more information, see Multi Value Field.

Property Description

Axis Id (O)
 

Species the axis to which subsequent axis elements apply. Applies to the AxisLabel, AxisLineGrid, and
AxisTitle elements. To view the values you can use, click the Axis Id property in Siebel Tools.
 

Color (O)
 

Species color for all elements. In particular, it species color for the following elements:
 

• Sets the text color for elements that contain text.

• Sets the ll color for the Plot element, chart element, and the HorizArea graphic.

• Sets the line color for the Axis Line Grid element and the Line, Rectangle, Ellipse, and HorizLine
graphics.

The value you enter must use the following format:
 

• A space-separated red, green, blue triplet with each value in the range 0 through 255.

Coordinates (O)
 

For more information, see Conguring the Coordinates Property of a Chart Element.
 

Display Format (O)
 

Species the format for the label of the AxisLabel element on the axis that the Axis Id property
species. If this property:
 

• Includes a value. Siebel CRM applies the format string that this property species. It applies this
format to the axis label before it displays the label in the chart.

• Does not include a value. Siebel CRM applies the default format for the Category, Series, or Data
Point Field business component eld that it uses for the x-axis, z-axis, or y-axis.

You can use any format string that the Display Format accepts. For example:
 

0.##%

Divisions (O)
 

Species the number of divisions for the axis that the Axis Id property species. Applies to the
AxisLabel element. It applies to the y-axis. It applies dierently for the following charts:
 

• Scaer chart. Applies to the x-axis and the y-axis.

• Other charts. If the eld values are numbers, then it applies to the x-axis or z-axis.

• Histogram chart. The axis that the Axis Id property species must display numeric data. If it does
not, then Siebel CRM displays labels and does not bucket data. To support a histogram chart, you
must also specify the Coordinates property.

You can use any number greater than 0. If the Divisions property does not include a value, then Siebel
CRM automatically calculates the number of divisions. For example, if the Divisions property includes
the following value, then Siebel CRM draws ve labels on the axis:
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Property Description

4

The Divisions property is required only for the x-axis and z-axis in a histogram chart.
 

Font Eect (O)(H)
 

Species format to apply to the font, such as StrikeThrough. Applies to the AxisLabel, AxisTitle,
 Legend, and Title elements. To view the values you can use, click the Font Eect property in Siebel
Tools.
 

Font Name (O)
 

Species the font name that Siebel CRM uses for the element text. Applies to the Axis Label, Axis Title,
 and Title elements.
 

Font Size (O)
 

Species the font size that Siebel CRM uses for the element text. Applies to the Axis Label, Axis Title,
 and Title elements. Siebel CRM does the following:
 

• If the chart is minimized, and if the screen resolution is 1024 by 768 or higher, then it applies this
font size.

• If the chart is maximized, then it uses a larger font.

• If the screen resolution is lower, then it uses a smaller font.

Font Style (O)(H)
 

Species the font style that Siebel CRM uses for the element text, such as Bold. Applies to the
AxisLabel, AxisTitle, Legend, and Title elements. To view the values you can use, click the Font Style
property in Siebel Tools.
 

Graphic Type (O)
 

Species the type of graphic element that Siebel CRM draws. The Coordinates property species the
graphic geometry. Applies to the Graphic element. To view the values you can use, click the Graphic
Type property in Siebel Tools.
 
If you set the Type property of the chart element to Graphic, then you must set the Graphic Type
property.
 

Line Style (O)
 

Species the line style that Siebel CRM uses for a Graphic or AxisLineGrid element. Applies to the
AxisLineGrid and Graphic elements. Siebel CRM applies this property only if the Line Width property is
0 or is empty. To view the values you can use, click the Line Style property in Siebel Tools.
 

Line Width (O)
 

Species the line thickness that Siebel CRM uses. Applies to the AxisLineGrid and Graphic elements.
You can use any positive number. The default value is 0, which is a thin line.
 

List Of Values (O)
 

Species the list of possible values for the x-axis, y-axis, or z-axis that the Axis Id property species.
Applies to the AxisLabel element. This property allows the user to specify values that Siebel CRM does
not display, such as 0 or an empty value.
 
If you apply this property to the y-axis, then Siebel CRM displays string values on the y-axis instead of
numeric values.
 
If you specify a list of values on the AxisLabel label for the X axis, then Siebel CRM displays every value
that this list contains even if the returned value in the Y axis is 0 or empty. It displays these values on
the X axis.
 
By default, if the value is empty, then Siebel CRM uses only the corresponding eld values that the
current business component contains for a given axis.
 
This property uses the following format:
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 business_component,field_name,
search_specification,sort_specification

 

where:
 

• business_component identies the name of the business component that the current business
object references.

• eld_name identies the business component eld that Siebel CRM uses to get the values that it
displays.

• search_specication species the search specication that Siebel CRM uses on the business
component.

• sort_specication species the sort specication that Siebel CRM uses on the business
component.

For example:
 

List Of Values,Value,Type = LEAD_QUALITY,Order By

For example:
 

Sales Cycle Def,Sales Cycle Stage,Sales Stage Order

Log Base (O)
 

Species to use a logarithmic axis instead of a linear axis. Applies to the AxisLabel element. You can
use any positive number. For example:
 

• If the value of the LogBase property is 10, then the axis displays 1, 10, 100, 1000, 10000, and so on.

• if the value of the LogBase property is 2, then the axis displays 1, 2, 4, 8, 16, 32, 64, and so on.

Name (R)
 

Species the name for the chart element. This name must be unique in the chart object.
 

Show Category Legend (O)
 

Species to display a legend for the axis that the Axis Id property species. Siebel CRM applies this
property only to the x-axis and z-axis for the AxisLabel element.
 
If the x-axis labels are long, or if a large number of labels exist, then the labels might overlap.
 
You can use one of the following values:
 

• TRUE. Display the entire x-axis group label on the x-axis.

• FALSE. Do not display the entire x-axis group label on the x-axis.

By default, if Siebel CRM displays more than one group on the x-axis legend, then it displays only the
rst three leers of each x-axis group.
 

Sort Specication (O)
 

Species the sort operation that Siebel CRM performs on the axis that the Axis Id property identies.
Applies to the x-axis, y-axis, or z-axis of the AxisLabel element. This property uses the following
format:
 

order,field_name

where:
 

• order is Ascending, Descending, or None.

• eld_name identies the eld that Siebel CRM sorts according to a column other than the
category or series.
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For example, the following seing congures Siebel CRM to sort the Sales Stage Order eld in
ascending order:
 

Ascending,Sales Stage Order

For the y-axis, Siebel CRM sorts the x-axis labels according to y-axis numeric values. If you specify a
sort specication for the y-axis, then you cannot specify a sort specication for the x-axis.
 
If the List Of Values property contains a value, then Siebel CRM ignores the Sort Specication property.
 

Text (O)
 

Species the text that Siebel CRM displays for the AxisTitle, Legend, Title, or HorizLine element.
 

Type (O)
 

Species the type of chart element. Applies to all elements. To view the values you can use, click the
Type property in Siebel Tools.
 

Vertical (O)
 

Species to display labels vertically on the x-axis. Applies to the AxisLabel element. Note the following:
 

• If the x-axis contains less than ve labels, then Siebel CRM ignores the Vertical property and
displays all labels horizontally.

• If a long label exists, then Siebel CRM moves the chart upward.

• If the monitor is a low resolution, then space is limited.

• Siebel CRM cannot display all fonts vertically.

• The Vertical property does not apply to a Period chart.

You can use one of the following values:
 

• TRUE. Display the labels vertically.

• FALSE. Display the labels horizontally.

Conguring the Coordinates Property of a Chart Element  
The Coordinates property of a chart element species coordinates for the Graphic and AxisLabel elements. This
property is required for the following items:

• Graphic elements

• X-axis labels in a scaer chart

• X-axis and z-axis labels in a histogram chart

Rectangle, Ellipse, and Line apply only to the scaer chart. HorizLine and HorizArea apply to all charts.

A histogram chart requires the following items:

• Coordinates for the axes that the user categorizes

• A value in the Divisions property.

The value you enter depends on the following type of element you specify:

• AxisLabel. You specify the minimum and maximum values for the Axis Id. You enter two numbers that specify
the following coordinates:

◦ Minimum value

◦ Maximum value
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For example:

0 1000000

This example sets a range that includes 0 through 1 million.

• Rectangle, Line, or Ellipse. You enter four numbers that specify the following coordinates:

◦ Left

◦ Boom

◦ Top

◦ Right

• For example:
60 1000 80 3000

This example sets the coordinates so that the left side of the element occurs at coordinate 60, the boom at
coordinate 1000, the top at coordinate 80, and the right side at coordinate 3000.

• HorizArea. You enter four numbers that specify the following coordinates:

◦ minYaxisValue

◦ maxYaxisValue
20 50

This example congures Siebel CRM to draw the horizontal area between y coordinate 20 and y coordinate 50.

• HorizLine. You enter one number that species the YaxisValue. For example:

40000

This example congures Siebel CRM to draw a horizontal line at a y coordinate of 40000.

Properties That Siebel CRM Uses for Dierent Types of Chart Elements  
The following table describes the properties that Siebel CRM uses for dierent types of chart elements.

Type of Chart Element Properties

Axis Label
 

Siebel CRM uses the following properties:
 

• Axis Id

• Color

• Coordinates

• Display Format

• Divisions

• Font Eect

• Font Name

• Font Size

42



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Type of Chart Element Properties

• Font Style

• List Of Values

• Log Base

• Show Category Legend

• Sort Specication

• Vertical

Axis Line Grid
 

Siebel CRM uses the following properties:
 

• Axis Id

• Color

• Line Style

• Line Width

You cannot congure the AxisLineGrid element.
 

Axis Title
 

Siebel CRM uses the following properties:
 

• Axis Id

• Color

• Font Eects

• Font Name

• Font Size

• Font Style

• Text

Graphic
 

Siebel CRM uses the following properties:
 

• Color

• Coordinates

• Graphic Type

• Line Style

• Line Width

• Text

Legend
 

Siebel CRM uses the following properties:
 

• Color

• Font Eect

• Font Name

• Font Size

• Font Style

You cannot congure the Font Name property or the Font Size property.
 

Plot Siebel CRM uses the following properties:
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• Color

Siebel CRM release 7.x does not support the Plot chart element.
 

Title
 

Siebel CRM uses the following properties:
 

• Color

• Font Eect

• Font Name

• Font Size

• Font Style

• Text

Chart Element Locale  
A chart denes language overrides that Siebel CRM uses with a chart element.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Chart > Chart Element > Chart Element Locale

The following table describes properties that Siebel CRM uses with a chart element locale.

Property Description

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Text (O)
 

Species the name of the chart element that Siebel CRM displays in the client for a language.
 

Chart Locale  
A chart locale denes language overrides that Siebel CRM uses with a chart.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Chart > Chart Locale

The following table describes properties that Siebel CRM uses with a chart locale.

44



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

Category Captions (O)
 

Species the caption for the x-axis for a language.
 

Data Point Captions (O)
 

Species the caption for the y-axis for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Picklist Function Captions (O)
 

Species the captions for the list of functions that Siebel CRM displays for the y-axis label for a
language.
 

Picklist Period Captions (O)
 

Species the captions for the list of time periods that Siebel CRM displays for the x-axis label for a
language.
 

Picklist Type Captions (O)
 

Species the captions for the types of charts for a language.
 

Series Captions (O)
 

Species the caption for the z-axis for a language.
 

Control  
A control denes an element in an applet, such as a text box, check box, or buon. You can add user properties to a
control.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Control

The following table describes properties for the control object. For more information about controls, see the topic
on eld data types in  Conguring Siebel Business Applications . For information about user properties, see  Siebel
Developer's Reference  .

Property Description

ActiveX Bind Property (O)(H)
 

Species the name of a property of an ActiveX control. To bind a eld to an ActiveX control, you must
also specify the name of this eld in the Field property of this control object. This eld must reside in
the business component that the applet references. Siebel CRM does the following:
 

• If Siebel CRM modies the property value of the ActiveX control, then it saves this value in this
eld in the current business component record.

• If Siebel CRM modies the eld value, then it saves this value in the property of the ActiveX
control.

This property applies to an ActiveX control.
 

ActiveX Properties (O)(H)
 

Includes a compressed version of the ActiveX properties for this control. You do not edit this property.
Siebel CRM automatically sets the value that this property contains. To determine this value, it uses
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values of the ActiveX properties in the Properties window or values of the properties in the property
window for the control.
 
This property applies to an ActiveX control.
 

Automatic Horizontal Scroll (O)(H)
 

Enables automatic horizontal scroll. If set to TRUE, and if:
 

• The user types a character at the end of the line, then Siebel CRM automatically scrolls text to the
right by ten characters.

• The user presses Enter, then Siebel CRM automatically scrolls all text back to position 0.

This property applies only to a TextBox control.
 

Automatic Vertical Scroll (O)(H)
 

Enables automatic vertical scroll. If set to TRUE, and if the user presses the ENTER key on the last line,
 then Siebel CRM automatically scrolls text up one page.
 
This property applies only to a TextBox control.
 

Background Color (O)(H)
 

Species a space-separated RGB (red, green, blue) value. You can set the value of the Background
Color property to for a Label, Image, or PushBuon control to one of the following values:
 

• Transparent. Makes the control transparent.

• A value other than Transparent. Makes these controls opaque.

Siebel CRM only sets the area under the caption to the color that the Background Color property
species for a Group control.
 
This property applies to the following types of controls:
 

• Textbox

• Label

• PushBuon

• ComboBox

• Group

Bitmap (O)(H)
 

Species a bitmap from the Control Icons bitmap category that Siebel CRM uses for the image control.
This value applies to static image controls that do not reference a eld in the current record.
 
This property applies to an Image control.
 

Caption (O)
 

Species headers for list applet columns, eld prompts, and link names. You can set this property to a
bitmap that resides in the Buon Icons bitmap category.
 
For a list applet, Siebel CRM uses the value that the Caption control property contains in the following
ways:
 

• To create the sortable list header. The ListHeader property of the swe:control tag determines
this header.

• To determine a eld prompt. The DisplayName property of the swe:control tag determines
this prompt.

If a control calls a method, then Siebel CRM uses the value in the Caption property as the link name or
buon label. The FormaedHtml property of the swe:control tag determines this name or label.
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Class (O)
 

Species the name of the C++ class that this control references. This property applies only to a Java
control or an ActiveX control.
 

Content Fixup Name (O)
 

Species a name that determines how Siebel CRM xes links and images in the HTML page:
 

• The Siebel Server for a Siebel CRM application. Siebel CRM xes links and images.

• The client browser xes links and images.

For more information, see  Siebel Portal Framework Guide .
 

Default Buon (O)(H)
 

Not used. This property applies only to a PushBuon control.
 

Detail Applet (O)
 

Species the name of the pop-up applet that Siebel CRM uses to display data from elds in the
business component. This property applies only to a TextBox control or a PushBuon control.
 

Display Format (O)
 

Species the format that Siebel CRM uses to display data for this control. This property applies only to
a TextBox control.
 

Field (O)
 

Species the business component eld or applet message that provides the data that this control
displays. This property applies to the following types of controls:
 

• TextBox

• CheckBox

• ImageControl

Field Retrieval Type (O)
 

Species the type of eld data. You can use one of the following values:
 

• Field Data. Rich content HTML.

• Service.

• Symbolic URL. Specially constructed URL that integrates data from the Siebel database and the
external content service.

• URL. Standard reference to a Web page.

• Empty. Siebel CRM encloses the eld value with a SPAN tag.

• HTML Aachment. Obsolete. Do not use.

Field Type (O)
 

Species to display data from a business component eld or an applet message. Siebel Tools
automatically sets this property when you set the Field property.
 

Foreground Color (O)(H)
 

Species an RGB value. You use an empty space to separate each number in this value.
 
This property applies to the following types of controls:
 

• Textbox

• Label

• PushBuon

• CheckBox

• ComboBox
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• Group

Group (O)(H)
 

Not used.
 

Height - Language Override (O)(H)
 

Species the height of the control in pixels if a language or locale is active.
 

Height (O)(H)
 

Species the height of the control in pixels. You can set this property to a number that is greater than
or equal to 0. The default value is 10. This property applies to all controls.
 

HTML Aributes (O)
 

Species to add HTML tag aributes to the HTML tags that the client creates when it displays the
control.
 
For example, If you set the HTML Aributes property to size=30 for a text box, then the client creates
the following tag:
 

<input type = text size=30 . . .>

HTML Bitmap (O)
 

Species a Bitmap object that resides in the HTML Control Icons bitmap category. If the HTML
Disabled Bitmap property is:
 

• Empty. Siebel CRM uses the image that the HTML Bitmap property references.

• Not empty. Siebel CRM uses the image that the HTML Bitmap property references only if the
control is in an enabled state.

HTML Default Control (O)(H)
 

Not used.
 

HTML Disabled Bitmap (O)
 

Species the image to use instead of the image that the HTML Bitmap property references if the
control is in a disabled state.
 

HTML Display Mode (O)
 

Species how to display the eld value. To support an applet message, you must set this property to
FormatData. This conguration allows Siebel CRM to use newlines and spaces in the applet message.
You can use one of the following values:
 

• EncodeData. Siebel CRM encodes any HTML reserved characters that the eld value contains
before it displays these characters. Each of the following symbols is an example of an HTML
reserved character:

◦ < (less than symbol)

◦ > (greater than symbol)

◦ & (ampersand)

◦ and so on

It is recommended that you set the HTML Display Mode to EncodeData for security purposes. For more
information about seing this property, see  Siebel Security Guide .
 

• FormatData. Siebel CRM formats text that the user enters. For example, assume the user enters
text that includes new lines and tabs in the description eld of a service request. Assume you set
the HTML Display Mode property to one of the following values:

◦ FormatData. Siebel CRM formats the text that the user enters in HTML so that it uses the same
format that the user enters.
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◦ Not set to FormatData. Siebel CRM does not format the text that the user enters. It displays the
entire text string that the user enters on one line.

HTML Height (O)
 

Species the height of the control in pixels.
 
You typically do not modify this property manually. Siebel Tools sets it automatically if you edit an
applet layout in a Siebel Tools layout editor.
 
If you use a TextArea eld that spans multiple elds, then to accommodate the buer between the
elds of a grid form, it might be necessary for you to add 2 pixels for each row. For example, consider
the TextArea eld that the Description control of the Service Request Detail Applet references. This
eld spans three rows of single-row elds. To align the boom of this eld with other elds, such
as Home Phone#, you must increase the value in the HTML Height property an additional 2 pixels
for every row of elds that the TextArea eld spans, not including the rst row. In this situation, the
Description control spans three rows of elds. You increase the HTML Height property to 2 rows
multiplied by 2 pixels for a total of 4 pixels. You modify the original HTML Height of 72 pixels to 76
pixels.
 
This property applies to the following types of controls:
 

• Java applet

• ActiveX

• Input type controls

HTML Height - Language Override (O)
 

Species the height of the control in pixels if a language or locale is active.
 

HTML Icon Map (O)
 

Species to map eld values to icons as dened in the icon map.
 

HTML Max Chars Displayed (O)
 

Species the maximum number of characters that Siebel CRM displays in a control.
 
This property applies only if the parent applet is in Base mode or if the control is read-only. It does not
limit the number of characters that the user can enter into a text control in edit mode.
 

HTML Max Chars Displayed - Language
Override (O)
 

Species the maximum number of characters that Siebel CRM displays in a control if a language or
locale is active.
 

HTML Only (O)
 

Species to use the control only in the Siebel Web Client. You can use one of the following values:
 

• TRUE. Use this control only in the Siebel Web Client.

• FALSE. Use this control in any client.

HTML Row Sensitive (O)
 

Species to position the applet. You can use one of the following values:
 

• TRUE. Position the applet on the current record before calling the method that the Method
Invoked property references.

• FALSE. Do not position the applet.

The following methods are examples that require you to set the HTML Row Sensitive property to TRUE:
 

• EditRecord

• DeleteRecord

• Drilldown
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HTML Sequence (O)
 

Species the order that Siebel CRM uses to position this control relative to other controls that it
displays in the applet in the Siebel Web Client.
 

HTML Sequence - Language Override (O)
 

Species the HTML sequence if a language or locale is active.
 

HTML Type (O)
 

Species how to display the control. If the HTML Type property is empty, then Siebel CRM uses the
Type property.
 
If your conguration requires an applet message, then you must set this property to Plain Text so that
Siebel CRM wraps long text in the applet message.
 

HTML Width (O)
 

Species the width of the control in pixels in the Siebel Web Client. The maximum value is 2048. This
property applies to the following types of controls:
 

• Java applet

• ActiveX

• Input type controls

HTML Width - Language Override (O)
 

Species the HTML width if a language or locale is active.
 

Left - Language Override (O)(H)
 

Species the left coordinate of a control if a language or locale is active.
 

Left (O)(H)
 

Species the left coordinate of this control in pixels. This property applies to all controls. You can enter
a number that is greater than or equal to 0.
 

Left Text (O)(H)
 

If this property is TRUE, then Siebel CRM places text on the left side of the control. This property
applies only to a CheckBox control.
 

MethodInvoked (O)
 

Species the method that Siebel CRM calls if the user clicks a buon control. If the control type is not
PushBuon, then Siebel CRM ignores this property.
 
The method that is available for a buon control depends on the class that the applet references
and the class that the business component references. The following methods are available for the
CSSFrameList applet class and the CSSFrame applet class:
 

• NewRecord

• DeleteRecord

• CopyRecord

• UndoRecord

You must use other methods only with caution. For more information, see Conguring the
MethodInvoked Property of a Control and  Siebel Developer's Reference .
 
This property applies only to a PushBuon control.
 

Multi Line (O)(H)
 

Species a multiple-line TextBox control. You can use one of the following values:
 

• TRUE. Allows a multiple-line TextBox.

• FALSE. Does not allow a multiple-line TextBox.

Scrolling depends on the following value of the Automatic Vertical Scroll style:
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• TRUE. Siebel CRM displays the control for as many lines as possible. If the user presses Enter, then

it scrolls vertically.

• FALSE. Siebel CRM displays the control for as many lines as possible. If it cannot display any
more lines, and if the user presses the Enter key, then it beeps. If the Automatic Horizontal Scroll
style is TRUE, and if the cursor goes past the right edge of the control, then multiple-line control
automatically scrolls horizontally.

To start a new line, the user must press the ENTER key. If Automatic Horizontal Scroll is FALSE, then
Siebel CRM automatically wraps the control words to the beginning of the next line, if necessary. If the
user presses the ENTER key, then Siebel CRM starts a new line. The window size determines the text
position. If the user modies the window size, then Siebel CRM displays the text again.
 
If a TextBox control:
 

• Includes scroll bars. It processes its own scroll bar messages.

• Does not include scroll bars. It processes any scroll messages that the parent window sends.

The default value is single line.
 
This property applies only to a TextBox control.
 

MVG Applet (O)
 

Species the applet that Siebel CRM uses for a pop-up multivalue group if the eld that the control
references is a multivalue eld and if the Runtime property of this control is TRUE.
 
This property applies only to a TextBox control.
 

Name (R)
 

Species the name of the control. This property applies to all controls.
 

Owner Draw (O)(H)
 

If TRUE, then Siebel CRM displays the bitmap that the Caption property references. It displays this
bitmap on the buon. This property applies only to a PushBuon control.
 

Pick Applet (O)
 

Species the applet that Siebel CRM uses for the pop-up picklist if you specify a picklist for the eld
that the control references and if the Runtime property of this control is TRUE.
 
This property applies only to a TextBox control.
 

Prompt (O)
 

Not used. This property applies only to a TextBox control.
 

Prompt Text (O)
 

For more information, see Conguring the Prompt Text Property of a Control or List Column.
 

Read Only (O)
 

You can use one of the following values:
 

• TRUE. The user cannot edit the control.

• FALSE. The user can edit the control.

If the Read Only property of the eld that this control references is TRUE, then this control is also read-
only even if the Read Only property of this control is FALSE.
 
This property applies only to a TextBox control.
 

Runtime (O)
 

You can use one of the following values:
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• TRUE. Siebel CRM displays a pop-up buon for a picklist, calculator, calendar, or multivalue group
at run time.

• FALSE. Siebel CRM does not display a pop-up buon.

This property applies only to a TextBox control.
 

Sequence - Language Override (O)(H)
 

Species the order that Siebel CRM uses to display this control relative to other controls in the applet if
a language or locale is active.
 

Sequence (O)(H)
 

Species the order that Siebel CRM uses to display this control relative to other controls in the applet.
You can use a number that is greater than or equal to 1.
 
This property applies to all controls.
 

Show Popup (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM opens a new browser window before it calls the method.

• FALSE. Siebel CRM calls the method in the current browser window.

You must not set the Show Popup property to TRUE in the following situations:
 

• A script uses the GotoView application object method.

• Siebel CRM uses TheApplication.GotoView. In this situation, it opens the view in a new browser
window. The client does not support Multiple Document Interface (MDI). Siebel CRM does not
support this conguration.

Sort (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM automatically sorts strings that the user enters in the control.

• FALSE. Siebel CRM does not automatically sort strings that the user enters in the control.

This property applies only to a ComboBox control.
 

Tab Stop (O)(H)
 

You can use one of the following values:
 

• TRUE. Allow the user to use the TAB key to navigate to the next control that the Sequence
property species.

• FALSE. Do not allow the user to use the TAB key.

This property applies to all controls.
 

Target View Frame (O)
 

Species the HTML page that Siebel CRM loads into the frame if the user clicks a control that calls a
method.
 
You can use one of the following values:
 

• Self. Open the frame that contains the applet control.

• Blank. Open a new full feature window.

• Others. Open some other frame.

This property applies to a Siebel Web Client control.
 

Text Alignment (O)
 

Species how to align the text in the control. To view the values you can use, click the Text Alignment
property in Siebel Tools. This property applies only to a TextBox control or a Label control.
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Text Alignment - Language Override (O)
 

Species how to align the text in the control if a language or locale is active. For more information, see
the description for the Text-Alignment Label property.
 

Text Alignment-Label - Language Override
(O)
 

Species how to align the text of a control label on a form applet if a language or locale is active. This
alignment occurs automatically for a locale that the user reads from right to left, such as Japanese.
 

Text Style (O)(H)
 

Species the text style that Siebel CRM uses to display this control. The Text Style object type
determines the font type and font style. For more information, see Text Style (H).
 
This property applies to the following types of controls:
 

• CheckBox

• ComboBox

• Group

• Label

• PushBuon

• TextBox

Text-Alignment Label (O)
 

Species how to align the text of a control label on a form applet. To view the values you can use, click
the Text-Alignment Label property in Siebel Tools.
 
For example, a eld and a eld label in a grid form applet are separate applet web template items that
each reference the same control. To place a label to the left of a eld, you do the following:
 

• Set the Text-Alignment Label property for the control that includes the label text to Right.

• Set the Text-Alignment Label property for the control that includes the eld text to Left.

Tooltip Text (O)(H)
 

Obsolete. Do not use. This property applies to a Buon control.
 

Top - Language Override (O)(H)
 

Species the order that Siebel CRM uses to display controls if a language or locale is active.
 

Top (O)(H)
 

Species the top coordinate of this control in pixels. The top coordinate of the applet is 0. You can
specify a number that is greater than or equal to 0. This property applies to all controls.
 

Type (O)(H)
 

Species the control type. To view the values you can use, click the Type property in Siebel Tools. This
property applies to all controls.
 

Vertical Scroll (O)(H)
 

You can use one of the following values:
 

• TRUE. Siebel CRM displays a vertical scroll bar in the control.

• FALSE. Siebel CRM does not display a vertical scroll bar in the control.

This property applies only to a ComboBox control or a TextBox control.
 

Visible (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM displays the control in the client.
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• FALSE. Siebel CRM does not display the control in the client.

This property applies to all controls.
 

Visible - Language Override (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM displays the control in the client if it uses the language that you specify as the
language override.

• FALSE. Siebel CRM does not display the control in the client.

Want Return (O)(H)
 

If the user presses the ENTER key in a multiple-line TextBox control, and if the Want Return property is:
 

• TRUE. Siebel CRM inserts a carriage return.

• FALSE. Siebel CRM performs the same logic it performs if the user clicks the default pushbuon
for the applet.

This property applies only to a multiple-line TextBox control. It has no eect on a single-line TextBox
control.
 

Width - Language Override (O)(H)
 

Species the order of controls if a language or locale is active.
 

Width (O)(H)
 

Species the width of the control in pixels. You can specify a number that is greater than or equal to 0.
The default value is 40. This property applies to all controls.
 

Conguring the MethodInvoked Property of a Control  
Siebel CRM does the following in an HTML client according to the value of the MethodInvoked property:

1. The user clicks a buon.
2. The MethodName property of control that this buon references control calls an InvokeMethod call in the

browser applet class. This class runs in the HTML browser.
3. A Browser Script on the applet includes a PreInvokeMethod handler that intercepts the method and handles the

PreInvokeMethod event.
4. If Siebel CRM does not handle the InvokeMethod call in the:

◦ Browser applet class. It does an InvokeMethod call in the server applet class. The client applet class uses
this method to call the server applet unless a specialized client applet exists that handles this method
in the client. To handle this method, you can use a WebApplet_PreInvokeMethod script in Siebel VB or
Siebel eScript.

◦ Server applet class. It forwards the call to the business component that the applet references.
This business component resides on the server. To handle this method, you can use a
BusComp_PreInvokeMethod script in Siebel VB or Siebel eScript.

5. If Siebel CRM does not handle the InvokeMethod on the business component that resides on the server, then it
returns an error.

Conguring the Prompt Text Property of a Control or List Column  
The Prompt Text Property species the text that Siebel CRM displays in the status bar of the Browser that displays the
client. This property applies only to a form applet or list applet. The Prompt Text eld can include a maximum of 250
characters. This maximum value exceeds the space that is available for this text in the Browser status bar. This status
bar can display only approximately 127 characters in Internet Explorer version 7.0.
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Control Locale  
A control locale denes language overrides that Siebel CRM uses with a control.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Control > Control Locale

The following table describes properties that Siebel CRM uses with a control locale.

Property Description

Caption (O)
 

Species the as headers for list applets columns, eld prompts, and link names.
 

Height (O)(H)
 

Species the height of the control in pixels.
 

HTML Height (O)
 

Species the height of the control in pixels.
 

HTML Max Chars Displayed (O)
 

Species the maximum number of characters that Siebel CRM displays in a control.
 

HTML Sequence (O)
 

Species the order that Siebel CRM uses to
 
The (order) position of this control relative to other controls in the applet in the Siebel Web Client.
Indicates tab sequence.
 

HTML Width (O)
 

Species the width of the control in pixels in the Siebel Web Client.
 

Left (O)(H)
 

Species the left coordinate of this control in pixels.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Prompt Text (O)
 

For more information, see Conguring the Prompt Text Property of a Control or List Column.
 

Sequence (O)(H)
 

Species the order that Siebel CRM uses to
 
Sets the (order) position of this control relative to other controls in the applet.
 

Text Alignment (O)
 

Species how to align text in the control. You can use one of the following values:
 

• Left

• Center

• Right

Text-Alignment Label (O)
 

Species the Text-Alignment Label property if a language or locale is active. Siebel CRM associates this
property with the Text Alignment Label Language Override property of a control.
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Tooltip Text (O)
 

Obsolete. Do not use.
 

Top (O)(H)
 

Species the top coordinate of this control in pixels. The top coordinate of the applet is 0. You can
specify a number that is greater than or equal to 0.
 

Visible (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM displays the control in the client.

• FALSE. Siebel CRM does not display the control in the client.

Width (O)(H)
 

Species the width of the control in pixels. You can specify a number that is greater than or equal to 0.
 

Control User Prop  
A control user prop sends a property value to specialized C++ code. Siebel CRM persists the value that you congure for
a user property in the Siebel runtime repository. For more information, see Object Types That You Must Not Modify.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Control > Control User Prop

The following table describes properties that Siebel CRM uses with a control user prop.

Property Description

Name (R)
 

Species the name of the user property.
 

Value (R)
 

Species the value of the user property.
 

Drilldown Object  
A drilldown object allows the user to drill down on a eld in a list applet and navigate to another view where Siebel CRM
displays more data about the eld. To identify a drilldown eld in a list, Siebel CRM uses colored, underlined text. For
more information about how to congure drilldown on a form applet in Siebel Open UI, see Article ID 539183.1 on My
Oracle Support.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Drilldown Object

The following table describes properties that Siebel CRM uses with a drilldown object.
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Business Component (O)
 

Species the destination business component. If this property is empty, then Siebel CRM uses the
same business component for the destination business component that it uses for the source business
component, although it typically modies the view.
 
If the destination view must display the same active business components in the same context, and if
you do not require Siebel CRM to modify the current query context, then do not specify a value in any
of the following properties for this drilldown object:
 

• Business Component

• Destination Field

• Source Field

Destination Field (O)
 

Species eld in the destination business component. The value that this eld contains equals the
value that the source eld contains in the source business component. If you do not specify a business
component, then do not specify a value in the Destination Field property.
 
If the Destination Field property is empty, then it defaults to Id, which is the row ID of the destination
business component.
 

Hyperlink Field (O)
 

Species a business component eld that the applet references that Siebel CRM uses for the drilldown.
This property also determines the eld in the list column in the list applet that is blue and underlined.
 
You must enter a value in the Hyperlink Field property. If you do not enter a value, then Siebel CRM
does not display a link that the user can click to drill down.
 

Menu Text (O)
 

Not used.
 

Name (R)
 

Species the name of the drilldown object. This name must be unique among drilldown objects in the
applet.
 

Sequence (O)
 

Species a sequence number that Siebel CRM uses in a dynamic drilldown. This number determines
the default drilldown object.
 

Source Field (O)
 

Species a business component eld that the applet references. This eld is the source of the
drilldown. Siebel CRM applies the value that this eld contains as a search specication to the
destination eld in the destination business component. Because the user navigates from one
view to another view, a new active business component occurs. The following properties establish
a relationship from a record in the source business component to the appropriate record or set of
records in the destination business component:
 

• Source Field

• Business Component

• Destination Field

If you do not specify a value in the Business Component property for this drilldown object, then do not
specify a value in the Source Field property.
 
If the Source Field property is empty, then Siebel CRM drills down to the same row in the destination
business component.
 

View (O)
 

Species the view that Siebel CRM displays if the user drills down. If the View property is empty, then:
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Property Description

• Siebel CRM continues to display the current view. For example, if the user drills down from an
account to a subaccount.

• You must specify a value in the Business Component property.

Visibility Type (O)
 

Species a visibility type that is dierent than the default visibility for the destination business
component. To view the values you can use, click the Visibility Type property in Siebel Tools.
 
You typically set this value to All. This value makes sure that Siebel CRM can display the destination
record.
 

Drilldown Object Locale  
A drilldown object locale denes language overrides that Siebel CRM uses with a drilldown object.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Drilldown Object > Drilldown Object Locale

The following table describes properties that Siebel CRM uses with a drilldown object locale.

Property Description

Menu Text (O)
 

Species the text that Siebel CRM displays in the right-click shortcut menu for a row for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

List  
A list contains information for list applets. For a list applet, there must be one and only one list object denition. If the
applet is not a list applet, then there are no list object denitions.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > List

The following table describes properties that Siebel CRM uses with a list.

Property Description

Alpha Tab Search Field (O)(H)
 

Species the name of the business component eld that Siebel CRM uses when it does an alpha tab
search. If this property includes a value, then Siebel CRM displays an alphabet tab search bar in the list
applet.
 

58



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

Alpha Tab Search Field - Language
Override (O)(H)
 

Species the alpha tab search eld if a language or locale is active.
 

HTML Hierarchy Bitmap (O)
 

Species the name of the HTML hierarchy bitmap. For more information, see HTML Hierarchy Bitmap.
 

HTML Multi Row Edit (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM can edit multiple rows without saving each row while in the Edit List mode of
the applet.

• FALSE. Siebel CRM must save each row to the Siebel database before it edits another row.

HTML Multi Row Select (O)
 

You can use one of the following values:
 

• TRUE. The user can choose multiple rows in an applet.

• FALSE. The user cannot choose multiple rows in an applet.

Name (R)
 

Species the name in the applet. This value is List.
 

Total Displayed (O)
 

Not used.
 

Total Required (O)
 

If TRUE, then Siebel CRM sums and displays at the boom of the list the columns whose Total Required
property is TRUE. Siebel CRM uses this property only if the applet is a list applet.
 

Variable Row Height (O)(H)
 

If TRUE, then the list applet supports variable row heights. For example, Notes. A variable row displays
the rst three lines by default. To display the entire line, the user must set the Text Lines Per Note Row
in the List tab of the Options window to 3.
 

List Column  
A list column associates one list column to a list applet. You can add user properties to a list column. For more
information about controls, see the topic about eld data types in  Conguring Siebel Business Applications . For
information about user properties, see  Siebel Developer's Reference .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > List > List Column

The following table describes properties that Siebel CRM uses with a list column.

Property Description

Available (O)
 

If FALSE, then Siebel CRM does not display the list column in the list or in the Columns Displayed
dialogue box. For more information, see the description of the Show In List property for this list
column.
 

Available - Language Override (O) Species to use this column with a list applet if a language or locale is active.
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Property Description

   

Bitmap Column Heading (O)(H)
 

You can use one of the following values:
 

• TRUE. Display the bitmap specied in the Check Bitmap Identier property as the list column
heading.

• FALSE. Display the normal name and display name in the list column heading.

You can use this property only in a Boolean list column that species a value for the Check Bitmap
Identier property.
 

Check Bitmap Identier (O)(H)
 

Species the bitmap that Siebel CRM displays in the TRUE state if this list column is a CheckBox list
column.
 

Content Fixup Name (O)
 

Species to use the Siebel Server or the client browser to do xup. This xup allows Siebel CRM to
display links and images in the HTML page. For more information, see  Siebel Portal Framework Guide .
 

Detail Applet (O)
 

Species the applet that Siebel CRM uses to display related data for the eld that the list column from
the same business component species.
 

Display Format (O)
 

Species the format mask that Siebel CRM applies to the data. For example:
 

$#,###,###,###

Display Name (O)
 

Species the value that Siebel CRM uses as the list column heading or the key to the international
message table. For example:
 

Expected Value

Field (O)
 

Species the eld that provides the data that the list column displays. For example:
 

Amount Expected Value

Field Retrieval Type (O)
 

Species that the eld data is one of the following:
 

• Rich content HTML data (Field Data)

• A predened reference to a Web page (URL)

• A specially created URL that integrates data from the Siebel database and the external content
service (Symbolic URL)

HTML Aribute (O)
 

Species to add HTML tag aributes to the HTML tags that the client creates to display the list column.
 

HTML Display Mode (O)
 

Species the display mode that Siebel CRM uses with a control that displays a eld value. You can use
one of the following values:
 

• EncodeData. Encode any reserved characters in the markup language that exist in the eld data
so that it displays correctly.

• FormatData. Encode any reserved characters in the markup language that exist in the eld data
so that it displays correctly. Format the eld value using the markup language using the same
format that the Siebel database uses. For example, if HTML is the markup language, then do the
following:
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Property Description

◦ Replace a newline with a br tag.

◦ Replace contiguous white space with &nbsp.

HTML Height (O)
 

Species the height of this list column in pixels in the Siebel Web Client.
 

HTML Height - Language Override (O)
 

Species the height of this list column in pixels in the Siebel Web Client if a language or locale is active.
 

HTML Icon Map (O)
 

Species to map eld values to icons that the icon map denes. For example:
 

CHECK

HTML List Edit (O)
 

You can use one of the following values:
 
TRUE. If the applet displays in the Edit List mode, then display this control as a data input control.
 
FALSE. Display this control as a read-only control.
 

HTML Max Chars Displayed (O)
 

Species the maximum number of characters that Siebel CRM displays in a list column. This property
applies only if the parent applet is in Base mode, or if the list column is read only. It does not limit the
number of characters that the user can enter in a text control in edit mode.
 

HTML Max Chars Displayed - Language
Override (O)
 

Species the maximum number of characters that Siebel CRM displays in a list column if a language or
locale is active.
 

HTML Only (O)
 

If TRUE, then Siebel CRM uses the control only in the Siebel Web Client.
 

HTML Row Sensitive (O)
 

Species to position the applet on the current record before calling the method that the Method
Invoked property species. The following methods are examples that require you to set the HTML Row
Sensitive property TRUE:
 

• EditRecord

• DeleteRecord

• Drilldown

HTML Sequence (O)
 

Species the position of this list column relative to other list columns that Siebel CRM displays in the
applet in the Siebel Web Client.
 

HTML Sequence - Language Override (O)
 

Species the position of this list column relative to other list columns that Siebel CRM displays in the
applet in the Siebel Web Client if a language or locale is active.
 

HTML Type (O)
 

Species how to display the list column. If this property is empty, then Siebel CRM uses the value that
the Type property species.
 

HTML Width (O)
 

Species the width of the list column in pixels in the Siebel Web Client. The maximum value is 2048.
 

HTML Width - Language Override (O)
 

Species the width of the list column in pixels in the Siebel Web Client if a language or locale is active.
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Property Description

MVG Applet (O)
 

Species the applet that Siebel CRM uses to display the pop-up multivalue group if the properties of
this list column are set as follows:
 

• The Field property references a multivalue eld.

• The Runtime property is TRUE.

Name (R)
 

Species the name of this list column.
 

Pick Applet (O)
 

Species the applet that Siebel CRM uses to display the pop-up picklist if the properties of this list
column are set as follows:
 

• The Field property references a multivalue eld.

• The Runtime property is TRUE.

If this list column references a eld that contains a static picklist, then Siebel CRM ignores this property.
The only exception to this conguration occurs if the Long List property of this picklist is TRUE.
 

Popup Edit (O)(H)
 

If TRUE, then a text eld uses a pop-up edit box.
 

Prompt Text (O)
 

For more information, see Conguring the Prompt Text Property of a Control or List Column.
 

Read Only (O)
 

If TRUE, then the user cannot edit data. If the Read Only property of the eld that the Field property of
this list column references is TRUE, then this list column is read-only even if the Read Only property of
this list column is FALSE.
 

Runtime (O)
 

You can use one of the following values:
 

• TRUE. Display a pop-up buon at run time for a picklist, calculator, calendar, or multivalue group.

• FALSE. Do not display a pop-up buon at run time. Siebel CRM assumes there is no picklist or
multivalue group or that the eld is a date or time eld.

Sequence (R)(H)
 

Species the position of this list column in the list. This property can contain only an integer. For more
information, see Conguring the Sequence Property of a List Column to Import Records.
 

Sequence - Language Override (O)(H)
 

Species the position of this list column in the list if a language or locale is active. This property can
contain only an integer.
 

Show In List (O)
 

If TRUE, then Siebel CRM displays this list column in a list.
 
If the Show In List property is FALSE, and if the Available property of this list column is TRUE, then
Siebel CRM does not display list column in the applet unless the user chooses it from the Columns
Displayed window.
 

Show In List - Language Override (O)
 

Species the list column that Siebel CRM displays in a list if a language or locale is active.
 

Show Popup (O)
 

You can use one of the following values:
 

• TRUE. Open a new browser window before calling the method.

• FALSE. Call the method in the same browser window.
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Property Description

Text Alignment (O)
 

Species the text alignment of this list column.
 

Text Alignment - Language Override (O)
 

Species the text alignment of the list column if a language locale is active. You can use one of the
following values:
 

• Center

• Left

• Right

Text-Alignment Label (O)
 

Species to align the text of the list column label on a list applet.
 

Text Alignment-Label - Language Override
(O)
 

Species the Text-Alignment Label property for a list column if a language or locale is active. Siebel
CRM applies this conguration automatically for a locale that reads right-to-left, such as Japanese. You
can use one of the following values:
 

• Center

• Left

• Right

Total Currency Code Expression  (O)
 

Species the currency that Siebel CRM uses to display the total value. You can use this property to
display the list column total in a converted currency. For example, assume an opportunity that uses
dollars as the currency code includes two products. One product is priced with YEN and the other
product is priced in USD. To display the list total in these currencies, you set the Total Currency Code
Expression to the following value:
 

Parent: 'Opportunity.Currency Code'

Total Required (O)
 

You can use one of the following values:
 

• TRUE. Create a total value of all the values that this list column displays. You must also set the
Total Required property of the list object denition to TRUE.

• FALSE. Do not create a total value.

Type (O)(H)
 

Species the list column type.
 

Width (O)(H)
 

Species the list column width.
 

Width - Language Override (O)(H)
 

Species the list column width if a language or locale is active.
 

Conguring the Sequence Property of a List Column to Import Records  
To import records, you must make sure you set the Sequence property of the list column so that Siebel CRM imports
records in the correct order. For example, assume you must congure Siebel CRM so that the user can import service
requests. To do this, the user navigates the Service Requests list, clicks Menu, and then clicks Import. To support this
requirement, assume you do the following:

• Congure hierarchical pick lists in the Service Request business component on the following elds:

◦ Area. The Area eld constrains the Sub-Area eld.
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◦ Sub-Area. The Sub-Area eld constrains the SR Type eld.

◦ SR Type.

• Create a custom import object and a list applet that uses the following conguration:

◦ Set Input Format to Comma Separated Text File

◦ Set Input Source to Auto Mapping

◦ In the applet, you set the Sequence property to the following:

- 4 for the Sub-Area list column
- 1 for the SR Type list column

When the user runs this import, it fails and Siebel CRM enters the following errors in the import log le:

Failed to import 'Information' into the field 'SR Type'. 

Failed to import 'Information' into the field 'SR Type'. 

This import fails because the sequence that Siebel CRM uses when it imports these elds is not correct. It aempts to
set the SR Type eld before it sets the Sub-Area eld, but this is not possible because the Sub-Area eld constrains the
SR Type. Siebel CRM must import the Sub-Area eld rst, choose a value for it, constrain the SR Type eld according to
the Sub-Area eld, and then import the SR Type eld.

To avoid this problem, you must set the Sequence property of the list column in the applet that displays these elds to
the following:

• 1 for the Sub-Area list column.

• 4 for the SR Type list column.

List Column Locale  
A list column locale denes language overrides that Siebel CRM uses with a list column.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > List > List Column > List Column Locale

The following table describes properties that Siebel CRM uses with a list column locale.

Property Description

Available (O)
 

If TRUE, then Siebel CRM can associate this list column with a list applet.
 

Display Name (O)
 

Species a symbolic string that Siebel CRM uses for the list column heading.
 

HTML Height (O)
 

Species the height of this list column in pixels in the Siebel Web Client.
 

HTML Max Chars Displayed (O)
 

Species the maximum number of characters that Siebel CRM displays in a list column.
 

HTML Sequence (O)
 

Species the position of this list column relative to other list columns in the applet in the Siebel Web
Client if the list applet is in Edit, Query, or New mode.
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Property Description

 

HTML Width (O)
 

Species the width of the list column in pixels in the Siebel Web Client. The maximum value is 2048.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Prompt Text (O)
 

For more information, see Conguring the Prompt Text Property of a Control or List Column.
 

Sequence (O)(H)
 

Species the position of this list column in the list. This property can contain only an integer.
 

Show In List (O)
 

If TRUE, then Siebel CRM displays this list column in a list.
 

Text Alignment (O)
 

Species the text alignment of the list column.
 

Text-Alignment Label (O)
 

Species the Text-Alignment Label property if a language or locale is active. This property aects the
Text Alignment Label Language Override property for this list column.
 

Width (O)(H)
 

Species the width for this list column.
 

List Column User Prop  
A list column user prop sends a property value to specialized C++ code. Siebel CRM persists the value that you congure
for a user property in the Siebel runtime repository.

For more information, see Object Types That You Must Not Modify.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > List > List Column > List Column User Prop

The following table describes properties that Siebel CRM uses with a list column user prop.

Property Description

Name (R)
 

Species the name of the user property.
 

Value (R)
 

Species the value of the user property.
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List Locale  
A list locale denes language overrides that Siebel CRM uses with a list.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > List > List Locale

The following table describes properties that Siebel CRM uses with a list locale.

Property Description

Alpha Tab Search Field (O)(H)
 

Species the name of the business component eld that Siebel CRM uses when it does an alpha tab
search. If this property includes a value, then Siebel CRM displays an alphabet tab search bar in the list
applet.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Tree  
A tree denes a tree control in a tree applet. To create a view that allows the user to navigate a hierarchal list of records,
Siebel CRM uses a tree applet. For example, the explorer view in the Service Requests screen uses a tree applet.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Tree

The following table describes properties that Siebel CRM uses with a tree.

Property Description

HTML Hierarchy Bitmap (O)
 

Species the name of the HTML hierarchy bitmap object that Siebel CRM uses to display icons on the
tree.
 

Name (S)
 

Species the name of this tree. The name is Tree.
 

Tree Node  
A tree node corresponds to one folder that Siebel CRM displays in a tree applet. It references the following items:

• Label. Species the source of the text that Siebel CRM displays next to this folder.
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• Applet. Species the name of the applet that Siebel CRM displays in the right half of the view if the user opens
the folder.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Tree > Tree Node

The following table describes properties that Siebel CRM uses with a tree node.

Property Description

Applet (O)
 

Species the applet that Siebel CRM displays if the user clicks this tree node. This applet is typically a
list applet. A list applet is not required. If the Applet property is empty, then Siebel CRM does nothing.
 

Bitmap Category (O)(H)
 

Not used.
 

Bitmap Index (O)(H)
 

Species an integer that Siebel CRM uses to choose a bitmap for the document symbol as a subset of a
multiimage bitmap. Siebel CRM uses this property internally. You must set it to the following value:
 

5 = document symbol

Bitmap Index Field (O)(H)
 

Not used.
 

Business Component (O)
 

Species the business component that Siebel CRM uses to populate values in this tree node. You
specify the same business component that the applet references. You specify this applet in the Applet
property of this tree node.
 

Display Name (O)
 

Species the text that Siebel CRM displays next to the folder that it displays for this tree node.
 

HTML Closed Bitmap (O)
 

Species the bitmap object that denes the properties of a closed folder image. The parent of the
bitmap object must be the HTML Tree Icons bitmap category.
 
If the HTML Closed Bitmap property is not empty, then it overrides the Close Bitmap property of the
HTML hierarchy bitmap object.
 

HTML Open Bitmap (O)
 

Species the bitmap object that denes the properties of an open folder image. The parent of the
bitmap object must be the HTML Tree Icons bitmap category.
 
If the HTML Open Bitmap property is not empty, then it overrides the Open Bitmap property of the
HTML hierarchy bitmap object.
 

Label Field (O)
 

Species the name of a business component eld that Siebel CRM uses to populate the names of the
document object denitions in this tree node.
 

Max Child Items (O)
 

Species an integer that sets a limit on the number of child items that Siebel CRM displays in this tree
node.
 

Name (R)
 

Species the name of this tree node. This name must be unique in the tree.
 

Position (R)
 

Species the position where Siebel CRM places this tree node in the tree hierarchy. This value includes
integer values separated by periods. For example:
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Property Description

1.2.3.14

where:
 

• 1 is the top level in the hierarchy.

• 2 is one level below level 1.

• 3 is one level below level 2.

• 14 is one level below level 3 and indicates that this tree node is in the 14th position of level 4.

Recursive (S)
 

If TRUE, then this tree node and all the tree nodes below it include the same type of Siebel CRM data.
For example, an account can include subaccounts. Each of these subaccounts can include more
subaccounts.
 

Recursive Link (O)
 

Species the name of the link that denes the relationship with the business component. You can use
it only if the Recursive property of this tree node is TRUE.
 

Root Search Spec (O)
 

Species a string value that determines the list of records at the top level of the tree. You use it
primarily for a recursive tree to create a starting point for the tree. For example:
 

[Parent Account Id] is NULL

Selected Bitmap Index (O)(H)
 

Species an integer that identies the bitmap in a multiple bitmap le that Siebel CRM displays if the
user chooses a record. You must use the following value:
 

5

Selected Bitmap Index Field (O)(H)
 

Not used.
 

Tree Node Locale  
A tree node locale denes language overrides that Siebel CRM uses with a tree node.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Tree > Tree Node > Tree Node Locale

The following table describes properties that Siebel CRM uses with a tree node locale.

Property Description

Display Name (O)
 

Species the text that Siebel CRM displays next to the folder that corresponds to the tree node.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU
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Application Object Types  
This topic describes the Application object type and the object types that are children of this object type. It includes the
following topics:

• Application

• Application Browser Script

• Application Event Services

• Application Find

• Application Locale

• Application Method Menu Item (H)

• Application Method Menu Item Locale (H)

• Application Server Script

• Application Toolbar (H)

• Application User Prop (H)

• Page Tab

• Page Tab Locale

• Screen Menu Item

• Screen Menu Item Locale

Application  
An application denes the screens and views that the user can access through menus and page tabs. You must not
congure Siebel Tools as an application in the same way that you congure a Siebel CRM application, such as Siebel
Sales or Siebel Service. Although the views and applets that Siebel Tools uses do exist in the repository, you must not
modify this information.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Applet Web Template > Applet Web Template Item > Siebel Object Types Reference >
Application

The following table describes properties that Siebel CRM uses with an application.

Property Description

Acknowledgement Web Page (O)
 

Species the name of the Web page that Siebel CRM displays after the user logs in.
 
Siebel CRM uses the Acknowledgement Web Page property only if the Acknowledgement Web View
property does not contain a value.
 
The Acknowledgement Web Page property or the Acknowledgement Web View property must contain
a value.
 

Acknowledgement Web View (O)
 

Species the name of the view that Siebel CRM displays after the user logs in.
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Property Description

The Acknowledgement Web Page property or the Acknowledgement Web View property must contain
a value.
 

Company Logo Bitmap (O)(H)
 

Species the name of a bitmap object denition in the Company Logos bitmap category.
 

Container Web Page (O)
 

Species the Web page object denition that Siebel CRM uses to display the elements that surround
a Siebel view. This page contains typical user interface elements, such as viewbars, screenbars, logos,
 and so on.
 
All views, pages, and applets use the page that the Container Web Page properties species, by default.
The Container Page property of a view can override this conguration.
 

Default Find (O)
 

Species the default value for a Find object. If the Default Find property of the Application Find object
is True, then Siebel CRM displays this Find object in the Look In drop-down list in the Search Center.
 

Display Name (O)
 

Species the name that Siebel CRM displays on menus and page tabs for an application.
 

Error Web Page (O)
 

Species the error page that Siebel CRM displays if an error occurs. This value must reference a Web
Page object type.
 

Login Web Page (O)
 

Species the page that Siebel CRM displays that allows the user to enter a user name and password.
This value must reference a Web Page object type.
 

Logo Acknowledgement Web Page (O)
 

Species the page that Siebel CRM displays after the user logs o. This value must reference a Web
Page object type.
 

Menu (O)
 

Species the menu object denition that Siebel CRM uses.
 

Name (R)
 

Species a unique application name.
 

Scripted (S)
 

Species if a Siebel VB or Siebel eScript script is aached to the Application object. It can contain one
of the following values:
 

• TRUE. Siebel script aached.

• FALSE. No Siebel script aached.

Sort Web Page (O)
 

Species the page that allows the user to choose the elds to sort in a list applet. This value must
reference a Web Page object type.
 

Text Style (O)(H)
 

Species the text style that Siebel CRM uses by default for all controls in the application object. It uses
this property only if the control, applet, or view do not specify a text style.
 
The conguration le provides the default value for this property.
 

Task Screen (O)
 

Species the screen that allows the user to restart a task UI.
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Application Browser Script  
An application browser script denes the browser script that an application uses.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Application Browser Script

The following table describes properties that Siebel CRM uses with an application browser script.

Property Description

Browser Group (O)
 

Species the browser type that this script supports.
 

Name (R)
 

Species a unique name for this script. To create this value, Siebel Tools automatically combines the
values in the User Agent property and the Procedure property.
 
You must not modify this property.
 

Procedure (O)
 

Species the name of the function or the procedure.
 

Script (O)
 

Species the text for the function.
 

Application Event Services  
A application event services denes the application event services that Siebel CRM uses.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Application Event Services

The following table describes properties that Siebel CRM uses with an application event services.

Property Description

Event Name (R)
 

Species the name of the application event service. It can include only the following value:
 

Start

Method Name (R)
 

Species the name of the business service method that Siebel CRM must call. It can include only the
following value:
 

Start

Name (R)
 

Species the event description.
 

Sequence (R) Species the order that Siebel CRM uses to process the services. This property only contain an integer.
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Property Description

   

Business Service (R)
 

Species the name of the business service that Siebel CRM must call.
 

Application Find  
An application nd denes the nd object denitions that Siebel CRM uses for an application.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Application Find

The following table describes properties that Siebel CRM uses with an application nd.

Property Description

Default Find (O)
 

Species the default value for a Find object. If the Default Find property of the Application Find object
is True, then Siebel CRM displays this Find object in the Look In drop-down list in the Search Center.
 

Find (R)
 

Species the name of the nd object denition that Siebel CRM includes in the application object. For
example:
 
Contact
 

Name (R)
 

Same as the Find property.
 

Sequence (O)
 

Species the order that Siebel CRM uses relative to other application nd objects that it includes in the
Find dialog box. This property can contain only an integer.
 

Application Locale  
An application locale denes language overrides that Siebel CRM uses with an application.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Application Locale

The following table describes properties that Siebel CRM uses with an application locale.

Property Description

Display Name (O)
 

Species the name that Siebel CRM displays on menus and page tabs for an application for a language.
 

Name (R) Species the abbreviation for the language that the Siebel CRM application uses. For example:
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Property Description

   
ENU

Application Method Menu Item (H)  
An application method menu item denes the menu for the application object.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Application Method Menu Item

The following table describes properties that Siebel CRM uses with an application method menu item.

Property Description

Menu Text (R)
 

Species the text that Siebel CRM displays in the menu item.
 

Method (R)
 

Species the method that the menu item calls.
 

Name (R)
 

Species the name of the application method menu item.
 

Position (R)
 

Species the position of the menu item in the menu tree. For example, the following position identies
the rst menu item of the submenu that resides in the third menu item. This third menu item resides in
the top-level menu:
 

3.1

Application Method Menu Item Locale (H)  
An application method menu item locale denes language overrides that Siebel CRM uses with an application method
menu item.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Application Method Menu Item (H) > Application Method Menu Item Locale

The following table describes properties that Siebel CRM uses with an application method menu item locale.

Property Description

Menu Text (R)
 

Species the text that Siebel CRM displays in the menu item for a language.
 

Name (O)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
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Application Server Script  
An application server script denes the Siebel VB and Siebel eScript script that an application object contains. For more
information, see  Siebel Object Interfaces Reference .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Application Server Script

An application server script uses the same properties as an applet script. For more information, see Applet Script (H).

Application Toolbar (H)  
An application toolbar associates a toolbar with an application. Dierent applications can use dierent toolbars.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Application Toolbar

The following table describes properties that Siebel CRM uses with an application toolbar.

Property Description

Name (R)
 

Species the name of the application toolbar object denition. This name must be unique in this
application.
 

Sequence (O)
 

Species the order that Siebel CRM uses to display this toolbar relative to other toolbars that it displays
at the top of the main window. This property can contain only an integer.
 

Toolbar (R)
 

Species the name of the toolbar object denition that Siebel CRM uses in an application.
 

Application User Prop (H)  
An application user prop is for Oracle use only.

Page Tab  
A page tab denes the screens that the user access through a page tab.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Page Tab

The following table describes properties that Siebel CRM uses with a page tab.

Property Description

Bitmap Category (O)(H)
 

Reserved for future use.
 

Screen (R)
 

Species the screen that Siebel CRM displays if the user clicks a page tab. For example:
 

Accounts Screen

Sequence (O)
 

Species the order that Siebel CRM uses when it displays the page tabs. This property can contain only
an integer.
 

Text (R)
 

Species the text or the key to localized text that Siebel CRM displays on the page tab. For example:
 

Accounts

Page Tab Locale  
A page tab locale denes language overrides that Siebel CRM uses with a page tab.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Page Tab > Page Tab Locale

The following table describes properties that Siebel CRM uses with a page tab locale.

Property Description

Name (R)
 

Species the abbreviation for the language that Siebel CRM uses. For example:
 

ENU

Text (O)
 

Species the text or the key to localized text Siebel CRM displays on the page tab.
 

Screen Menu Item  
A screen menu item adds a menu item to a screen menu.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Screen Menu Item

75



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

The following table describes properties that Siebel CRM uses with a screen menu item.

Property Description

Screen (R)
 

Species the name of the screen that this screen menu item displays. If a screen contains multiple
screen views, and if the user clicks a screen menu item, then Siebel CRM expands this screen menu
item and then displays screen menu items for each of these views.
 

Sequence (O)
 

Species the order that Siebel CRM uses to display this screen menu item on the Screen menu.
 

Text (R)
 

Species the text label that Siebel CRM uses for this screen menu item. If localized text exists for this
screen menu item, then the value in this Text property is a key that identies the message table that
Siebel CRM uses to nd the localized text.
 

Screen Menu Item Locale  
A screen menu item locale denes language overrides for a screen menu item.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Screen Menu Item > Screen Menu Item Locale

The following table describes properties that Siebel CRM uses with a screen menu item locale.

Property Description

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Text (O)
 

Species the text that Siebel CRM uses for the screen menu item.
 

Assignment Aribute Object Types  
This topic describes the Assignment Aribute object type and the object types that are children of this object type. It
includes the following topics:

• Assignment Aribute

• Assignment Aribute Column
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Assignment Aribute  
An assignment aribute does the following:

• Denes an aribute that an assignment criteria can reference.

• Species the picklist that Siebel CRM uses in the Values applet in the Assignment Criteria view that an
administrator can use in the client to congure an aribute.

• Does not directly specify a database column or a combination of database columns. The child assignment
aribute column denes a column mapping.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Application > Assignment Aribute

The following table describes properties that Siebel CRM uses with an assignment aribute.

Property Description

Bounded (O)
 

You can use one of the following values:
 

• TRUE. The administrator must choose a value from the picklist.

• FALSE. The administrator can enter a value that the picklist does not display.

Data Type (R)
 

Species the data type for the assignment aribute. You can use one of the following values:
 

• Varchar

• Number

Name (R)
 

Species the name of the assignment aribute. The value that this property contains must be unique
in the repository.
 

Order By LOV Type (O)
 

Not used.
 

Pick Field (O)
 

Species the name of the eld that the administrator can choose from the picklist. You can use one of
the following values:
 

• Created

• Created By

• Id

• Updated

• Updated By

Picklist (O)
 

Species the name of the picklist that provides the values that populate a list column in the Values
applet in the Assignment Criteria view.
 

Translate Pick Field (O)
 

Species to save the Language Independent Code in the Siebel database or in the display value for the
assignment criteria.
 

Use Range (O)
 

You can use one of the following values:
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Property Description

• TRUE. Display a pair of list columns that allows an administrator to specify a range of values for
assignment criteria aributes.

• FALSE. Display a single column that requires the administrator to specify a single value for
assignment criteria aributes.

For example, the Use Range property of the Revenue assignment aribute is TRUE. It displays two list
columns: Revenue Low and Revenue High. It allows the administrator to enter 50000 in the Revenue
Low column and 100000 in the Revenue High column to indicate a range of $50,000 through $100,
000.
 

Checking In Assignment Objects  
You must check the project that an assignment object references in to the Siebel Server.

Assignment Aribute Column  
An assignment aribute column does the following:

• Assigns an assignment aribute to an assignment object and a workow policy component column. These
mappings set up value matching in the assignment object and workow policy object for criteria that use the
parent assignment aribute.

• Maps an assignment object to a workow policy component column.

• Each assignment aribute column can specify a dierent assignment object or a dierent aribute in the same
assignment object.

You must check in modications you make. For more information, see Checking In Assignment Objects.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Assignment Aribute > Assignment Aribute Column

The following table describes properties that Siebel CRM uses with an assignment aribute column.

Property Description

Assignment Object (R)
 

Species an assignment object. Siebel CRM examines the values that this object contains to determine
if a match exists with values that the parent assignment aribute contains.
 

Name (R)
 

Species the name of the assignment aribute column. You can use the following format:
 

 assignment_object: workflow_policy_component_column

 

For example:
 

Account: Area Code

Sequence (R)
 

Species a unique sequence number for the assignment aribute column.
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Property Description

If an assignment aribute contains multiple assignment aribute columns, then Assignment Manager
searches for aribute values in the order that you dene them in this property.
 
This property can contain only an integer.
 

Workow Policy Component (R)
 

Species the name of the workow policy component in the workow policy object that this
assignment aribute column references. For example:
 

Account

Workow Policy Component Column (R)
 

Species the name of the workow policy component column in the workow policy component that
this assignment aribute column references. For example:
 

Account Area Code

Workow Policy Object (R)
 

Species the name of the workow policy object that this assignment aribute column references. For
example:
 

Account

Assignment Criteria Object Types  
This topic describes the Assignment Criteria object type and the object types that are children of this object type. It
includes the following topics:

• Assignment Criteria

• Assignment Criteria Aribute

• Assignment Criteria Aribute Locale

• Assignment Criteria Locale

Assignment Criteria  
An assignment criteria denes an aribute that Siebel CRM uses in an assignment criteria record. Siebel CRM displays
assignment criteria in the picklist that it displays if the user clicks in the Criteria list column when the user edits an
assignment criteria record in the client.

You must check in modications you make. For more information, see Checking In Assignment Objects.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Assignment Criteria

The following table describes properties that Siebel CRM uses with an assignment criteria.

Property Description

Display Flag (O)
 

You can use one of the following values:
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Property Description

• TRUE. Display the Criteria object in the Assignment Criteria view in the client.

• FALSE. Do not display the Criteria object in the Assignment Criteria view in the client.

Display Name (O)
 

Species the name that Siebel CRM displays for this assignment criteria object in the picklist and in the
Criteria list column in the Assignment Criteria applet in the Assignment Criteria view.
 
If Display Name does not contain a value, then Siebel CRM uses the value in the Name property.
 

Employee Skill (O)
 

You can use one of the following values:
 

• TRUE. Display the Assignment Criteria object in the Skill applets in the client.

• FALSE. Do not display the Assignment Criteria object in the Skill applets in the client.

Name (R)
 

Species the name of the assignment criteria.
 

Team
 

Species Used with dynamic candidates feature.
 
You can use one of the following values:
 

• TRUE. Use a column on the team table to calculate assignment criteria.

• FALSE. Do not use a column on the team table to calculate assignment criteria.

Use Expertise (O)
 

You can use one of the following values:
 

• TRUE. Assignment Manager uses the expertise code to match an assignment object to a person.

• FALSE. Assignment Manager does not use the expertise code to match an assignment object to a
person.

Assignment Criteria Aribute  
An assignment criteria aribute allows an assignment criteria to include multiple aributes.

You must check in modications you make. For more information, see Checking In Assignment Objects.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Assignment Criteria > Assignment Criteria Aribute

The following table describes properties that Siebel CRM uses with an assignment criteria aribute.

Property Description

Assignment Aribute (R)
 

Species the assignment aribute that this assignment criteria aribute references.
 

Display Name (R)
 

Species the list column label that Siebel CRM displays for this assignment criteria aribute in the
Values list applet. If this property does not include a value, then Siebel CRM uses the name in the list
column label.
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Property Description

Display Sequence (R)
 

Species the order that Siebel CRM uses to display the list column for this assignment criteria aribute
in the list applet relative to other assignment criteria aributes in the assignment item. A lower number
places the list column farther to the left.
 

Display Sequence - Language Override
 

Allows you to order the list columns in the list applet dierently for dierent languages.
 

Name (R)
 

Species the name of the assignment criteria aribute. This name must be unique in the parent
assignment criteria.
 

Pick Applet (O)
 

Species the name of the pick applet that Siebel CRM displays in a picklist. If a picklist is dened, then
this picklist allows the user to choose a value in a list column for the assignment aribute.
 

Store Column (R)
 

Species the column in the S_ASGN_RULE_ITEM (assignment rule item) table that contains the value
for the assignment criteria aribute. To save assignment criteria aribute values for each assignment
criteria, Siebel CRM uses four columns for each of the following data types:
 

• Number

• Varchar

The Data Type property in the assignment aribute determines this data type.
 
The Store Column property must contain one of the following unique values for each assignment
criteria aribute that uses the same data type:
 

• 1

• 2

• 3

• 4

Assignment Criteria Aribute Locale  
An assignment criteria aribute locale denes language overrides that Siebel CRM uses with an assignment criteria
aribute.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Assignment Criteria > Assignment Criteria Aribute > Assignment Criteria Aribute Locale

The following table describes properties that Siebel CRM uses with an assignment criteria aribute locale.

Property Description

Display Name (R)
 

Species the list column label that Siebel CRM displays for this assignment criteria aribute in the
Values list applet for a language.
 

Display Sequence
 

Species the order that Siebel CRM uses to display the list column for this assignment criteria aribute
in the list applet relative to other assignment criteria aributes in the assignment item. A lower number
places the list column farther to the left.
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Property Description

 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Assignment Criteria Locale  
An assignment criteria locale denes language overrides that Siebel CRM uses with an assignment criteria.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Assignment Criteria > Assignment Criteria Locale

The following table describes properties that Siebel CRM uses with an assignment criteria locale.

Property Description

Display Name (R)
 

Species the name that Siebel CRM displays for this assignment criteria in the picklist and the Criteria
list column in the Assignment Criteria applet in the Assignment Criteria view for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Bitmap Category Object Types  
This topic describes the Bitmap Category object type and the object types that are children of this object type. It
includes the following topics:

• Bitmap

• Bitmap Category

• Bitmap Locale

Bitmap  
A bitmap references a GIF or JPG image le that a buon control or another object uses. Each bitmap image in the
repository can exist in only one bitmap category.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Bitmap Category > Bitmap

The following table describes properties that Siebel CRM uses with a bitmap.
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Property Description

Alt Text (O)
 

Species alternative text that Siebel CRM uses instead of the value that the Name property contains.
 

Data (S)(H)
 

Species the bitmap data.
 

File Name (O)
 

Species the le name of the bitmap. The following directory is the default directory for this le:
 

\public\language\images 

where:
 

• language is enu for U.S. English.

Height (S)
 

Species the height in pixels of the bitmap.
 

MIME Type (O)
 

Species the MIME type of the le contents.
 

Name (R)
 

Species the name of the bitmap object denition.
 

Transparent Color (O)(H)
 

Species to use 1-bit transparency support for logos, toolbars, buons, and similar bitmap object
denitions.
 
If the user sets a custom background color, then this conguration allows Siebel CRM to use this
background color so that a toolbar buon or applet buon that displays over this background is visible.
 
The color you choose or enter in the Transparent Color property species the color that Siebel CRM
uses as a substitute for a Clear color. You can enter it as a triplet of integers. You can also click the
Transparent Color buon during a bitmap import and then use the color selection dialog box that
Siebel Tools displays.
 

Width (S)
 

Species the width in pixels of the bitmap.
 

Bitmap Category  
A bitmap category allows Siebel CRM to group bitmaps according to function or some other relationship. You can use
some predened bitmap categories only for a specic purpose. For example, the Background Bitmap property of an
applet references the Applet Backgrounds bitmap category for the bitmap le.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Bitmap Category

The following table describes properties that Siebel CRM uses with a bitmap category.

Property Description

Name (R)
 

Species the name of the bitmap category.
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Property Description

Predened (O)(H)
 

You can use one of the following values:
 
TRUE. A predened bitmap category that typically contains a bitmap le that you or Oracle provides.
You can add or remove a bitmap le from a predened category. You cannot delete or rename the
object denition for a bitmap category.
 
FALSE. A bitmap category that you provide. You can create, delete, or modify the object denition of
the bitmap category. This bitmap is typically a view bar logo that uses the Logo.bmp name. You provide
the bitmap category name and reference it in the Bitmap Category property of the view.
 

Bitmap Locale  
A bitmap locale denes a language override that Siebel CRM uses with a bitmap.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Bitmap > Bitmap Locale

The following table describes properties that Siebel CRM uses with a bitmap locale.

Property Description

Alt Text (O)
 

Alternative text that Siebel CRM uses instead of the parent name property for a bitmap for a language.
 

Name (R)
 

The abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Business Component Object Types  
This topic describes the Business Component object type and the object types that are children of this object type. It
includes the following topics:

• BusComp Browser Script

• BusComp Server Script

• BusComp View Mode

• Business Component

• Business Component User Prop

• Field

• Field Locale

• Field User Prop

• Join

84



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

• Join Constraint

• Join Specication

• Multi Value Field

• Multi Value Link

• MVF Pick Map

• MVF Pick Map UpdOnlyIfNull

• Pick Map

• Pick Map UpdOnlyIfNull

• Single Value Field

• SVF Pick Map

• SVF Pick Map UpdOnlyIfNull

BusComp Browser Script  
A buscomp browser script denes the browser script that a business component uses.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > BusComp Browser Script

The following table describes properties that Siebel CRM uses with a buscomp browser script.

Property Description

Browser Group (O)
 

Not used.
 

Name (R)
 

Species a unique name for the script. To dene this property, Siebel Tools automatically combines the
Browser Group and Procedure properties. You must not modify this property.
 

Procedure (O)
 

Species the name of the function or the procedure.
 

Script (R)
 

The text for the script.
 

BusComp Server Script  
A buscomp server script denes Siebel VB or Siebel eScript script for a business component. For more information, see 
Siebel Object Interfaces Reference .

Starting with Siebel CRM version 7.0, buscomp server scripts replace business component scripts.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > BusComp Server Script

A buscomp server script uses the same properties as a applet script. For more information, see Applet Script (H).
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BusComp View Mode  
A buscomp view mode denes access control for a business component in a view.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > BusComp View Mode

The following table describes properties that Siebel CRM uses with a buscomp view mode.

Property Description

Name (R)
 

Species the view mode name. To examine the values you can use, you can click this Name property in
Siebel Tools.
 

Owner Type (R)
 

Species the owner of the records in the current view mode. For example, if the user chooses My
Opportunities, then the position is the owner of the opportunities that Siebel CRM displays.
 
To examine the values you can use, you can click this Owner Type property in Siebel Tools.
 
For more information about using the Owner Type property, see the topic about business component
view mode elds in  Siebel Security Guide .
 

Private Field (O)
 

Species the name of a eld that indicates private or public access to a record. This eld is typically
named Private or Private Flag. This property allows Siebel CRM to display private predened queries
that a user creates and public queries that an administrator creates. It can display these queries in the
same list.
 
The eld that the Private Field property references contains a TRUE or FALSE value that indicates if the
record is private. This value determines the following visibility:
 

• Private. Only the record owner can view this record.

• Not private. All users can view this record.

Visibility Field (O)
 

Species the eld that Siebel CRM uses to establish single-owner visibility. This eld identies the
record ID of a record that the business component contains.
 

Visibility MVField (O)
 

Species the name of the multivalue eld that Siebel CRM uses to maintain the list of owners that it
displays in team visibility. This eld typically references the Name property in the business component.
Siebel CRM uses this property with the Visibility MVLink property.
 
To examine the values you can use, you can click this Visibility MVField property in Siebel Tools.
 

Visibility MVLink (O)
 

Species the name of the multivalue link that Siebel CRM uses to maintain the list of owners that it
displays in team visibility. Siebel CRM uses this property with the Visibility MVField property.
 
To examine the values you can use, you can click this Visibility MVLink property in Siebel Tools.
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Business Component  
A business component denes a logical entity that organizes columns from one or more tables into a single entity. It
provides a foundation that controls how Siebel CRM chooses, inserts, and updates data in underlying tables. This data
is typically specic to a functional area, such as a product, a contact, or an account. An applet references a business
component. It does not directly reference the tables. This conguration allows you to reference data according to
functional area. It might also separate work that a developer performs from work that an administrator performs.

A virtual business component denes external data. For more information, see Properties of the Field Object Type That
Siebel CRM Supports for a Virtual Business Component.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component

The following table describes properties that Siebel CRM uses with a business component.

Property Description

Browser Class (O)(H)
 

Not used.
 

Cache Data (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM does the following:

◦ If a query runs more than one time on a business component, and if each query uses the same
search specication, the Siebel CRM reads business component data only one time for all of these
queries.

◦ If a query runs more than one time on a business component, and if each query uses a dierent
search specication, then Siebel CRM reads data for each query.

• FALSE. Siebel CRM reads business component data for each query.

For more information, see Conguring the Cache Data Property of a Business Component.
 

Class (R)
 

Species the name of the class that determines the conguration of the business component. For
example, you can use the following value:
 

CSSBcVAbsResult

Data Source (O)
 

Allows a business component to use a dierent name for the conguration le that identies the data
source. This name is dierent from the name that the Siebel CRM application currently uses. Server or
Local are examples of a data source. This conguration allows a business component to get data from
a database other than the typical SQL database.
 
If a business component species a data source, then all the tables it implicitly and explicitly joins must
reside in the same data source.
 
If the Data Source property is empty, then Siebel CRM uses the same data source that it uses to start
the Siebel CRM application.
 

Dirty Reads (O)
 

You can use one of the following values:
 

• TRUE. The business component supports database dirty reads.
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Property Description

• FALSE. The business component does not support database dirty reads.

Siebel CRM uses this property only if it use a Sybase database. If Siebel CRM does not use a Sybase
database, then it ignores this property. It is recommended that you modify the default seing of TRUE
for this property only to support workow processes or Enterprise Application Integration (EAI).
 
If TRUE, then the user can read data that can be modied without their knowledge. This conguration
might be desirable in a situation where the data is available for reading and anybody can update it. If
dirty reads are not allowed, then nobody can update the data until everybody nishes displaying this
data.
 
If dirty reads are allowed, and if another user does not modify the same record since Siebel CRM last
queried this record, then it updates data immediately. For example, if user A updates a record, and
if user B is not aware of this update and then aempts to update the same record, then Siebel CRM
displays a message to user B that states that the data was updated and the user must requery.
 

Distinct (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM suppresses system elds. Allows the equivalent of a distinct query because it
suppresses system elds, such as Created, Updated, Id, and so.

• FALSE.Siebel CRM does not suppress system elds.

Enclosure Id Field (O)
 

Species the ID of a recipient of literature, typically the contact ID.
 

Extension Type (O)
 

You can use one of the following values:
 

• JOIN. Siebel CRM joins the extension table and gets the extended data and the other data that it
requires.

• LINK. Siebel CRM uses a separate SQL statement that gets extended data. It uses this property
with a Sybase database server because Sybase uses a 2 KB record length limit.

If the Extension Type property is empty, and if Siebel CRM:
 

• Uses Sybase. This property defaults to LINK.

• Does not use Sybase. This property defaults to JOIN.

Force Active (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM gets all elds from the server database. This conguration degrades business
component performance. It is not recommended.

• FALSE. Siebel CRM gets only the elds that the client registers or that a specialized business
component requests. This conguration improves performance.

GenReassignAct (O)
 

You can use one of the following values:
 

• TRUE. If the business component uses a multivalue group for visibility, and if Siebel CRM modies
the primary team member, then it creates an activity.

• FALSE. Siebel CRM does not create an activity.

Hierarchy Parent Field (O)
 

Species the eld that contains the parent data in a hierarchy. It allows Siebel CRM to display nesting in
a hierarchical list applet.
 

Insert Update All Columns (S)
 

Used internally to make each SQL INSERT or UPDATE statement include a column. This conguration
allows Siebel CRM to reuse parsed statements more eectively during batch processing.
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You must not modify this value.
 

Log Changes (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM enables logging.

• FALSE. Siebel CRM disables logging.

CAUTION:
Siebel CRM sets this property to TRUE, by default. You must not modify it. Any modication
you make might adversely aect data integrity.
 

Maximum Cursor Size (O)
 

Species the maximum number of records that Siebel CRM can get from the server database. It applies
only to an Oracle or DB2 UDB database. You can use one of the following numbers:
 

• - 1. Siebel CRM gets records until it encounters an EOF (end of le) record.

• A number greater than 0. Siebel CRM gets the number of records that you specify.

If the Maximum Cursor Size property contains a value, then this value overrides the MaxCursorSize
parameter in the conguration le.
 
You can also use this property with a multivalue group business component. For more information, see
Conguring a Multivalue Group Business Component.
 

Multi Recipient Select (S)
 

You can use one of the following values:
 

• TRUE. Siebel CRM allows the user to choose multiple recipients.

• FALSE. Siebel CRM does not allow the user to choose multiple recipients.

The Service Request business component sets this property.
 

Name (R)
 

Species the name for the business component. This name must be unique among business
components. It can include spaces. It cannot include special characters.
 

No Delete (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM does not allow the user to delete a record in an applet that references this
business component.

• FALSE. Siebel CRM allows the user to delete a record in an applet that references this business
component.

If the Admin Mode Flag property of the current view is TRUE, then Siebel CRM ignores this property.
 

No Insert (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM does not allow the user to insert a record in an applet that references this
business component.

• FALSE. Siebel CRM allows the user to insert a record in an applet that references this business
component.

If the Admin Mode Flag property of the current view is TRUE, then Siebel CRM ignores this property.
 

No Merge (O)
 

You can use one of the following values:
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• TRUE. Siebel CRM does not allow the user to merge two existing records into a single record in an
applet that references this business component.

• FALSE. Siebel CRM allows the user to merge two existing records into a single record in an applet
that references this business component. You must also set the No Delete property to FALSE
because merging requires Siebel CRM to delete one of the records that it merges.

If the Admin Mode Flag property of the current view is TRUE, then Siebel CRM ignores this property.
 

No Update (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM does not allow the user to update a record in an applet that references this
business component.

• FALSE. Siebel CRM allows the user to update a record in an applet that references this business
component.

If the Admin Mode Flag property of the current view is TRUE, then Siebel CRM ignores this property.
 

Owner Delete (O)
 

You can use one of the following values:
 

• TRUE. Only the owner can delete a record.

• FALSE. Anyone can delete a record.

The following visibility determines the owner:
 

• Team visibility. The owner is the primary position on the sales team. Team visibility occurs if the
Visibility MVLink property and the Visibility MVField property of the BusComp View Mode each
includes a value.

• Position visibility. The owner is the position that the visibility eld contains. The Visibility Field
property of the BusComp View Mode species this eld.

If a view uses Admin mode, then Siebel CRM disables the Owner Delete property and any user who can
access the view can delete the record.
 

Placeholder (O)
 

Not used.
 

Popup Visibility Auto All (O)
 

You can use one of the following values:
 

• TRUE. Pop-up visibility is All.

• FALSE. The Popup Visibility Type property determines pop-up visibility.

Popup Visibility Type (O)
 

Species the type of pop-up visibility. To view the values you can use, click the Popup Visibility Type
property in Siebel Tools. If this property is empty, then Siebel CRM uses the Sales Rep default value.
 

PreFetch Size (O)
 

Species the number of records that Siebel CRM gets from the server database for a business
component. If this property includes a value, then it overrides the MaxCursorSize parameter in the
conguration le.
 
If you set the PreFetch Size property to the same value that the Maximum Cursor Size property
contains, then Siebel CRM does the following:
 

• Reads the number of records that you specify in the PreFetch Size parameter.

• Resets the Siebel database cursor so that Siebel CRM can use it for a subsequent query.

You can use this property with the Maximum Cursor Size property only with a DB2 UDB database.
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You can use this property with a multivalue group business component. For more information, see
Conguring a Multivalue Group Business Component.
 

Recipient Id Field (O)
 

Species the eld that references the recipient IDs. This ID is typically the Contact ID. This property
species the eld that references the ID. It does not specify the ID.
 
If the user uses CTRL+L in the Service Request screen to create recipients, and if the Recipient Id Field
property of the Service Request business component is empty, then Siebel CRM does not create any
recipients.
 

Reverse Fill Threshold (O)
 

Species the maximum number of records that Siebel CRM reads when it runs the rst record or the
last record request. It does this before the SQL statement that automatically reruns with a reversed sort
sequence.
 
The default value is 100.
 

Scripted (S)
 

Indicates a Siebel VB or Siebel eScript script is aached to the business component:
 
TRUE. Script is aached.
 
FALSE. No script is aached.
 

Search Specication (O)
 

Species a conditional expression that Siebel CRM uses to restrict the records it gets for this business
component. You can enter a maximum of 255 characters in this property.
 

Sort Specication (O)
 

Species the sort expression that Siebel CRM uses to sort the records it gets from the server database.
 
If the business component references any class other than CSSBusComp, then Siebel CRM might
disable the sort specication.
 
For performance reasons, the Application Object Manager ignores the sort specication property for
the All view mode and the Manager view mode.
 
You cannot dene a sort specication on an administrative list.
 
The user can sort records after the rst query. To improve performance, Siebel CRM requires the user
to lter for a smaller record set.
 
You can enter a maximum of 255 characters in this property.
 
For more information, see Business Component User Prop.
 

Status Field (O)
 

Species the name of a eld that contains the value that determines the New status for a record. If this
eld value is:
 

• TRUE. The record is new and no user has viewed it.

• FALSE. A user has viewed the record.

You use this property with the visibility properties of the business component, such as the Visibility
MVLink property and the Position Visibility Field property.
 

Synonym Field (O)
 

Species the eld that contains synonyms for the business component. If this property includes a
value, then any bounded picklist that the business component contains searches these synonyms.
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Property Description

Table (R)
 

Species the name of the primary SQL table where Siebel CRM gets records for this business
component. The table name is case-sensitive. It must use the same format that it uses in the Siebel
database.
 
A virtual business component does not use this property.
 

Type
 

You can use one of the following values:
 

• Transient. Save data only when the task UI commits it. You use this value only with a task UI.

• Non-Transient. Save data in an underlying table. You use this value with any business component
that a task UI does not reference.

For more information, see  Siebel Business Process Framework: Task UI Guide .
 

Upgrade Ancestor
 

For more information, see Common Object Properties.
 

XA Aribute Value BusComp (O)
 

Species the child business component that contains the aribute values for this business component.
This property enables extended dynamic aributes for this business component.
 

XA Class Id Field (O)
 

Species the eld that this business component references that contains the class data.
 

Restrictions on Inserts, Updates, and Deletes  
An insert, update, or delete operation aects data in the table that the Table property of a business component
references. It does not aect data in a table that a join references.

How Siebel CRM Persists a Business Component Instance  
Siebel CRM ends the persistence of a business component instance when the business object instance that references
this business component instance ends.

Conguring the Cache Data Property of a Business Component  
If Siebel CRM caches data for a business component, and if it modies the contents of this cache, then this business
component might reference obsolete data. This problem might occur in the following situations:

• A user modies some data through another business component. For example, the user modies data through
a business component that uses a multivalue link.

• Another user modies data while the user who rst modied this data is still connected.

For this reason, it is recommended that you congure Siebel CRM to use caching only with static data, such as a list of
values or a product. Do not congure Siebel CRM to use caching with data that the user might modify frequently, such
as accounts or opportunities. If you do this, then the client cache might not remain synchronized with data in the server
database.

It is recommended that you do not set the Cache Data property of a business component to TRUE and also set the Use
Primary Join property of a multi value link to TRUE. If Siebel CRM modies the primary record of a multivalue group
business component in this situation, then it might not update data for the cached parent.

92



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Conguring a Multivalue Group Business Component  
You can use the Maximum Cursor Size property and the PreFetch Size property with a multivalue group business
component. These properties are available only with a DB2 UDB database. The following items aect the number of
rows that Siebel CRM returns for the rst operation that a multivalue group business component performs:

• If the multivalue group business component uses aggregation, then it reads every record. The sum function
and the count function are examples of aggregation.

• A multivalue group business component aempts to make the primary record the current record. Siebel CRM
loads records until it nds the primary record. For example, if the primary record is the 4,000th record, then
it loads 4,000 records. To prevent this conguration, you can use a detail view instead of a multivalue group.
For example, you can use the Contact - Address detail view with the Contact in the top applet and a list of
addresses in the boom applet.

Business Component User Prop  
A business component user prop sends a property value to the C++ code that implements specialized business
component conguration. If you congure the value for a user property, then Siebel CRM persists this value in the Siebel
runtime repository. For more information, see Object Types That You Must Not Modify.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Business Component User Prop

The following table describes properties that Siebel CRM uses with a business component user prop.

Property Description

Name (R)
 

Species the name of the user property.
 

Value (R)
 

Species the value of the user property.
 

How a Business Component User Property Might Aect View Modes  
Sometimes it might seem that Siebel CRM ignores the All view mode and the Manager view mode in the client. In this
situation, the All Mode Sort business component user property might control the conguration for these modes. For
more information about this user property, see  Siebel Developer's Reference . For information about virtual business
components, see  Siebel Developer's Reference  or  Overview: Siebel Enterprise Application Integration .

Field  
A eld denes a business component eld. The elds in a business component record include entries from a single
value eld or a multi value eld. Siebel CRM evaluates required elds in alphabetical order according to the parent
business component. For example, assume two required elds named Alpha and Omega exist on an applet and that
these elds reference a business component eld. Siebel CRM processes Alpha rst and then Omega.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Field

The following table describes properties that Siebel CRM uses with a eld.

Property Description

Calculated (O)
 

If TRUE, then Siebel CRM gets values from the business component to calculate the eld value rather
than geing values from the server database.
 

Calculated Value (O)
 

Species the expression Siebel CRM uses to calculate the eld value if the Calculated property is TRUE.
 

Column (R)
 

Species the table column name. Other objects that reference this eld can reference it through the
column name.
 
This property is not used or required for the following items:
 

• Calculated elds

• Multi-value elds

• Fields in a virtual business component

The column name is name is case-sensitive. It must use the same format that it uses in the Siebel
database.
 

Currency Code Field (O)
 

Species the name of the currency code eld that Siebel CRM uses with a DTYPE_CURRENCY data
type.
 
The default eld name is Currency Code.
 

Dest Field (O)
 

Species a eld in the destination business component that is dened in the Multi Value Link eld.
 
Siebel CRM uses the Dest Field property only if the Multi Valued property is TRUE
 
If the Multi Valued property is FALSE, the Siebel CRM ignores the Dest Field property.
 

Disable Search
 

You can use one of the following values:
 

• TRUE. The user cannot use this eld to search in the client.

• FALSE. The user can use this eld to search in the client.

Disable Sort
 

You can use one of the following values:
 

• TRUE. The user cannot use this eld to sort in the client.

• FALSE. The user can use this eld to sort in the client.

Exchange Date Field (O)
 

Species the name of the exchange date eld that Siebel CRM uses with a DTYPE_CURRENCY data
type. The default eld name is Exchange Date.
 

Force Active (O)
 

If TRUE, then to get the eld value, Siebel CRM queries the Siebel database each time it instantiates the
parent business component. It does this even if it does not display this eld in the client. You must set
the Force Active property to TRUE only if you must script a eld in the active business component, and
only if Siebel CRM does not display this eld in the active applet. Seing this property to TRUE might
reduce performance.
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Force Case (O)
 

Species the case for the eld value. You can use one of the following values:
 

• UPPER

• LOWER

• FIRSTUPPER

Hidden (O)
 

If TRUE, then the eld is not visible to a dynamically created list view, such as the view that the
forecasting module uses. Siebel CRM uses this property to support only specialized functionality. It
does not support general conguration.
 
The default value of the Hidden property is one of the following:
 

• TRUE for a business component that uses the DTYPE_ID data type.

• FALSE for business components that do not use the DTYPE_ID data type.

Immediate Post Changes (O)
 

For more information, see Conguring the Immediate Post Changes Property of a Field.
 

Internal Pick Applet (O)
 

Species a pick applet that Siebel Tools displays for a workow process. You can set the conditions for
the Decision Point step in a workow process to use values from business component elds. You can
use the Internal Pick Applet property to specify the applet that this user interface displays.
 

Join (O)
 

Species the name of the join object denition that this eld uses. Siebel CRM uses this join to get data
from the table that the join denes. The value in the Join property corresponds to the Name property
of this join. For more information, see Join.
 

Link Specication (O)
 

If TRUE, then Siebel CRM sends the eld value as a default value to a eld in the child business
component.
 

Message Display Mode
 

Species the data to display if a validation failure occurs. You can use one of the following values:
 

• User Msg. Display only the validation message.

• User Msg with Error Code Only. Display the validation message and a Siebel error code in the
following format:

SBL-xxx-yyy

• User Msg with Error Code/Msg. Display the validation message, Siebel error code, and the default
error message.

Multi Value Link (O)
 

Depends on the following value of the Multi Valued property of this eld:
 

• TRUE. The Multi Value Link property species the multivalue link for this eld.

• FALSE. Siebel CRM ignores the Multi Value Link property.

Multi Valued (O)
 

You can use one of the following values:
 

• TRUE. This eld is a multivalue eld.

• FALSE. This eld is a single value eld.

Name (R)
 

Species the name for this eld. Other objects reference this eld through this Name property.
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You must not modify the name of a predened eld. Doing this can create upgrade problems and
might aect intended conguration.
 
The name can include spaces. It must be unique in the business component.
 

No Copy (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM does not copy the eld value to the newly created record during a Based On
Last operation.

• FALSE. Siebel CRM copies the eld value to the newly created record during a Based On Last
operation. If you set the No Copy property to false for a eld that Siebel CRM derives from a
joined table, then you must make sure that No Copy in the join eld is also set to FALSE. The
Source Field property in the join specication identies this join eld. If you do not do this, then
Siebel CRM displays the new record. It does this to copy the elds from the joined table. If the
record is required, then it does not populate the elds. This situation occurs only in a Based On
Last operation.

Oracle Sequence Object (O)
 

Species the name of an Oracle sequence object. If Siebel CRM creates a new record, then it uses this
sequence for this eld.
 
You must manually create the Oracle sequence object in the Oracle Database. This is an exception to
the normal way that you congure an Oracle sequence object.
 
Siebel Remote does not support an Oracle sequence object.
 

PickList (O)
 

Species the name of a picklist object denition that Siebel CRM uses to display a list of valid values
that the user can choose.
 

Post Default Value (O)
 

Species the eld value that Siebel CRM inserts in this eld if it is empty the rst time Siebel CRM
writes it to the Siebel database. Note the following:
 

• Siebel CRM inserts the post default value even if it does not display this eld in the client.

• If this eld is empty during a subsequent update of this eld, then Siebel CRM does not insert this
post default value.

• Siebel CRM does not validate the value that the Post Default Value property contains for a
calculated eld.

• Siebel CRM limits the value in the Post Default Value property to 255 characters.

• To make sure the conguration in the linked eld of a child business component works correctly,
 the Link Specication property must be TRUE on the parent business component.

Pre Default Value (O)
 

Species the eld value that Siebel CRM inserts in this eld when it creates a new record through an
Add New Record or Copy Record operation. Note the following:
 

• The user can modify this value before Siebel CRM writes the record to the Siebel database.

• Siebel CRM inserts the predefault value even if it does not display this eld in the client.

• Siebel CRM does not validate the value that the Pre Default Value property contains for a
calculated eld.

• Siebel CRM limits the value in the Pre Default Value property to 255 characters.

• If a predefault value expression depends on other elds, then these elds must be populated
when Siebel CRM evaluates this expression. For example, the following predefault value works
because Siebel CRM populates the Row Id or Id eld when it initializes the record:

Expr: Field 'ID'
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The following predefault value does not work because Siebel CRM populates the Picklist Field after it
initializes the record:
 

Expr: Field: 'picklist_field_name'

This situation is true for a Copy Record operation only if the NoCopy property is TRUE.
 

Precision (O)
 

For more information, see About the Precision and Scale Properties.
 

Read Only (O)
 

If TRUE, then the user cannot modify the eld value for this eld. A eld that references a joined table
is typically read-only with the following exceptions:
 

• A join to an extension table

• A join to an active intersection table

Some elds are read-only even if the Read Only property is FALSE. The Eective Start Date eld for the
following business components is read-only:
 

• Account Product

• Promotion

• Promotion Account

• Promotion Account Product

• Promotion Administration

• Promotion Product

For more information, see Join.
 

Required (O)
 

If TRUE, then Siebel CRM writes the eld value to the Siebel database only if this eld contains a value.
 

Scale (O)
 

For more information, see About the Precision and Scale Properties.
 

Text Length (O)
 

Species the maximum length of text that the eld can contain.
 
Siebel CRM typically ignores this property. It typically gets the length from the table column that this
eld references.
 
If a Text eld includes a user property named Text Length Override, then Siebel CRM does not ignore
the Text Length property.
 

Type (R)
 

Species the eld data type. For more information, see Conguring the Type Property of a Field.
 

Validation (O)
 

Species the expression that Siebel CRM uses to validate the data that the user enters in this eld. Note
the following:
 

• You can use the Validation property only with a single value eld. You cannot use it with a
multivalue eld.

• Siebel CRM limits the value in the Validation property to 255 characters.

Validation Message (O)
 

Species to override the default validation message that the Application Object Manager provides.
For example, if a user enters 250 in a eld, and if this value must not exceed 200, then the Application
Object Manager displays the following validation message:
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Incorrect fields values: field_name <= 200.

The user might not understand this message. To improve it, you can use the Validation Message
property to congure Siebel CRM to display the following message:
 

Please enter a value under 200 for the field_name field.

For more information about validation messages, see the description for the Message Display Mode
property.
 

Conguring the Immediate Post Changes Property of a Field  
You can set the Immediate Post Changes property to one of the following values:

• TRUE. Siebel CRM immediately saves the eld value to the Siebel Server. For example, if a user modies a eld
value and then tabs to the next eld in the same record, then Siebel CRM immediately saves this new value to
the Siebel Server and then refreshes the data that it displays in the client. To do this, it makes a round trip to
the Siebel Server and calls a PreSetFieldValue browser script event. For more information about this event, see 
Siebel Object Interfaces Reference .

• FALSE. Siebel CRM does not immediately save the eld value to the Siebel Server. For example, if a user
modies a eld value and then tabs to the next eld in the same record, then Siebel CRM does not save this
new value to the Siebel Server. The default value is FALSE.

Situations Where You Must Set the Immediate Post Changes Property to True
Seing the Immediate Post Changes property to TRUE might negatively aect performance. You typically set it to TRUE
only to support the following congurations:

• Calculated eld. For example, assume eld B is a calculated eld that uses values from eld A. The Application
Object Manager on the server does the calculation for a calculated eld. If Siebel CRM modies the value in eld
A, then it must do a server round trip to calculate and display the new value for eld B. To allow this round trip,
you must set the Immediate Post Changes property for eld A to TRUE. You do not set it to TRUE for eld B
because Siebel CRM is not required to do a round trip if it modies the value in eld B.
If the user modies a value in a eld, then Siebel CRM must run the code that the following event handlers
contain on the Siebel Server:

◦ BusComp_PreSetFieldValue performs a validation

◦ BusComp_SetFieldValue causes some other action to occur after Siebel CRM validates a value

If the Immediate Post Changes property is FALSE, then Siebel CRM does not run the code on the Siebel Server
until the next time it performs a server round trip. If the PreSetFieldValue event nds a problem with the eld
value, and if the Immediate Post Changes property is FALSE, then Siebel CRM does not notify the user that a
problem exists until the next time it performs a server round trip. For more information about event handlers,
see  Siebel Object Interfaces Reference .

• Constrained drop-down list. Assume the following constraints exists:
◦ If eld A = Y, then eld B can contain Y1, Y2, Y3.

◦ If eld A = Z, then eld B can contain Z1, Z2, Z3.

In this example, Siebel CRM cannot populate the picklist for eld B until the user chooses eld A. To get the
values for eld B, it must perform a server round trip after the user chooses eld A. To allow this round trip, you
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must set the Immediate Post Changes property for eld A to TRUE. You do not set it to TRUE for eld B because
Siebel CRM is not required to do a round trip if it modies the value in eld B.

Conguring the Type Property of a Field  
The Type property of a eld corresponds to the physical type of the table column that resides in the Siebel database:

• The value in the Type property includes a DTYPE_ prex.

• You must use the data types that come predened with Siebel CRM.

• If you congure Siebel CRM to map a column to a data type, then you must make sure you congure it to use a
similar type. For example, Siebel CRM can map an integer column to the DTYPE_INTEGER data type. It cannot
map an incompatible type. For example, it cannot map a Long column to the DTYPE_BOOL data type.

The following table describes the data types that Siebel CRM supports for a eld.

Data Type Description

DTYPE_BOOL
 

This data type includes the following qualities:
 

• Stores Boolean data, such as Y or N.

• Mapped to a column that uses a Character(1) physical type and length.

• Typically displayed as TRUE or FALSE, or checked or unchecked.

DTYPE_CURRENCY
 

This data type includes the following qualities:
 

• Stores currency data.

• Mapped to a column that uses a Number physical type.

DTYPE_DATE
 

This data type includes the following qualities:
 

• Stores date data. It ignores other saved data, such as time.

• Mapped to a column that uses a Date physical type.

DTYPE_DATETIME
 

This data type includes the following qualities:
 

• Stores date and time data.

• Mapped to a column that uses a DateTime physical type.

DTYPE_ID
 

This data type includes the following qualities:
 

• Stores a key that Siebel CRM creates.

• Mapped to a column that uses a Varchar(15) physical type and length.

DTYPE_INTEGER
 

This data type includes the following qualities:
 

• Stores integer data.

• Mapped to a column that uses a Number physical type.

DTYPE_NOTE
 

This data type includes the following qualities:
 

• Stores long string data.
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Data Type Description

• Mapped to a column that uses a Long physical type.

DTYPE_NUMBER
 

This data type includes the following qualities:
 

• Stores number data.

• Mapped to a column that uses a Number physical type.

DTYPE_PHONE
 

This data type includes the following qualities:
 

• Stores phone number data.

• Mapped to a column that uses a Varchar(40) physical type and length.

DTYPE_TEXT
 

This data type includes the following qualities:
 

• Stores string data.

• Mapped to a column that uses a Varchar physical type.

• Uses upper and lower case text that the user enters.

• The ForceCase property on a eld can force text to Upper, Lower, or FirstUpper case.

DTYPE_TIME
 

This data type includes the following qualities:
 

• Stores time data.

• Mapped to a column that uses a Time physical type.

• Siebel CRM ignores other saved data, such as date.

DTYPE_UTCDATETIME
 

Species the time as Greenwich mean time (GMT). For more information, see  Siebel Global
Deployment Guide .
 

Properties of the Field Object Type That Siebel CRM Supports for a Virtual Business
Component  
The following table describes the properties of a eld that Siebel CRM supports in a virtual business component.

Properties That Siebel CRM Supports Properties That Siebel CRM Does Not Support

Siebel CRM supports the following
properties of a eld in a virtual business
component:
 

• Calculated

• Calculated Value

• Currency Code Field

• Exchange Date Field

• Force Case

• Hidden

• Internal Pick Applet

Siebel CRM does not support the following properties of a eld in a virtual business component:
 

• Column

• Dest Field

• Force Active

• Join

• Link Specication

• Multi Value Link

• Multi Valued

• No Copy
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Properties That Siebel CRM Supports Properties That Siebel CRM Does Not Support

• Link Specication

• Pick List

• Post Default Value

• Pre Default Value

• Precision

• Read Only

• Required

• Scale

• Text Length

• Type

• Oracle Sequence Object

• Validation

Field Locale  
A eld locale denes language overrides that Siebel CRM uses with a eld.

This object type occurs in the following location in the object hierarchy:

Siebel Objects > Business Component > Field > Field Locale

The following table describes properties that Siebel CRM uses with a eld locale.

Property Description

Validation Message (R)
 

Species the language text that Siebel CRM displays if validation fails. The Validation property on the
parent eld determines validation.
 
You can specify an error message. Siebel CRM displays this message in the client. It uses the language
that the Language Code property species.
 

Field User Prop  
A eld user prop sends a property value to specialized C++ code. Siebel CRM persists the value that you congure for a
user property in the Siebel runtime repository. For more information, see Object Types That You Must Not Modify.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Field > Field User Prop

The following table describes properties that Siebel CRM uses with a eld user prop.

Property Description

Name (R) Species the name of the user property.
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Property Description

   

Value (O)
 

Species the value of the user property.
 

Join  
A join denes the logical join between the table that a business component references and another table. Siebel CRM
can update an implicit joined eld. It cannot update an explicit join. For a complete explanation of restrictions on left,
self, and simple joins, see an SQL language reference manual.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Join

The following table describes properties that Siebel CRM uses with a join.

Property Description

Name (R)
 

Species the name of the join object denition. This value defaults to the table that the Table property
species. If two joins to the same table exist, then you must modify the name of one of these joins.
 

Outer Join Flag (O)
 

You can use one of the following values:
 

• TRUE. Indicates a left outer join. Siebel CRM applies an outer join to the table that the Table
property of the join denes. It receives values even if the join returns no values.

• FALSE. Indicates an inner join.

Table (R)
 

Species the name of an SQL table. This name is case sensitive. It must use the same format that the
table name uses in the Siebel database.
 

Join Constraint  
A join constraint is a constant value search specication that Siebel CRM applies to a column during a join. Outer joins
use it.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Join > Join Constraint

The following table describes properties that Siebel CRM uses with a join constraint.

Property Description

Destination Column (O)
 

Species the column of a destination table. Siebel CRM to applies the constraint to this destination
table. For example, you can use the following value:
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LANG_CD

Name (R)
 

Species the name of the join constraint.
 

Value (O)
 

Species a constant value or constant function that is not empty, such as LoginId, PositionId, or
DivisionId. For example, you can specify the following value:
 

Language()

You can specify GetProleAr. A prole aribute can be persistent or dynamic. If it is dynamic, then this
Value property must contain a value before Siebel CRM uses the join. If this property does not contain
a value, then GetProleAr returns a null value and the join fails.
 

Join Specication  
A join specication species the columns to join from the tables on the left side and the right side of a join.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Join > Join Specication

The following table describes properties that Siebel CRM uses with a join specication.

Property Description

Destination Column (O)
 

Species the name of the column in the destination table that Siebel CRM uses for the join. This name
is case-sensitive. It must use the same format that it uses in the Siebel database. If the join occurs on a
column other than the ROW_ID column, then the Destination Column property is required.
 

Name (R)
 

Species the name of the join specication object denition, which must be unique in the join. The
name defaults to the Source Field value for the join specication.
 
By default, the name of a join specication is the name of the source eld specied for the object
denition. You must not modify this value unless two join specication object denitions exist for the
same join that use the same source eld. The merge and upgrade utility uses this eld to determine
matching entries.
 
For more information about the join specication, see  Conguring Siebel Business Applications .
 

Source Field (O)
 

Species the name of a eld. Siebel CRM uses this eld to join the destination table. Note the following:
 

• This eld resides in the parent business component of the join object denition.

• The Source Field property must reference a eld that denes a database column. A computed
eld is an example of a eld that does not reference a database column. You cannot use it as the
source eld for a join specication.

• This eld must be a foreign key to the Destination Column.

• If the join occurs on a eld other than the ID eld, then the Source Field property is required.
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Multi Value Field  
A multi value eld displays the child records of a parent record. If the user clicks a multivalue eld, then Siebel CRM
displays these child records.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Multi Value Field

The following table describes properties that Siebel CRM uses with a multi value eld.

Property Description

Calculated (O)
 

If TRUE, then Siebel CRM uses business component data to calculate the eld value.
 

Field (R)
 

Species the name of a single-value eld in the child business component that the multivalue link
references. This eld must be visible in a list applet.
 
To avoid performance problems, it is recommended that you do not specify a multivalue eld from
another business component in this property. If you must specify a multivalue eld from another
business component, then get help from Oracle. For more information, see Object Types That You
Must Not Modify.
 

Force Active (O)
 

If TRUE, then Siebel CRM gets the eld value from the Siebel database.
 

Hidden (O)
 

If TRUE, then Siebel CRM does not display this multivalue eld in any list view that it dynamically
creates at runtime. The default value is one of the following:
 

• TRUE for a business component data type of DTYPE_ID

• FALSE for any business component data type that is not DTYPE_ID

Link Specication (O)
 

If TRUE, then Siebel CRM sends the eld value as a default value to a eld in the child business
component. This conguration is required to support any business component that Siebel CRM uses as
the child of a link from this business component, and if this child uses the Parent type of default values
and expects to receive a value.
 

Multi Value Link (R)
 

Species the name of the multivalue link that Siebel CRM uses when it gets data.
 

Name (R)
 

Species the name of this multivalue eld. The name must be unique in the business component. It
can contain spaces. To reference this multivalue eld, other objects use this name.
 

No Copy (O)
 

If TRUE, then Siebel CRM does not copy the value that this multivalue eld contains into the newly
created record during a Based On Last operation. Also, if one of the following objects for this
multivalue eld species No Copy as TRUE, then Siebel CRM does not copy this value:
 

• The multi value link

• The source eld

PickList (O)
 

Species the name of a picklist that Siebel CRM uses to display a list of values that the user can choose.
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Property Description

Read Only (O)
 

If TRUE, then the user cannot modify the value of this multivalue eld.
 

Required (O)
 

Not used.
 

Multi Value Link  
A multi value link gets the records that Siebel CRM displays through a multivalue eld.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Multi Value Link

The following table describes properties that Siebel CRM uses with a multi value link.

Property Description

Auto Primary (O)
 

Species how Siebel CRM populates row ID values in the primary ID eld. You can use one of the
following values:
 

• DEFAULT. Automatically set the rst record as the primary.

• NONE. Require the user to manually set the primary.

• SELECTED. Use the primary that the user chooses in a multivalue list to set the primary for other
lists. For example, if the user chooses a primary Shipping Address, then Siebel CRM also sets this
address as the primary Billing Address. Siebel CRM does the following:

◦ Sets these primary values only if the primary is not set.

◦ Does not set a value if a primary already includes a value.

◦ Uses SELECTED only if more than one multivalue link references the same detail business
component.

Check No Match (O)
 

Species how to set the primary if the foreign key eld in the parent business component contains a
value of No Match. You can use one of the following values:
 

• TRUE. It runs a separate query. If the Auto Primary property of this multivalue link is:

◦ Default. It sets the rst record as the primary.

◦ SELECTED. It determines if another multivalue link to this business component indicates a
primary record. If it does, then Siebel CRM sets this record as the primary of this multivalue link.

• FALSE. It does not run a separate query.

For more information, see the topic about using the Check No Match property with a primary join
in  Conguring Siebel Business Applications . See the topic about how the Check No Match property
impacts performance in  Siebel Performance Tuning Guide .
 

Destination Business Component (R)
 

Species the name of the child business component.
 

Destination Link (R) Species the name of the link that Siebel CRM uses.
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Property Description

   

Name (R)
 

Species the name for this multivalue link. Note the following:
 

• Other objects use this name to reference this multivalue link.

• The name must be unique among the multivalue links for this business component.

• The name can contain spaces.

• The name cannot contain numbers or special characters.

No Associate (O)
 

If TRUE, then Siebel CRM does not create associations through this multivalue link. It can add new
detail records.
 
If the current view is in Admin Mode, then Siebel CRM ignores the No Associate property.
 

No Copy (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM does not copy child records through this multivalue link.

• FALSE. Siebel CRM does the following:

◦ Copies child records through this multivalue link.

◦ Only copies records that are directly related to this multivalue group. The copy operation on the
child business component might fail due to a unique index violation.

◦ If the No Copy property of a multivalue link on a child business component is FALSE, then Siebel
CRM ignores it and does not use the Deep Copy feature to copy grandchild records.

No Delete (O)
 

If TRUE, then the user cannot delete records associated with this multivalue link.
 

No Insert (O)
 

If TRUE, then the user cannot insert records associated with this multivalue link.
 

No Update (O)
 

If TRUE, then the user cannot update records associated with this multivalue link.
 

Popup Update Only (O)
 

If TRUE, then Siebel CRM displays the multivalue group window for any of the multivalue group values
that it must update.
 

Primary Id Field (O)
 

Species the name of the eld in the master business component that contains the row ID values that
reference the primary records in the detail business component.
 

Source Field (O)
 

Species the name of a source eld that Siebel CRM uses to link the child business component with the
source business component. The source business component is the business component that includes
the object denition for the multivalue link.
 
If the source eld is dierent from the Id, then the Source Field property is required.
 

Type Field (O)
 

Species the name of a eld in the DestBusComp business component that Siebel CRM uses as a lter
to get a subset of records. It uses this property with the Type Value property.
 

Type Value (O)
 

Species the data value that Siebel CRM uses to lter a subset of records.
 

Use Primary Join (O) You can use one of the following values:
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Property Description

   
• TRUE. Run a primary join that uses the value in the Primary Id Field property to get the data for

the primary child. To get the value for a nonprimary multivalue eld, the user must type EXISTS in
the query.

• FALSE. Run the second query that gets all child records. Siebel CRM automatically creates the
EXISTS query.

If the Cache Data property of the business component is TRUE, then you must not set the Use Primary
Join property to TRUE. For more information, see the description for the Cache Data property in the
Business Component topic.
 

MVF Pick Map  
An MVF pick map species instructions for copying elds when a drop-down list is used by a eld in a business
component.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Multi Value Field > MVF Pick Map

The following table describes properties that Siebel CRM uses with an MVF pick map.

Property Description

Constrain (O)
 

You can use one of the following values:
 

• TRUE. Denes the MVF pick map as a constraint pick map.

• FALSE. Denes the MVF pick map as a copy pick map.

For more information, see About Copy and Constraint Pick Maps.
 

Field (R)
 

Species the eld in the parent business component that Siebel CRM uses with this MVF pick map. To
constrain a picklist on a multivalue eld:
 

• You cannot use a eld in the parent business component.

• You can only use a multivalue eld that resides in the detail business component.

No Clear (O)
 

You can use one of the following values:
 

• TRUE. If the user does not pick a value from the drop-down list, then do not set the eld that the
Field property species to NULL.

• FALSE. Delete any value that exists in the eld that the Field property species. If the drop-down
list is not bound, then Siebel CRM does not delete these eld values.

Pick List Field (O)
 

Species the eld in the picklist business component Siebel CRM uses with this MVF pick map.
 

107



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

MVF Pick Map UpdOnlyIfNull  
An MVF pick map UpdOnlyIfNull marks a copy pick map to perform the copy operation only if the eld that the
pick map species is not empty. A constrain pick map also copies a pick map. If the constraint is active, then this
conguration results in no operation. If an MVF pick map UpdOnlyIfNull causes Siebel CRM to ignore the constraint,
then the copy operation works. To avoid the copy operation, you can use a calculated eld as the eld for the constrain
pick map.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Multi Value Field > MVF Pick Map > MVF Pick Map UpdOnlyIfNull

The following table describes properties that Siebel CRM uses with an MVF pick map UpdOnlyIfNull.

Property Description

Field (R)
 

Species the eld in the parent business component that Siebel CRM examines for a NULL value
before it does the copy operation that the parent pick map species.
 

Pick Map  
A pick map species how to copy elds if a eld uses a picklist. You cannot use a eld in the parent business component
to constrain a picklist on a multivalue eld. You can only use a multivalue eld that the detail business component
includes.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Field > Pick Map

The following table describes properties that Siebel CRM uses with a pick map.

Property Description

Constrain (O)
 

You can use one of the following values:
 

• TRUE. Dene the pick map as a constraint pick map.

• FALSE. Dene the pick map as a copy pick map.

For more information, see About Copy and Constraint Pick Maps.
 

Field (R)
 

Species a eld in the parent business component that this pick map references.
 

No Clear (O)
 

Species how to set the Field property if the user does not choose a value from the picklist. You can
use one of the following values:
 

• FALSE. The Field property is NULL.

• TRUE. The Field property is not set to NULL.
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Property Description

Pick List Field (O)
 

Species the eld in the picklist business component that this pick map references.
 

Sequence (O)
 

Species the order that Siebel CRM uses to copy the eld values back to the business component after
the user picks a row. This property can contain only an integer.
 
If Siebel CRM can get the Pick List Source Id, then it ignores the Sequence property.
 

About Copy and Constraint Pick Maps  
Siebel CRM can use the following types of pick maps:

• Constraint pick map. Siebel CRM applies the value from a eld in the parent business component as a search
specication on a eld in the picklist business component.

• Copy pick map. Siebel CRM copies the value of a eld in the picklist business component to a eld in the parent
business component.

The Pick List Field property species the eld in the picklist business component. The Field property species the eld
in the parent business component.

Pick Map UpdOnlyIfNull  
A pick map UpdOnlyIfNull congures a copy pick map to do a copy operation only if the values of the elds that the pick
map UpdOnlyIfNull species are empty. For more information, see Pick Map.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Field > Pick Map > Pick Map UpdOnlyIfNull

The following table describes properties that Siebel CRM uses with a pick map UpdOnlyIfNull.

Property Description

Field (R)
 

Species the eld in the parent business component that Siebel CRM examines for the empty
condition before it does the copy operation that the parent pick map species.
 
Each pick map object denition includes a child object denition of type Pick Map UpdOnlyIfNull. If
you add one of these child object denitions to the pick map that constrains the picklist, and if the
constraining value is NULL, then Siebel CRM ignores the constraint. If a picklist eld that is not empty
exists, then this eld returns records and Siebel CRM displays these records.
 
If the value of the constraining eld is empty, and if the values of the elds that the Pick Map
UpdOnlyIfNull constraint pick map species are empty, then this Pick Map UpdOnlyIfNull works
like a copy pickmap. To disable the constraint if the constraining eld value is empty, you can use a
calculated eld as the eld for the constraint pickmap.
 
Siebel CRM disables the constraint only if the following situations are true:
 

• The eld that the parent constraint pick map references is empty.

• The eld that this Pick Map UpdOnlyIfNull references is empty.
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Single Value Field  
A single value eld denes properties for a single value eld.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Single Value Field

The following table describes properties that Siebel CRM uses with a single value eld.

Property Description

Calculated (O)
 

If TRUE, then Siebel CRM calculates the value for this eld.
 

Calculated Value (O)
 

Species an expression that Siebel CRM uses to calculate value for this eld.
 

Column (R)
 

Species the name of a database table column. This name is case-sensitive. It must use the same
format that it uses in the Siebel database.
 
The Column property is not allowed for a calculated eld. It is required for a eld that Siebel CRM does
not calculate.
 

Currency Code Field (O)
 

Species the name of the currency code eld that Siebel CRM uses with a DTYPE_CURRENCY data
type. The default value is Currency Code.
 

Exchange Date Field (O)
 

Species the name of the exchange date eld that Siebel CRM uses with a DTYPE_CURRENCY data
type. The default value is Exchange Date.
 

Force Active (O)
 

If TRUE, then Siebel CRM gets the data value from the Siebel database. For best performance, it is
recommended that you set the Force Active to FALSE in most situations.
 
This property does not aect how browser script references or uses the value that this eld contains.
 

Force Case (O)
 

Species the case for the eld value. You can use one of the following values:
 

• UPPER

• LOWER

• FIRSTUPPER

Hidden (O)
 

If TRUE, then Siebel CRM does not display this eld in any list view that it creates dynamically at
runtime. If business component data is:
 

• Of type DTYPE_ID, then the default value is TRUE.

• Not of type DTYPE_ID, then the default value is FALSE.

Join (O)
 

Species the name of the join that this eld uses. Siebel CRM uses this name only if the eld value it
gets is from the table that the join denes. For more information, see Join.
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Property Description

Link Specication (O)
 

If TRUE, then Siebel CRM sends the eld value as a default value to a eld in a child business
component. If a business component is a child of this link, and if this business component uses the
Parent type of default value, and if it expects to get a value, then a link specication is required.
 
For performance reasons, it is recommended that you set the Link Specication property TRUE only
if Siebel CRM must predefault the parent value to the child value through the link. This conguration
requires Siebel CRM to get the column value any time that this object is active. It is similar to the
conguration that Siebel CRM uses for the ForceActive property.
 
This property does not aect how browser script references or uses the value that this eld contains.
 

Message Display Mode
 

Species the details that Siebel CRM displays in the validation message. You can use one of the
following values:
 

• User Msg. Display only the message that you dene in Siebel Tools.

• User Msg with Error Code Only. Display the message and the error code that the Application
Object Manager returns.

• User Msg with Error Code/Msg. Display the message that you dene in Siebel Tools Display. Also
display the message and the error code that the Application Object Manager returns.

Name (R)
 

Species a name for this eld. This name must be unique in the business component. It can contain
spaces. Other objects use this name to reference this eld.
 

No Copy (O)
 

If TRUE, then Siebel CRM does not copy the eld value to the new record during a Based On Last
operation.
 

Oracle Sequence Object (O)
 

Species the name of an Oracle sequence object. It determines the sequence that Siebel CRM uses for
eld defaults when it creates a new record.
 

PickList (O)
 

Species the name of a picklist that Siebel CRM uses to display a list of valid values that the user can
choose.
 

Post Default Value (O)
 

Species a value that Siebel CRM uses for this eld if the user does not enter a value and saves the
record. Siebel CRM does not validate this value for a calculated eld.
 
The Post Default Value property can contain no more than 255 characters.
 

Pre Default Value (O)
 

Species the value that Siebel CRM uses for an empty eld if an Add New Record or Copy Record
operation creates a new record. The user might modify this value before Siebel CRM writes it to the
Siebel database. Siebel CRM does not validate this value for a calculated eld.
 
The Post Default Value property can contain no more than 255 characters.
 

Precision (O)
 

For more information, see About the Precision and Scale Properties.
 

Read Only (O)
 

If TRUE, then the user cannot modify the eld value. Some elds are read-only even if the Read Only
property is FALSE. For example, the Eective Start Date eld for the following business components is
read-only:
 

• Account Product

• Promotion
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Property Description

• Promotion Account

• Promotion Account Product

• Promotion Administration

• Promotion Product

In general, a eld that references a joined table is read-only. There are two exceptions to this rule:
 

• The join references an extension table.

• The join references an active intersection table.

For more information, see Join.
 

Required (O)
 

If TRUE, then the user must enter a value in this eld before Siebel CRM can write the record to the
Siebel database.
 
For information about how you can use a user property to control required according to an expression,
 see  Siebel Developer's Reference .
 

Scale (O)
 

For more information, see About the Precision and Scale Properties.
 

Text Length (O)
 

Species the maximum length of text that the user can enter in this eld. Siebel CRM typically ignores
this property. It gets the length from the underlying column denition.
 

Type (R)
 

Species the data type for this eld. You must make sure that the type you choose uses the same data
type that the column uses. The Column property of this eld species this column.
 

Validation (O)
 

Species the expression Siebel CRM uses to make sure the data that the user enters is correct. You can
use validation only with a single value eld. You cannot use it with a multivalue eld. The Validation
property can contain no more than 255 characters.
 

SVF Pick Map  
An SVF pick map species how to copy elds if another eld uses a picklist.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Single Value Field > SVF Pick Map

The following table describes properties that Siebel CRM uses with an SVF pick map.

Property Description

Constrain (O)
 

You can use one of the following values:
 
TRUE. Denes this SVF pick map as a constraint pick map.
 
FALSE. Denes this SVF pick map as a copy pick map.
 
For more information, see About Copy and Constraint Pick Maps.
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Property Description

 

Field (R)
 

Species the eld in the parent business component that this SVF pick map uses.
 

No Clear (O)
 

Species how to set the Field property if the user does not choose a value from the picklist. You can
use one of the following values:
 
FALSE. Set the Field property to NULL.
 
TRUE. Do not set the Field property to NULL.
 

Pick List Field (O)
 

Species the eld in the picklist business component that this SVF pick map uses.
 

SVF Pick Map UpdOnlyIfNull  
An SVF pick map UpdOnlyIfNull marks a copy pick map to perform the copy operation only if the eld that the pick map
species is not empty. A constrain pick map also copies a pick map. If the constraint is active, then this conguration
results in no operation. If the UpdOnlyIfNull causes Siebel CRM to ignore the constraint, then the copy operation works.
To avoid the copy operation, you can use a calculated eld as the eld for the constrain pick map.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Component > Single Value Field > SVF Pick Map > SVF Pick Map UpdOnlyIfNull

The following table describes properties that Siebel CRM uses with an SVF pick map UpdOnlyIfNull.

Property Description

Field (R)
 

Species the eld in the parent business component that Siebel CRM examines to determine if the eld
is empty before it performs the copy operation that the parent pick map species.
 

Business Object Object Types  
This topic describes the Business Object object type and the object types that are children of this object type. It includes
the following topics:

• Business Object

• Business Object Component
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Business Object  
A business object organizes one or more business components according to functional requirements. For example, the
Opportunity business object can reference the following business components:

• Opportunity

• Contact

• Product

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Object

The following table describes properties that Siebel CRM uses with a business object.

Property Description

Name (R)
 

Species the name of the business object. This name must be unique among business objects. It can
include spaces but it cannot include special characters.
 
To reference a business object, other objects reference this name.
 

Primary Business Component (O)
 

Species the parent business component of the business object.
 

Query List Business Component (O)
 

Species the name of the business component that Siebel CRM uses to save predened queries for the
business object.
 

Business Object Component  
A business object component identies a business component.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Object > Business Object Component

The following table describes properties that Siebel CRM uses with a business object component.

Property Description

BusComp (R)
 

Species the name of a business component. For example:
 

Contact

Link (O)
 

Species the name of a link that Siebel CRM uses between two business components. If this property
does not include a value, then Siebel CRM does not create a link. For example:
 

Account/Contact

For more information, see Link.
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Property Description

Name (S)
 

Species the name of the business object component. For example:
 

Contact

Business Service Object Types  
This topic describes the Business Service object type and the object types that are children of this object type. It
includes the following topics:

• Business Service

• Business Service Browser Script

• Business Service Locale

• Business Service Method

• Business Service Method Arg

• Business Service Method Arg Locale

• Business Service Method Arg User Prop

• Business Service Method Locale

• Business Service Server Script

• Business Service Subsystem

• WF Process Metric

Business Service  
A business service denes reusable business logic. You can congure the following types of business services:

• Built-in business service that you dene in Siebel Tools. It can reference the predened CSSService class or a
specialized class. A specialized business service is for Oracle use only.

• Run-time business service that you dene in the client.

You can use a business service as a reusable code library that Siebel CRM can call from another script.

To congure a business service, you can use properties and Siebel VB script or Siebel eScript script.

Starting with Siebel CRM version 8.0, if a business service uses the Web Client Automation Server or Browser Script,
then you must use Siebel Tools to register this business service as an application user property. This conguration
prevents a Service Not Found error. For more information about registering a business service, see  Siebel Object
Interfaces Reference .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service

The following table describes properties that Siebel CRM uses with a business service.
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Property Description

Browser Class (O)(H)
 

Not used.
 

Cache (O)
 

You can use one of the following values:
 

• TRUE. The business service instance exists until the user session nishes.

• FALSE. Siebel CRM deletes the business service instance after it nishes running.

Class (R)
 

Species the class. If you create a business service, then you must set the Class property to
CSSService. For example:
 

CSSService

Display Name (R)
 

Species the name that Siebel CRM displays in the picklist.
 

External Use (O)
 

Species that Siebel CRM can use the business service in a script and test it in a simulator. If you create
a business service, then you must set the External Use property to TRUE.
 

Hidden (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM hides the object.

• FALSE. Siebel CRM does not hide the object.

Name (R)
 

Species the name of the business service.
 

Server Enabled (S)
 

You can use one of the following values:
 

• TRUE. Siebel CRM enables the business service on the Siebel Server. In most situations, you must
set the Server Enabled property to TRUE.

• FALSE. Siebel CRM does not enable the business service on the Siebel Server.

State Management Type (R)
 

Species the state management type for a workow process. For more information, see the description
about the State Management Type property in Workow Process.
 

Web Service Enabled (O)
 

You can use one of the following values:
 

• TRUE. Expose the business service as a Web service.

• FALSE. Do not expose the business service as a Web service.

For more information, see  Siebel CRM Web Services Reference .
 

Business Service Browser Script  
A business service browser script species the browser script that the business service uses. For more information, see 
Siebel Object Interfaces Reference .
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service Browser Script

The following table describes properties that Siebel CRM uses with a business service browser script.

Property Description

Browser Group (O)
 

Not used.
 

Name (S)
 

Species a unique name for the script. To create a value for this property, Siebel Tools combines the
values that the Browser Group property and the Procedure property contains. You must not modify this
property.
 

Procedure (O)
 

Species the name of the function or the procedure.
 

Script (R)
 

Species the text for the function.
 

Business Service Locale  
A business service locale denes language overrides that Siebel CRM uses with a business service.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service Locale

The following table describes properties that Siebel CRM uses with a business service locale.

Property Description

Display Name (R)
 

Species the name that Siebel CRM displays in the picklist for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Business Service Method  
A business service method denes functionality for a business service.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service Method

The following table describes properties that Siebel CRM uses with a business service method.
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Property Description

Display Name (O)
 

Species the name that Siebel CRM displays in various picklists.
 

Hidden (O)
 

You can use one of the following values:
 

• TRUE. Do not display the business service method in picklists in the Workow Process Designer.

• FALSE. Display the business service method in picklists in the Workow Process Designer.

Name (R)
 

Species the name of the business service method.
 

Business Service Method Arg  
A business service method arg denes the arguments for a business service method.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service Method > Business Service Method Arg

The following table describes properties that Siebel CRM uses with a business service method arg.

Property Description

Data Type (R)
 

Species the data type of the business service method arg. To view the values you can use, click the
Data Type property in Siebel Tools.
 

Display Name (O)
 

Species the name that Siebel CRM displays in the client.
 

Hidden (O)
 

You can use one of the following values:
 

• TRUE. Hide the business service method argument.

• FALSE. Display the business method argument.

Integration Object (O)
 

Species the name of the integration object that Siebel CRM uses for the business service method
argument.
 
To view the values you can use, click the Integration Object property in Siebel Tools.
 
Siebel CRM uses this property only if the Data Type property is Integration Object.
 

Name (R)
 

Species the name of the business service method argument.
 

Optional (O)
 

You can use one of the following values:
 

• TRUE. The business service method argument is optional.

• FALSE. The business service method argument is required.

Pick Applet (O) Species the name of the pick applet that this business service method argument reference.
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Property Description

   

Pick Field (O)
 

Species the name of the pick eld that this business service method argument references.
 

Picklist (O)
 

Species the name of the picklist that this business service method argument references.
 

Preferred Sequence (O)
 

Species the order that Siebel CRM uses to call the business service method arguments that a business
service contains.
 
This property can contain only an integer.
 

Storage Type (R)
 

Species the storage type. To view the values you can use, click the Storage Type property in Siebel
Tools.
 

Type (R)
 

Species the type of business service method argument. You can use one of the following values:
 
Input. The argument is part of the Input property set for the InvokeMethod call.
 
Input / Output. The argument is part of the Input property set and the Output property set.
 
Output. The argument is part of the Output property set.
 

Business Service Method Arg Locale  
A business service method arg locale denes language overrides that Siebel CRM uses with a business service method
arg.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service Method > Business Service Method Arg > Business Service
Method Arg Locale

The following table describes properties that Siebel CRM uses with a business service method arg locale.

Property Description

Display Name (O)
 

Species the name that Siebel CRM displays in the client for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU
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Business Service Method Arg User Prop  
A business service method arg user prop sends a property value to C++ code. Siebel CRM typically uses these user
properties to import WSDL documents and to modify the metadata it uses to create a SOAP document at run-time.
Siebel CRM persists the value that you congure for a user property in the Siebel runtime repository.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service Method > Business Service Method Arg > Business Service
Method Arg User Prop

The following table describes properties that Siebel CRM uses with a business service method arg user prop.

Property Description

Name (R)
 

Species the name of the user property.
 

Value (R)
 

Species the value of the user property.
 

Business Service Method Locale  
A business service method locale denes language overrides that Siebel CRM uses with a business service method.
These values persist in the repository and in the Siebel runtime repository.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service Method > Business Service Method Locale

A business service method locale uses the same properties that a business service method arg locale uses. For more
information, see Business Service Method Arg Locale.

Business Service Server Script  
A business service server script includes the Siebel VB script or Siebel eScript script that a business service contains.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service Server Script

A business service server script uses the same properties that an applet script uses. For more information, see Applet
Script (H).

For more information, see  Siebel Object Interfaces Reference .
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Business Service Subsystem  
A business service subsystem denes the subsystem that a business service references.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service Subsystem

The following table describes properties that Siebel CRM uses with a business service subsystem.

Property Description

Name (R)
 

Species the name of the internal Oracle business service subsystem.
 

Subsystem (R)
 

Species the name of an external business service subsystem.
 

Business Service User Prop  
A business service user prop sets the initial values for the properties of a business service. It communicates a property
value to the C++ code or script that implements the business service conguration. Siebel CRM can modify these values
during conguration or at run time. The GetProperty and SetProperty functions provide run-time access.

For more information, see Object Types That You Must Not Modify. For more information about properties that Siebel
CRM supports, see  Siebel Developer's Reference .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Business Service > Business Service User Prop

The following table describes properties that Siebel CRM uses with a business service user prop.

Property Description

Name (R)
 

Species the name of the business service user prop.
 

Value (R)
 

Species the value of the business service user property.
 

Class Object Types  
This topic describes the Class object type and the object types that are children of this object type. It includes the
following topics:

• Class
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• Class Method

• Class Method Menu Item

• Class Method Menu Item Locale

• Class User Prop

• Class User Prop Value

Class  
A class identies the class for some object types, such as applet or business component. It includes a list of classes that
the repository contains.

CAUTION:  You can modify a class only if you are adding a new ActiveX control or Java Applet to the Siebel
Web Client. Any modication you make to any other object can adversely aect performance and operation.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Class

The following table describes properties that Siebel CRM uses with a class.

Property Description

DLL (S)
 

Species the DLL that includes the class.
 

Handheld Client (S)
 

You can use one of the following values:
 

• TRUE. Siebel CRM can use the class in the mobile client.

• FALSE. Siebel CRM cannot use the class in the mobile client.

High Interactivity Enabled (S)
 

The property has been deprecated and is ignored.
 

Java Thin Client (S)(H)
 

You can use one of the following values:
 

• TRUE. Siebel CRM can use this class for the Java thin client.

• FALSE. Siebel CRM cannot use this class for the Java thin client.

Name (S)
 

Species the name of the C++ class.
 

Object Type (S)
 

Species the name of the object type that this class references.
 

Super Class (S)
 

Species the name of the parent class.
 

Thin Client (S)(H)
 

You can use one of the following values:
 

• TRUE. Siebel CRM can use this class with the Siebel Web Client.

• FALSE. Siebel CRM cannot use this class with the Siebel Web Client.

UNIX Support (S)(H) Species to support this class on the UNIX operating system.
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Property Description

   

Class Method  
A class method describes the method that the class calls.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Class > Class Method

The following table describes properties that Siebel CRM uses with a class method.

Property Description

Method (S)
 

Species the method that the class calls.
 

Name (S)
 

Species the name of the method.
 

Class Method Menu Item  
A class method menu item controls a menu item on an applet-level menu of a Siebel Web Engine applet of an applet
class and the subclasses of this applet class.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Class > Class Method Menu Item

The following table describes properties that Siebel CRM uses with a class method menu item.

Property Description

Command (S)
 

Species the name of the command that provides the method and target for the menu item.
 

Menu Text (S)
 

Species the text that Siebel CRM displays in the menu item.
 

Name (S) Species the name of the class method menu item.
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Property Description

   

Position (S)
 

Species the sequence of the menu item in the single-level list of menu items. This property can
contain only an integer.
 

Suppress Menu Item (S)
 

You can use one of the following values:
 

• TRUE. Removes the applet-level menu items from the applet-level menu in all applets that Siebel
CRM gets from this class and the subclasses of this class.

• FALSE. Does not remove these menu items.

Class Method Menu Item Locale  
A class method menu item locale denes language overrides that Siebel CRM uses with a class method menu item.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Class > Class Method Menu Item > Class Method Menu Item Locale

The following table describes properties that Siebel CRM uses with a class method menu item locale.

Property Description

Menu Text (S)
 

Species the text that Siebel CRM displays in the menu item.
 

Name (S)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Class User Prop  
A class user prop species a user property that Siebel CRM can use on Siebel repository objects that use the parent
class.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Class > Class User Prop

The following table describes properties that Siebel CRM uses with a class user prop. For information about user
properties, see  Siebel Developer's Reference .

Property Description

Description (O)
 

Species a description for this user property. Siebel CRM displays this description in the picklist where
it calls the user property so the user can quickly understand the usage and implications of the user
property.
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Property Description

 
For example, to force a view to sort according to the ORDER BY clause on the predened user key,
 Siebel CRM overrides the sort specication on this view for some visibility types. To override the sort
specication and use a sort that Siebel CRM applies to the business component for the aected views,
 you can use the All Mode Sort user property.
 

Name (R)
 

Species the name of the user property. This is the name that the C++ code of the class uses if it gets
the value of the user property. It is also the name that Siebel Tools displays in the user property picklist
for some objects. For example, a business component user property.
 
For example, you can enter the following value:
 

All Mode Sort

Type (R)
 

Species the object type that Siebel CRM uses with this class user property. You can enter one of the
following values:
 

• Business Component

• Business Service

• Applet

Value Type (O)
 

Species the type of value that Siebel enters in this user property. If the user property contains plain
text, then you can leave this property empty. You can use one of the following values:
 

• Field

• Link

• Business Service

Class User Prop Value  
A class user prop value denes a value that Siebel CRM displays in the picklist for the parent class user prop.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Class > Class User Prop > Class User Prop Value

The following table describes properties that Siebel CRM uses with a class user prop value. For information about user
properties, see  Siebel Developer's Reference .

Property Description

Description (O)
 

Includes text that describes the object denition for this class user property. Siebel CRM displays this
description in the picklist where the user uses the user property value. It allows this user to quickly
understand the usage and implications of this value as compared to other values in the picklist.
 
For example, if the All Mode Sort user property value is Normal, then Siebel CRM uses a sort
specication that is dened on a business component. This conguration also allows the user to run a
predened query that incorporates a sort.
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Property Description

Name (R)
 

Species the name of the user property value. This is the name that Siebel Tools displays in the picklist
for a user property value for an object type. For example, a business component user property.
 
For example, you can use one of the following values:
 

• TRUE

• FALSE

• Normal

Command Object Types  
This topic describes the Command object type and the object types that are children of this object type. It includes the
following topics:

• Accelerator

• Accelerator Locale

• Command

• Command Locale

Accelerator  
An accelerator denes an accelerator key sequence for each browser for a menu item that uses this command. For more
information, see Formats You Can Use With an Accelerator Object Type.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Command > Accelerator

The following table describes properties that Siebel CRM uses with an accelerator.

Property Description

Browser Platform (O)
 

User Agent. A user agent is typically a browser version, such as Internet Explorer 9.0.
 
You can use one of the following values:
 

• All. Applies to all versions of a browser version.

• Basic. Denes the capabilities of a major version of a browser.

• Extended. Denes the extended capabilities of minor versions of the same browser.

Display Name (O)
 

Species the name of the shortcut that Siebel CRM displays on a menu. For example:
 

CTRL+N

Key Sequence (O)
 

The series of keyboard strokes in a shortcut.
 
For values you can use, see Accelerator Locale.
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Property Description

 

Key Sequence - Language Override (O)
 

The language code that Siebel CRM uses for the current key sequence. An Accelerator Locale object
can override this value.
 

Name (R)
 

Species the name of the accelerator. For example:
 

New record

Accelerator Locale  
An accelerator locale denes a language override that Siebel CRM uses with an accelerator. For more information, see
Formats You Can Use With an Accelerator Object Type.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Command > Accelerator > Accelerator Locale

The following table describes properties that Siebel CRM uses with an accelerator locale.

Property Description

Display Name (O)
 

The series of keyboard strokes in a shortcut for a language and how Siebel CRM displays it on a menu.
For example:
 

CTRL+N

Key Sequence (O)
 

The series of keyboard strokes in a shortcut for a language.
 

Name (O)
 

The abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Command  
A command species the method that Siebel CRM calls if a toolbar icon associated with this command runs. It also
denes the bitmap that it displays on the toolbar icon. A toolbar item or menu item references a command.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Command

The following table describes properties that Siebel CRM uses with a command.
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Property Description

Bitmap (R)(H)
 

Not used.
 

Business Service (O)
 

Species a browser service or server service, depending on the property that handles the method.
 

Category (R)
 

Species the category name for a customize dialog box.
 

Category Display Name (O)
 

Not used.
 

Display Name (O)
 

Species the name of the command. If you do not specify a name for a menu, then Siebel CRM uses
the value that the Display Name property contains.
 

Dynamic Tooltip (O)
 

Species to make a tooltip dynamic or static. It can include one of the following values:
 

• TRUE. To get the dynamic tooltip text, Siebel CRM calls an underlying object, such as an
application, applet, or service.

• FALSE. Use a static value.

Reserved for future use.
 

Force Enable (O)
 

Species to associate the menu item or toolbar item with this command object.
 
Reserved for future use.
 

HTML Bitmap (O)
 

Species the name of the bitmap that Siebel CRM displays if the control is in the enabled state.
 

HTML Disabled Bitmap (O)
 

Species the name of the bitmap that Siebel CRM displays if the control is in a disabled state.
 

HTML Popup Dimension (O)
 

Species the dimensions of the pop-up window, in pixels. For example:
 

640x480

The format requires a lower case x and no empty spaces.
 

Method (R)
 

Species the name of the method that Siebel CRM calls if the user chooses a menu item or toolbar
icon. This method can be predened or a custom method that you dene.
 

Method Argument (O)
 

Species the method argument that Siebel CRM sends to the method that the Method property
contains. For example, assume a command item opens a new window and then navigates to a URL in
that window. To implement this requirement, a command can specify the following:
 

• The GotoURL method in the Method property.

• The URL to navigate to in the Method Argument property.

Name (R)
 

Species the name of the command object denition. This is the name of the toolbar icon that Siebel
CRM displays in the Commands list on the Commands tab of the Customize dialog box in Siebel CRM.
 

Show Popup (O)
 

You can use one of the following values:
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Property Description

• TRUE. Open a new browser window before calling the method.

• FALSE. Call the method in the current browser window.

Status Text (O)
 

Not used.
 

Target (O)
 

Species the name of the target. To view the values you can use, click the Target property in Siebel
Tools. Note the following values:
 

• Active Applet. The command is visible in all clients.

• Service. The command displays only in a client that implements this service. This service must
handle the CanInvokeMethod and InvokeMethod methods.

• Application. Do not use. This value is for Oracle use only.

Tooltip Text (O)
 

Obsolete. Do not use.
 

Command Locale  
A command locale denes language overrides that Siebel CRM uses with a command.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Command > Command Locale

The following table describes properties that Siebel CRM uses with a command locale.

Property Description

Category Display Name (O)
 

Not used.
 

Display Name (O)
 

Species the name of the command in the client.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Status Text (O)
 

Not used.
 

Tooltip Text (O)
 

Obsolete. Do not use.
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Content Object Types  
This topic describes the Content object type and the object types that are children of this object type. It includes the
following topics:

• Content Object

• Content Object View

Content Object  
A content object species a class of content for the Content Center. It denes the elds and aachments of the content
that Siebel CRM transfers from a staging environment to a production environment for use with the Content Center.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Content Object

The following table describes properties that Siebel CRM uses with a content object.

Property Description

Business Object (O)
 

Species the business object. You can specify any business object that references a primary business
component.
 

Integration Object (O)
 

Species the integration object. You can specify any EAI object that Siebel CRM creates from the
business object that the Business Object property species.
 

Name (R)
 

Species the name of the content object.
 

Pick Applet (O)
 

Species the name of the pick applet that Siebel CRM uses to choose the content data for a content
item. The Business Component property of this applet must reference the primary business
component of the business object.
 

Pick List (O)
 

Species the name of the picklist for the pick applet. The Business Component property of this picklist
must reference the primary business component of the business object.
 

Sequence (O)
 

Species the order that Siebel CRM uses to publish content items. It uses this sequence only if it
publishes a content project that includes content items from dierent content objects.
 
Siebel CRM publishes the content items from the content object that possesses the lowest sequence
number rst. It then publishes the content object that possesses the next lowest sequence number,
 and then proceeds in this order until it publishes all content items from all content objects.
 
This property can contain only an integer.
 

Source Field (O)
 

Species the eld from the picklist that Siebel CRM uses to pick and ll in the content item reference ID.
This property must only contain the following value:
 

Id
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Content Object View  
A content object view species the view that Siebel CRM uses to work with a class of content in the Content Center.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Content Object > Content Object View

The following table describes properties that Siebel CRM uses with a content object view.

Property Description

Name (R)
 

Species the name of the content object view. It is recommended that the name of the content object
view be the same as the view name.
 

Sequence (O)
 

Species the order that Siebel CRM uses to look up the content object views that the content object
includes. A content object can include multiple content object views.
 
Siebel CRM looks up the view that includes the lowest sequence value rst. It ignores any view for
which the user does not possess visibility.
 
This property can contain only an integer.
 

View Name (O)
 

Species the name of the view that the content contributor or approver drills down to from a content
item. This user uses this destination view to edit or add content data.
 
You can specify any view. Typically, the top applet in this view references the primary business
component of the business object that the content object references.
 

DLL Object Type  
This topic describes the DLL object type.

DLL  
A DLL object contains the Siebel Tools program library les.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > DLL

The following table describes properties that Siebel CRM uses with a DLL object.
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Property Description

Aributes (O)
 

Species any aributes that are associated with the applet tag.
 

Code or Class Id (O)
 

Species the complete classname of the Java applet including the package name.
 

File Name (R)
 

Species the name of the DLL le.
 

Java Package (O)
 

Species the Java packages that this DLL requires.
 

Name (R)
 

Species the name of the DLL object without a DLL lename extension.
 

Dock Object Object Types  
This topic describes the Dock Object object type and the objects that are children of this object type. It includes the
following topics:

• Dock Object

• Dock Object Related DObj

• Dock Object Table

• Dock Object Visibility Rule

Dock Object  
A dock object denes rules or groups of rules that Siebel CRM uses to synchronize records to remote users. For more
information, see  Siebel Developer's Reference .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Dock Object

The following table describes properties that Siebel CRM uses with a dock object.

Property Description

Active (S)
 

If TRUE, then the dock object is active in Siebel CRM.
 

Dock Code (S)
 

Species the code that Siebel CRM uses for this dock object.
 

Name (S)
 

Species the abbreviated name of the primary table.
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Property Description

Primary Table Name (S)
 

Species the name of the primary table. Tables that the dock object tables identify for a dock object are
related through foreign keys in the data model to one primary table.
 

User Name (S)
 

Species the full name of the dock object.
 

Visibility Level (S)
 

Species the level at which to download tables to a corresponding set of tables.
 

Write DB cache (S)
 

If TRUE, then the dock object writes explicitly to the S_DOCK_INST table.
 

Dock Object Related DObj  
A dock object related DObj aects information access. For more information, see  Siebel Developer's Reference .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Dock Object > Dock Object Related DObj

The following table describes properties that Siebel CRM uses with a dock object related DObj.

Property Description

Active (S)
 

If TRUE, then the dock object is active in Siebel CRM.
 

Check Visibility (S)
 

If TRUE, then Siebel CRM examines the visibility rules for the user.
 

Name (S)
 

Species the name of the dock object in which this doc object related dock DObj belongs.
 

Rel DObj Visibility Strength (S)
 

Species the visibility strength of the related dock object. This property can contain only an integer.
 

Related Dock Object Name (S)
 

Species the name of the related dock object.
 

SQL Statement (S)
 

Species the SQL script that Siebel CRM uses to handle special exceptions for a rule.
 

Sequence (S)
 

Species the position of the dock object. This property can contain only an integer.
 

Visibility Event Columns (S)
 

Species the name of the visibility event columns for the related dock object visibility rule.
 

Visibility Strength (S)
 

Species the visibility strength of the related dock object. This property can contain only an integer
between 0 and 100:
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Property Description

 
• A value of 100 provides full visibility.

• A value of 0 provides no visibility.

• A value between 1 and 100 provides partial visibility.

Dock Object Table  
A dock object table species the table that contains the records that Siebel CRM downloads with a dock object. For more
information, see  Siebel Developer's Reference .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Dock Object > Dock Object Table

The following table describes properties that Siebel CRM uses with a dock object table.

Property Description

Dock Object Sub Type (S)
 

Species the sub type of the dock object.
 

Filter Sql Statement (S)
 

Species the SQL script that Siebel CRM uses to lter data regarding the dock object tables.
 

Name (S)
 

Species the name of the table that receives the records.
 

Node Language Filter (S)
 

Species to use language selective downloading of translation tables to a remote client according to
the client preferred language.
 
You can use one of the following values:
 

• TRUE. Siebel CRM applies the node language lter to the translation tables.

• TRUE. Siebel CRM does not apply the node language lter and treats the table the same as it does
a normal dock table.

Notify (S)
 

If TRUE, then Siebel CRM logs events to the Client Diagnostics view of the Siebel Remote Admin
screen.
 

Source Column Name (S)
 

Species the name of the column that Siebel CRM uses as the source for the dock object table.
 

Table Name (S)
 

Species the name of the table that contains the records that Siebel CRM downloads with the dock
object.
 

Target Column Name (S) Species the target column of the table that contains the records that Siebel CRM must download.
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Property Description

   

Target Table Name (S)
 

Species the name of the table that receives the records that Siebel CRM downloads with the dock
object.
 

Visibility Event (S)
 

If TRUE, then the Transaction Router examines visibility rules on a visibility event and makes sure that
any modication that exists in a dock table is a visibility event transaction.
 

Visibility Strength (S)
 

Species the visibility strength of the dock object table. This property can contain only an integer
between 0 and 100:
 

• A value of 100 provides full visibility.

• A value of 0 provides no visibility.

• A value between 1 and 100 provides partial visibility.

Dock Object Visibility Rule  
A dock object visibility rule denes a set of rules that evaluate the records in a dock object that Siebel CRM displays for a
remote user. For more information, see  Siebel Developer's Reference .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Dock Object > Dock Object Visibility Rule

The following table describes properties that Siebel CRM uses with a dock object visibility rule.

Property Description

Active (S)
 

If TRUE, then the dock object visibility rule is active in Siebel CRM.
 

Category Column Name (S)
 

Species the name of the category column that Siebel CRM uses to determine if a category is visible to
a user.
 

Category Table Name (S)
 

Species the name of the category table that Siebel CRM uses to determine if a category is visible to a
user.
 

Check DObj Visibility Strength (S)
 

Species the property that Siebel CRM examines to determine the visibility strength of the dock object.
 

Check Dock Object Name (S)
 

Species the name of an object denition that Siebel CRM uses to determine if it is related to another
record that the user receives.
 

DBX SQL Statement (S) Species the SQL statement that Siebel CRM uses to extract a database.
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Property Description

   

Dock Object Sub Type (S)
 

Species the sub type of the dock object.
 

Employee Column Name (S)
 

Species the name of the column that Siebel CRM uses to evaluate each record according to if it
includes a foreign key to the Employee record of the remote user.
 

Employee Table Name (S)
 

Species the name of the employee table.
 

Name (S)
 

Species the name of the dock object visibility rule.
 

Node Column Name (S)
 

Species the column name for the node dock object visibility rule.
 

Node Table Name (S)
 

Species the table name for the node dock object visibility rule.
 

Organization Column Name (S)
 

Species the column name for the organization dock object visibility rule.
 

Organization Table Name (S)
 

Species the table name for the organization dock object visibility rule.
 

Partial (S)
 

Not used.
 

Position Column Name (S)
 

Species the column name for the position dock object visibility rule.
 

Position Table Name (S)
 

Species the table name for the position dock object visibility rule.
 

Sequence (S)
 

Species an integer that determines the order that Siebel CRM uses to run this visibility rule relative to
other visibility rules.
 

Source Column Name (S)
 

Species the source column name for the check dock object visibility rule.
 

Source Table Name (S)
 

Species the source table name for the check dock object visibility rule.
 

SQL Statement (S)
 

Species the SQL statement for the SQL dock object visibility rule.
 

Target Column Name (S)
 

Species the target column name for the check dock object visibility rule.
 

Target Table Name (S)
 

Species the target table name for the check dock object visibility rule.
 

Type (S)
 

Species the type of the dock object visibility rule.
 

Visibility Event Columns (S)
 

Species the visibility event columns for the dock object visibility rule.
 

Visibility Strength (S)
 

Species the visibility strength of the dock object visibility rule. This property can contain only an
integer between 0 and 100:
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Property Description

 
• A value of 100 provides full visibility.

• A value of 0 provides no visibility.

• A value between 1 and 100 provides partial visibility.

EIM Interface Table Object Types  
This topic describes the EIM Interface Table object type and the object types that are children of this object type. It
includes the following topics:

• Aribute Mapping

• EIM Explicit Primary Mapping

• EIM Interface Table

• EIM Interface Table Column

• EIM Table Mapping

• Foreign Key Mapping

• Foreign Key Mapping Column

• Interface Table User Key Usage

Aribute Mapping  
An aribute mapping identies an aribute column that Siebel CRM updates. This column resides in the destination
table that the parent Siebel Enterprise Integration Manager (EIM) table mapping identies.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > EIM Interface Table > EIM Table Mapping > Aribute Mapping

The following table describes properties that Siebel CRM uses with an aribute mapping.

Property Description

Base Table Aribute Column Name (S)
 

Species the name of the aribute column in the base table.
 

Export Only (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM considers mappings for export.

• FALSE. Siebel CRM does not consider mappings for export.

Interface Table Data Column (S) Species the name of corresponding EIM Interface Table Column.
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Property Description

   

Name (S)
 

Species the name of the aribute column in the target table.
 

EIM Explicit Primary Mapping  
An EIM explicit primary mapping maps a primary for the Siebel Enterprise Integration Manager (EIM). For more
information, see  Siebel Developer's Reference .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > EIM Interface Table > EIM Table Mapping > EIM Explicit Primary Mapping

The following table describes properties that Siebel CRM uses with an EIM explicit primary mapping.

Property Description

Inf Tbl Exp Primary Flg Col Name (S)
 

Species the name of the column that Siebel CRM uses for primary mapping.
 

Name (S)
 

Species the name of the table that Siebel CRM uses for the primary mapping.
 

EIM Interface Table  
An EIM interface table is an alternative representation of a table that the Siebel Enterprise Integration Manager (EIM)
uses only for interface tables. For more information, see  Siebel Enterprise Integration Manager Administration Guide .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > EIM Interface Table

The following table describes properties that Siebel CRM uses with an EIM interface table.

Property Description

Abbreviation 1 - 3 (S)
 

Species up to three alternative abbreviations for the table.
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Property Description

Alias (S)
 

Not used.
 

Base Table Name (S)
 

Species the Type property as one of the following:
 

• Ext for extending

• Journal for the name of the table that is journaling

EIM Delete Proc Column Name (S)
 

Species the name of the column that Siebel CRM deletes during data integration.
 

EIM Export Proc Column Name (S)
 

Species the name of the column that Siebel CRM exports during data integration.
 

EIM Merge Proc Column Name (S)
 

Species the name of the column that Siebel CRM merges during data integration.
 

File (S)
 

If TRUE, then Siebel CRM uses the table to save le aachment data.
 

Name (S)
 

Species the unique name of the table.
 

Parent Interface Table Name (S)
 

Species the name of the parent interface table.
 

Parent Table Column 1 Name (S)
 

Species the name of the column that references the primary parent if this table is a child table or
intersection table.
 

Parent Table Column 2 Name (S)
 

Species the name of the column that references the second parent if this table is an intersection table.
 

Target Table Name (S)
 

Species the name of the target table.
 

Type (S)
 

Species the type of table.
 

User Name (S)
 

Species a user-friendly name for the table.
 

EIM Interface Table Column  
An EIM interface table column is an alternative representation of a column that Siebel Enterprise Integration Manager
(EIM) uses for a column that is a child of an interface table. For more information, see  Siebel Enterprise Integration
Manager Administration Guide .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > EIM Interface Table > EIM Interface Table Column
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The following table describes properties that Siebel CRM uses with an EIM interface table column.

Property Description

Alias (S)
 

Not used.
 

Cascade Clear (S)
 

If TRUE, then EIM clears this foreign key if Siebel CRM deletes the related entity. This property must be
FALSE for an extension column.
 

Default (S)
 

Species the value that Siebel CRM uses for this column in a new record.
 

Denormalization Path (S)
 

Species the path that Siebel CRM denormalizes if this is a denormalization column. Applies to
denormalization of a user key column into an intersection table.
 

EIM Processing Column Flag (S)
 

If TRUE, then the column for this interface table is reserved for EIM processing. You must not use this
property to allow this column to contain customer data.
 

Force Case (S)
 

Species to force new values to uppercase leers.
 

Foreign Key Table Name (S)
 

Species the table to which this column is a foreign key, EIM uses this property.
 

Lov Bounded (S)
 

If TRUE, then EIM examines the values in a list dened in a LOV Type. You must congure Siebel CRM
to rst import LOV data into the S_LST_OF_VAL table and you must specify LOV Type.
 
This property is read-only for a predened column in Siebel CRM but is editable for a column that you
add through the Database Extension Designer.
 

Lov Type (S)
 

Species the list of values where Siebel CRM validates this column. Siebel CRM uses the Lov Type
property with the LOV Bounded property. You dene a list of values in List of Values administration
screen in the client.
 
This property is read-only for a predened column in Siebel CRM but is editable for a column that you
add through the Database Extension Designer.
 

Name (S)
 

Species a name that must be unique in the table.
 

Nullable (S)
 

If TRUE, then Siebel CRM can save NULL in this column.
 

Physical Type (S)
 

Species the data type of the column in the Siebel database.
 

Precision (S)
 

For more information, see About the Precision and Scale Properties.
 

Primary Child Col (S)
 

EIM uses this property. For Oracle use only.
 

Primary Child Column Name (S)
 

Species the name of the column that contains the primary ID value.
 

Primary Child Table Name (S)
 

Species the name of the table where Siebel CRM can locate the primary child.
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Property Description

Primary Inter Table Name (S)
 

EIM uses this property. For Oracle use only.
 

Primary Join Column Name (S)
 

Species the name of the column that Siebel CRM uses to join the record.
 

Primary Key (S)
 

If TRUE, then Siebel CRM uses this column as part of the primary key of the table.
 

Required (S)
 

If TRUE, then Siebel CRM requires this column. This requirement is true even if the Siebel database
allows a NULL value.
 

Scale (S)
 

For more information, see About the Precision and Scale Properties.
 

Sequence Object (S)
 

If TRUE, then Siebel CRM uses a sequence object and automatically creates case column values. Only
one foreign key can exist for the foreign key table for each table.
 
For Oracle use only.
 

Text Length (S)
 

Species the length in characters for a Text column or Varchar column. The column size in Siebel Tools
is not the same as the column size in the physical database. For more information about this dierence,
 see 531960.1 (Article ID) on My Oracle Support.
 

Translate
 

For Oracle internal use only. You must leave this property set to FALSE for an extension column.
 

Translation Table Name (S)
 

Species the name of the translation table.
 

Type (S)
 

Species the type.
 

Use FKey (S)
 

If TRUE, then Siebel CRM uses this foreign key during synchronization to evaluate visibility. You must
leave this property set to FALSE for an extension column.
 

Use Key Sequence (S)
 

Species the order that Siebel CRM uses this column in the user key.
 

User Name (S)
 

Species the user-friendly name for the column.
 

Valid Condition (S)
 

Species the expression that Siebel CRM uses to validate column values.
 

EIM Table Mapping  
An EIM table mapping identies a data table that the parent EIM interface table object denition updates. Siebel
Enterprise Integration Manager (EIM) uses this object. For more information, see  Siebel Enterprise Integration Manager
Administration Guide .

141



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > EIM Interface Table > EIM Table Mapping

The following table describes properties that Siebel CRM uses with an EIM table mapping.

Property Description

Default Map Column Name Prex (S)
 

Species the prex for the default column that Siebel CRM maps during data integration.
 

Destination Table Name (S)
 

Species the name of the target table for the mapping.
 

EIM Exists Proc Column Name (S)
 

Species the name of the existing column that Siebel CRM uses during data integration.
 

EIM ROW_ID Proc Column Name (S)
 

Species the name of the row ID column that Siebel CRM uses during data integration.
 

EIM Status Proc Column Name (S)
 

Species the name of the status column that Siebel CRM uses during data integration.
 

EIM Unique Proc Column Name (S)
 

Species the unique name of the column that Siebel CRM uses during data integration.
 

Explicit Mapping (S)
 

If TRUE, then Siebel CRM maps the table during data integration.
 

Name (S)
 

Species the name of the target table.
 

Second Row (S)
 

If TRUE, then Siebel CRM separates one row in the EIM table into two dierent rows in the table. If you
must map a table to an EIM table two times, then you can set this property. You can use this property
with a table that includes a data row pair, such as the S_INV_LGR_ENTRY table.
 

Foreign Key Mapping  
A foreign key mapping identies a foreign key column in the destination table that an interface table populates. Siebel
Enterprise Integration Manager (EIM) uses this object type. For more information, see  Siebel Enterprise Integration
Manager Administration Guide .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > EIM Interface Table > EIM Table Mapping > Foreign Key Mapping

The following table describes properties that Siebel CRM uses with a foreign key mapping.
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Property Description

EIM Foreign Key Proc Column (S)
 

Species the name of the column that EIM uses as the foreign key.
 

Export Only (O)
 

If TRUE, then the Foreign Key Mapping Column object denitions identify user key columns to the
interface table so that Siebel CRM gets foreign key values when an export occurs.
 
Each Foreign Key Mapping Column object denition identies part of the user key columns that Siebel
CRM uses to locate rows in the table that the foreign key references. The combination of user key
columns uniquely identies rows in this table.
 

Foreign Key Column Name (S)
 

Species the name of the column that Siebel CRM uses as the foreign key.
 

Name (S)
 

Species the name of the foreign key column.
 

Override Ref Column Name (S)
 

Species the name of the column that Siebel CRM uses to override the value that the EIM Foreign Key
Proc Column property contains.
 

User Key Name (S)
 

Species the name of the user key column that Siebel CRM nds in the user key index.
 

Foreign Key Mapping Column  
A foreign key mapping column identies a part of the user key. It identies an aribute column that Siebel CRM uses to
locate rows in the table that the foreign key references. The combination of user key columns uniquely identies rows in
this table. Siebel Enterprise Integration Manager (EIM) uses this object type. For more information, see  Siebel Enterprise
Integration Manager Administration Guide .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > EIM Interface Table > EIM Table Mapping > Foreign Key Mapping > Foreign Key Mapping
Column

The following table describes properties that Siebel CRM uses with a foreign key mapping column.

Property Description

Interface Table Data Column Name (S)
 

Species the name of the column in the interface table that supplies the data.
 

Name (S)
 

Species the name of the user key column.
 

Self Ref Mapping Column Name (S)
 

Species the name of the column.
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Property Description

Self Reference Join (S)
 

If TRUE, then Siebel CRM allows a join operation between the self-reference mapping column and the
foreign key mapping column.
 

User Key Aribute Name (S)
 

Species the name of the aribute column.
 

Interface Table User Key Usage  
An interface table user key usage provides support for alternative user keys for tables. It determines how Siebel CRM
uses a nontraditional user key for an interface table. Siebel Enterprise Integration Manager (EIM) uses this object type.
For more information, see  Siebel Enterprise Integration Manager Administration Guide .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > EIM Interface Table > Interface Table User Key Usage

The following table describes properties that Siebel CRM uses with an interface table user key usage.

Property Description

Application Table Name (S)
 

Species the name of the base table in an interface table.
 

Name (S)
 

Species the name of an interface table user key usage.
 

User Key Name (S)
 

Species the name of the user key.
 

Entity Relationship Diagram Object Types  
This topic describes the Entity Relationship Diagram object type and the object types that are children of this object
type. It includes the following topics:

• Entity

• Entity Aribute (H)

• Entity Physical Relation (H)

• Entity Relation

• Entity Relationship Diagram
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Entity  
An entity contains entity properties.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Entity Relationship Diagram > Entity

The following table describes properties that Siebel CRM uses with an entity.

Property Description

Business Component
 

Species a user-dened entity or an entity that is associated with an existing business component.
 

Name
 

Species the name of the entity. The default name is Entity 1. You can modify this value.
 

Entity Aribute (H)  
An entity aribute contains information about an aribute in an entity.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Entity Relationship Diagram > Entity > Entity Aribute

The following table describes properties that Siebel CRM uses with an entity aribute.

Property Description

Business Component
 

Species the business component to display for the parent entity object.
 
This property is read only.
 

Business Component Field
 

Species the eld that contains a picklist of the properties on the business component that Siebel CRM
maps to the entity.
 
For example, if Siebel CRM maps the Account business component to an entity, then the Business
Component Field picklist contains Account Competitors, Account Conditions, Account Markets, and so
on.
 

Data Example
 

Species a text example of an entity aribute.
 

Data Type
 

Species the data type for this entity aribute.
 

Format String
 

Species the string format for this entity aribute. For example, to specify the format string for a
telephone number, you can enter the following value:
 

(XXX)XXX-XXXX

145



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

Length
 

Species the maximum length for this entity aribute.
 

Name
 

Species the name for this entity aribute.
 

Pick List Domain
 

Species the set of values for an entity aribute that you dene from a picklist.
 

Pick List Required
 

If TRUE, then a picklist is required.
 

User Key Flag
 

If TRUE, then this entity aribute is a user key.
 

Entity Physical Relation (H)  
An entity physical relation if you bind a relation in the ERD these elds become populated as read-only elds.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Entity Relationship Diagram > Entity Relation > Entity Physical Relation

The following table describes properties that Siebel CRM uses with an entity physical relation.

Property Description

Business Component
 

Species the primary business component depending on if this entity physical relation is a:
 

• Link. Species the business component name.

• Join. Species the parent business component.

Join Alias
 

Species the join alias if this entity physical relation is a join.
 

Link Name
 

Species the link name if this entity physical relation is a link.
 

Name
 

Species the name of the repository object that Siebel CRM binds to this entity physical relation
depending on if this entity physical relation is a:
 

• Link. Species the link name.

• Join. Species the join alias.

Entity Relation  
An entity relation contains the denition of the relation that Siebel Tools displays on the canvas.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Entity Relationship Diagram > Entity Relation

The following table describes properties that Siebel CRM uses with an entity relation.

Property Description

Cardinality
 

Species one of the following relationships:
 

• 1:1 (one to one)

• 1:M (one to many)

• M:1 (many to one)

• M:M (many to many)

End Name 1
 

Species the name for the start of the relationship.
 

End Name 2
 

Species the name for the end of the relationship.
 

Entity 1
 

Species the entity at the start of the relationship. You can specify an entity that references a
predened business component or a custom entity.
 

Entity 2
 

Species the entity at the end of the relationship. You can specify an entity that references a
predened business component or a custom entity.
 

Name
 

Species the name of the entity relation. You can specify the default name, such as Relation0, or you
can use a custom name, such as one of the following names:
 

Owns for Customer 

Owns Automobile

Entity Relationship Diagram  
An entity relationship diagram allows a business analyst or developer to dene business entities and then map the
appropriate Siebel object to each entity.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Entity Relationship Diagram

The following table describes properties that Siebel CRM uses with an entity relationship diagram.

Property Description

Name
 

Species the name of the entity relationship diagram (ERD). This name must be unique.
 

Status Species the status of the entity relationship diagram.
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Property Description

   

External Search Engine Object Type  
This topic describes the External Search Engine object type.

External Search Engine (H)  
An external search engine customizes search content. A search engine includes one or more search tables and each of
these tables includes one or more search elds.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > External Search Engine

The following table describes properties that Siebel CRM uses with an external search engine.

Property Description

Max Rows (O)
 

Species the maximum number of result rows to get.
 

Max Time (O)
 

Species the maximum time in seconds to search.
 

Name (R)
 

Species the logical name of this search denition. This value is the value for the SearchDefName
parameter in the conguration le.
 

Sort Specication (O)
 

Species the sort expression that orders the records that Siebel CRM returns. For example:
 

SCORE DESC, FILENAME ASC

Find Object Types  
This topic describes the Find object type and the object types that are children of this object type. It includes the
following topics:

• Find

• Find Field

• Find Field Locale

• Find Locale

• Find Pick View

• Find View
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Find  
A nd creates an entry that Siebel CRM can add to the Find dialog box in the client.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Find

The following table describes properties that Siebel CRM uses with a nd.

Property Description

Applet (R)
 

Species the applet that the nd uses. The view that Siebel CRM species for every Find View object
denition for the Find object must include this applet.
 

Destination Field (R)
 

Species the destination eld that Siebel CRM uses to drill down into a record. This eld resides in the
business component that the applet references. If the Destination Field property is empty, then Siebel
CRM uses the row ID eld.
 

Display Name (O)
 

Species the display name for the Find object.
 

Drilldown View (O)
 

Species the view that Siebel CRM displays if the user drills down. If the Drilldown View property is
empty, then it uses the Find View.
 

Name (R)
 

Species the name of the Find object denition. You reference this value when you congure the
application nd object denitions that use this Find object denition.
 

Preview (O)
 

Species the view that Siebel CRM displays in a separate browser window if the user clicks the Preview
buon in the Search Center. This preview view is typically a read-only view.
 
For example, the preview for the Accounts nd is Accounts Preview View.
 

Find Field  
A nd eld adds a search eld to the Find dialog box that Siebel CRM displays in the client.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Find > Find Field

The following table describes properties that Siebel CRM uses with a nd eld.

Property Description

Display In Entry (O)
 

Species a TRUE or FALSE value.
 

Display In Results (O)
 

Species a TRUE or FALSE value.
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Property Description

Display Name (O)
 

Species the text or a key to the localized text that Siebel CRM displays for this nd eld if the parent
nd object denition of this nd eld is active in the Find dialog box.
 

Drilldown Business Component
 

Species the business component of the search result record that Siebel CRM queries in the
destination view. This property allows you to congure separate drilldowns on the various elds in the
Find Results applet.
 

Drilldown Destination Field
 

Species the eld in the destination business component whose value equals the value of the source
eld in the source business component. This property allows you to congure separate drilldowns on
the various elds in the Find Results applet. If you do not specify a value in the Drilldown Source Field
property, then do not specify a value in the Drilldown Destination Field property.
 
The value you enter in the Drilldown Destination Field property is valid only for Find results.
 

Drilldown Source Field
 

Species the eld in the source business component whose value equals the value of the eld in the
destination business component. This property allows you to congure separate drilldowns on the
various elds in the Find Results applet.
 
The value you enter in the Drilldown Source Field property is valid only for Find results.
 

Drilldown View
 

Species the view where Siebel CRM displays the search result record if the user drills down. This
property allows you to congure separate drilldowns on the various elds in the Find Results applet.
 

Field (R)
 

Species the eld that Siebel CRM searches in the business component.
 

Name (R)
 

Species the name of the search eld.
 

Sequence (O)
 

Species the order that Siebel CRM uses to position this nd eld in the list of elds that it displays in
the Find dialog box for the parent nd object denition. The Sequence property can contain only an
integer.
 

Sequence - Language Override (O)
 

Species to modify the Sequence property if a language or locale is active. The Sequence - Language
Override property can contain only an integer.
 

Title (O)
 

Reserved for future use.
 

Conguring the Field for a Find Field  
The eld that you specify in a nd eld must exist in the business component that the applet references for the nd
object denition.

Conguring Query For the Find Dialog Box  
The conguration of the Find dialog box and the conguration of a query by example might be dierent for a multivalue
eld. The Find dialog box uses the same query that an EXISTS query on a eld in a query by example uses. To verify this
conguration, you can use an Exists expression in the query by example. For example:

Exists (Aga*)
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Query by example supports each type of querying, but to keep the Find dialog box simple, Siebel CRM uses a query that
works in all situations. If your implementation must not use the EXISTS conguration in the Find dialog box, then you
can do the following:

1. Create a join from the primary ID eld for the multivalue link to the table that contains the data.
2. Add a eld on the table that you joined in the preceding instructions.
3. Congure the nd eld to reference the eld you added in the preceding instructions.

Find Field Locale  
A nd eld locale denes language overrides that Siebel CRM uses with a nd eld.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Find > Find Field > Find Field Locale

The following table describes properties that Siebel CRM uses with a nd eld locale.

Property Description

Display Name (O)
 

Species the text or the key to the localized text that Siebel CRM displays for this nd eld if the parent
nd object denition is active in the Find dialog box for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Sequence (O)
 

Species the order that Siebel CRM uses to position this nd eld in the list of elds that it displays in
the Find dialog box for the parent nd object denition. The Sequence property can contain only an
integer.
 

Find Locale  
A nd locale denes the language overrides that Siebel CRM uses with a nd.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Find > Find Locale

The following table describes properties that Siebel CRM uses with a nd locale.

Property Description

Display Name (O)
 

Species the display name for the Find object for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU
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Find Pick View  
A nd pick view identies the applet in the pick view that receives items from the nd results list. Siebel CRM can
associate nd results to an applet if a relationship exists between the applet and the parent of this applet, and if the
search result and the Pick Applet reference the same business components. To create this relationship in Siebel Tools,
you use an intersection table that creates a link between the two business components.

The following is an example conguration for the Opportunities nd category:

• Conguration of the pick view is Contact Detail - Opportunities View

• Conguration of the pick applet is Opportunity List Applet - Basic

In this example, if a many-to-many relationship exists between the parent Contact applet and the child Opportunity
List Applet - Basic applet, then Siebel CRM can aach an Opportunity Find result to the Opportunity List Applet - Basic
applet.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Find > Find Pick View

The following table describes properties that Siebel CRM uses with a nd pick view.

Property Description

Applet Name (O)
 

Species the name of an applet in a view that allows the user to associate a child record to a parent.
 

Field Name (O)
 

Species the MVG eld. Siebel CRM does not support this property in Siebel CRM version 7.
 

Name (R)
 

Property is hidden and its value is defaulted from the View Name property.
 

View Name (O)
 

Species the name of the view.
 

Find View  
A nd view species the view that Siebel CRM displays if it uses the Find dialog box to perform a nd operation.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Find > Find View

The following table describes properties that Siebel CRM uses with a nd view.

Property Description

Sequence (O)
 

Species the order that Siebel CRM uses to display views for a nd object denition. The nd operation
uses the rst nd view object denition that it encounters in the responsibility list for the user. Dierent
views apply dierent visibility. It is recommended that you congure Siebel CRM to examine the least
restrictive view in this list rst and the most restrictive view last. This order allows users who possess
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Property Description

dierent responsibilities to use the broadest visibility that Siebel CRM allows the user to apply when the
user must nd an item.
 

View (R)
 

Species the name of the view that Siebel CRM uses for the nd operation if this nd view is used.
 

Help ID Object Type  
This topic describes the Help Id object type.

Help Id  
A help Id species the HTML le name that contains the help topics for a screen in the client. To reference it, you enter
the help Id name in the Help Identier property of a view or screen. If the user chooses the Help menu and then clicks
Contents, then Siebel CRM calls the GotoPage method of the Siebel Web Engine (SWE). This method uses SWE code
to display the correct help topic in a separate browser window. For more information about help, see  Siebel Object
Interfaces Reference .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Help Id

The following table describes properties that Siebel CRM uses with a help Id.

Property Description

HTML Help URL (O)
 

Species the URL that Siebel CRM displays. The URL is relative to the public directory on the Siebel
Web Server. This URL includes the HTML le that includes help content. For example, you can enter the
following value in the HTML Help URL property:
 

help/siebaccounts.htm

Name (R)
 

Species the string that identies the help topic. This string must contain no special characters except
for the underscore (_) symbol. It uses the following format:
 

ID_type_object_name
 

where:
 

• type is VIEW or SCREEN. You must use all upper case leers.

• object_name identies the view or screen

For example, you can use the following value for the Accounts screen help:
 

ID_SCREEN_ACCOUNTS

Type (O)
 

Species the object type that can use this help topic. For example:
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Property Description

View

Value (O)
 

Not used.
 

HTML Hierarchy Bitmap Object Type  
This topic describes the HTML Hierarchy Bitmap object type.

HTML Hierarchy Bitmap  
An HTML hierarchy bitmap is a top-level object that determines the set of bitmaps that Siebel CRM uses to display
hierarchical information.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > HTML Hierarchy Bitmap

The following table describes properties that Siebel CRM uses with an HTML hierarchy bitmap. If a property in this table
references a bitmap, then the Bitmap Category property of this bitmap must be set to HTML Hierarchy Icons.

Property Description

Arrow Down Bitmap (O)
 

Species the name of the bitmap object that denes a down arrow image.
 

Arrow Up Bitmap (O)
 

Species the name of the bitmap object that denes an up arrow image.
 

Bar Bitmap (O)
 

Species the name of the bitmap object that denes a vertical bar image.
 

Close Bitmap (O)
 

Species the name of the bitmap object that denes a closed folder image.
 

Collapse Bitmap (O)
 

Species the name of the bitmap object that denes a collapsed folder image.
 

Collapse Elbow Bitmap (O)
 

Species the name of the bitmap object that denes a collapsed elbow image.
 

Collapse Tee Bitmap (O)
 

Species the name of the bitmap object that denes a collapsed tee image.
 

Elbow Bitmap (O)
 

Species the name of the bitmap object that denes an elbow image.
 

Expand Bitmap (O)
 

Species the name of the bitmap object that denes an expanded image.
 

Expand Elbow Bitmap (O)
 

Species the name of the bitmap object that denes an expanded elbow image.
 

154



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

Expand Tee Bitmap (O)
 

Species the name of the bitmap object that denes an expanded tee image.
 

Leaf Bitmap (O)
 

Species the name of the bitmap object that denes a document image.
 

Name (R)
 

Species the name of this HTML hierarchy bitmap.
 

Open Bitmap (O)
 

Species the name of the bitmap object that denes an open folder image.
 

Space Bitmap (O)
 

Species the name of the bitmap object that denes a white space image.
 

Tee Bitmap (O)
 

Species the name of the bitmap object that denes a |- (pipe dash) image.
 

Icon Map Object Types  
This topic describes the Icon Map object type and the object types that are children of this object type. It includes the
following topics:

• Icon

• Icon Map

Icon  
An icon species then icon that a bitmap uses to dene the image for the icon.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Icon Map > Icon

The following table describes properties that Siebel CRM uses with an icon.

Property Description

Bitmap (O)
 

Species the bitmap that Siebel CRM uses for the icon.
 

Bitmap Category (O)
 

Species the bitmap category in which the icon bitmap belongs.
 

Name (R)
 

Species the name of the icon that Siebel CRM compares to the eld value.
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Icon Map  
An icon map denes a collection of icon objects that Siebel CRM uses in controls and list columns to map a eld value
to an icon. To determine the icon that Siebel CRM uses to display the eld value, it compares the eld value to the icon
name.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Icon Map

The following table describes properties that Siebel CRM uses with an icon map.

Property Description

Name (R)
 

Species the name of the icon map.
 

Import Object Object Types  
This topic describes the Import Object object type and the object types that are children of this object type. It includes
the following topics:

• Import Aux Field

• Import Field

• Import Field Column

• Import Field Locale

• Import Field Map

• Import Key Field

• Import Object

• Import Source

Import Aux Field  
An import aux eld denes the auxiliary key eld name for the business component dened in the import object. If
more than one item references the key eld, then Siebel CRM does a second search that uses the auxiliary key elds. For
example, Account and Account Location for Contact.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Import Object > Import Aux Field

The following table describes properties that Siebel CRM uses with an import aux eld.
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Property Description

Aux Field Name (R)
 

Species the auxiliary key eld name.
 

Name (R)
 

Species the name in the import object.
 

Import Field  
An import eld denes a eld. Siebel CRM imports data to this eld.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Import Object > Import Field

The following table describes properties that Siebel CRM uses with an import eld.

Property Description

Display Name (O)
 

Species the value that Siebel CRM uses as the column heading or the key to the international
message table.
 

Field (R)
 

Species the name of a eld. Siebel CRM imports data to this eld.
 

Name (R)
 

Species the name in the import object.
 

Import Field Column  
An import eld column denes the column in the import source that Siebel CRM uses to import the data. It imports this
data into the parent import eld of the corresponding data map.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Import Object > Import Source > Import Field Map > Import Field Column

The following table describes properties that Siebel CRM uses with an import eld column.

Property Description

Column (R)
 

Species the name of the column.
 

Name (R)
 

Species the name in the import object.
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Import Field Locale  
An import eld locale denes language overrides that Siebel CRM uses with an import eld.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Import Object > Import Field > Import Field Locale

The following table describes properties that Siebel CRM uses with an import eld locale.

Property Description

Display Name (O)
 

Species the value that Siebel CRM uses as the column heading or the key to the international
message table for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Import Field Map  
An import eld map denes the mapping between the business component eld and the column in the import source.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Import Object > Import Source > Import Field Map

The following table describes properties that Siebel CRM uses with an import eld map.

Property Description

Country Code Column (O)
 

Species the name of the country code column in the import source.
 

Display Name (O)
 

Species the value that Siebel CRM uses as the column heading or the key to the international
message table.
 

Field (R)
 

Species the name of a eld. Siebel CRM imports data to this eld.
 

Name (R)
 

Species the name in the import source.
 

Parse Middle Name (O)
 

If TRUE, then Siebel CRM parses the middle name out of the full name.
 

Separator Character (O)
 

Species the character that Siebel CRM inserts between the parts the input data if this input data
include separate parts.
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Import Key Field  
An import key eld denes the key eld name for the business component dened in the import object. Siebel CRM
uses the import key eld to search for duplicates. For example, the contact import object includes the First Name,
Middle Name, and Last Name key elds.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Import Object > Import Key Field

The following table describes properties that Siebel CRM uses with an import key eld.

Property Description

Key Field (R)
 

Species the key eld name.
 

Name (R)
 

Species the name in the import object.
 

Import Object  
An import object denes the information that Siebel CRM uses to import external data into a business component.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Import Object

The following table describes properties that Siebel CRM uses with an import object.

Property Description

Business Component (R)
 

Species the name of a business component. Siebel CRM imports data into this business component.
 

Name (R)
 

Species the name of the import object.
 

Import Source  
An import source denes the source that Siebel CRM uses to import data. For example, ACT! or ECCO.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Import Object > Import Source

The following table describes properties that Siebel CRM uses with an import source.
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Property Description

Name (R)
 

Species the name of the import source.
 

Integration Object Object Types  
This topic describes the Integration Object object type and the object types that are children of this object type. It
includes the following topics:

• Integration Component

• Integration Component Field

• Integration Component Field User Prop

• Integration Component Key

• Integration Component Key Field

• Integration Component User Prop

• Integration Object

• Integration Object User Prop

Integration Component  
An integration component structures an inbound or outbound message string into a format that Siebel CRM or an
external application can recognize. The integration component is an intermediate structure that helps resolve any
dierence that exists between the format that Siebel CRM uses and the format that an external application uses.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Integration Object > Integration Component

The following table describes properties that Siebel CRM uses with an integration component.

Property Description

Adapter Info (S)
 

Oracle uses this property with the Integration Object Wizard.
 

Business Component (O)
 

Species the name of the business component.
 

Cardinality (O)
 

Species the number of integration components.
 

External Name (S)
 

Species the name of the structure that the external application can recognize.
 

External Sequence (O)
 

Species the order that Siebel CRM uses to process integration components. This property can contain
only an integer.
 

Name (R) Species the name of the integration component.
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Property Description

   

Parent Integration Component (O)
 

Species the name of the parent integration component for this component only if a parent exists.
 
Only one active integration component in an integration object can be the root integration component.
If this integration component is the root integration component, the you must leave the Parent
Integration Component property empty.
 

XML Container Element (O)
 

Species the XML Tag that Siebel CRM uses to enclose elements that represent this integration
component.
 

XML Sequence (O)
 

Species the order that Siebel CRM uses to display integration components in an XML document. This
property can contain only an integer.
 

XML Tag (O)
 

Species the XML tag name that Siebel CRM creates for this integration component if Siebel CRM
converts it into an XML document.
 

Integration Component Field  
An integration component eld is a eld of an integration component object.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Integration Object > Integration Component > Integration Component Field

The following table describes properties that Siebel CRM uses with an integration component eld.

Property Description

Adapter Info (S)
 

Oracle this property with the Integration Object Wizard.
 

Business Component Field (O)
 

Species the name of the business component eld.
 

Column (O)
 

Species the name of the column.
 

External Data Type (R)
 

Species the data type of the eld that Siebel CRM gets from the external application.
 

External Length (O)
 

Species the length of the external data element that corresponds to the Integration component eld.
 

External Name (O)
 

Species the external name of a data component or element that an external application can
recognize.
 

External Precision (O)
 

For more information, see About the Precision and Scale Properties.
 

External Required (O)
 

If TRUE, then the external application requires the external data element. For example, an external
application might require a ROWID that uses ROWID as a primary key eld in a non-Siebel database.
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Property Description

 

External Scale (O)
 

For more information, see About the Precision and Scale Properties.
 

External Sequence (O)
 

Species the order that the adapter uses to process integration component elds. Semantics are
dierent for each adapter.
 

Field Type (O)
 

Species the eld type. The Object List Editor uses the following label to represent a eld type:
 
Type
 
You can use one of the following values:
 

• Custom. Manually sends custom aributes that are not necessarily part of the actual data but
are related to the data context. For more information about this eld type value, see  Integration
Platform Technologies: Siebel Enterprise Application Integration .

• Data. Contains raw eld data that can Siebel CRM can format. It formats an XML document as
delimited strings and saves it in this type of eld.

• System. Contains data that Siebel CRM formats in Siebel format. You can use it to specify the
primary rows of a multivalue group or to specify an operation for an integration object instance.

Group (O)
 

Not used.
 

Length (O)
 

Species the length of the Siebel eld that corresponds to a Siebel table column.
 

Name (R)
 

Species the name of the eld. The maximum length is 75 characters.
 

Physical Data Type (O)
 

Species the data type of the integration eld in the integration space.
 

Precision (O)
 

For more information, see About the Precision and Scale Properties.
 

Required (O)
 

Species that the integration component is required in an integration object.
 

Scale (O)
 

For more information, see About the Precision and Scale Properties.
 

User Visible (O)
 

If TRUE, then this integration component eld is visible to Data Transformation Engine users.
 

XML Literal Value (O)
 

Species the default value that Siebel CRM displays in an XML document if the value for this
integration component eld is not specied.
 

XML Parent Element (O)
 

Species the name of the parent element to which this integration component eld belongs. This
parent element becomes an XML tag.
 

XML Sequence (O)
 

Species the order that Siebel CRM uses to display integration component elds in an XML document.
This property can contain only an integer.
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Property Description

XML Style (O)
 

Species the name of the XML style. It determines if Siebel CRM formats this integration component
eld as an XML aribute or an XML element if Siebel CRM creates an XML document for the
integration object that contains this eld.
 

XML Tag (O)
 

Species an XML element that denes this integration component eld. If the XML Tag property is
empty, then Siebel CRM assigns an XML tag to the integration component eld when it sends this data
to an external application.
 
The maximum length for this property is 75 characters.
 

Integration Component Field User Prop  
An integration component eld user prop sends a property value to the C++ code that implements special conguration
for an integration component eld. Siebel CRM persists the value that you congure for a user property in the Siebel
runtime repository.

For more information, see Object Types That You Must Not Modify.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Integration Object > Integration Component > Integration Component Field > Integration
Component Field User Prop

The following table describes properties that Siebel CRM uses with an integration component eld user prop.

Property Description

Name (R)
 

Species the name of the integration component eld user prop.
 

Value (O)
 

Species the value of the integration component eld user prop.
 

Integration Component Key  
An integration component key denes a key for an integration component. A key includes one or more key elds that
Siebel CRM uses to detect duplicate rows. An integration component key eld denes these key elds.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Integration Object > Integration Component > Integration Component Key

The following table describes properties that Siebel CRM uses with an integration component key.
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Property Description

Key Sequence Number (O)
 

Species the order that Siebel CRM uses to process integration component keys that are of the same
type. This property can contain only an integer.
 

Key Type (R)
 

Type of integration component key.
 

Name (R)
 

Species the name of this integration component key. The maximum length that you can specify in
this property is 75 characters.
 

Target Key Name (O)
 

Species the target key that this foreign key references. Siebel CRM maps elds are mapped according
to sequence.
 
Siebel CRM uses the Target Key Name property only for a key of type Foreign Key.
 

Integration Component Key Field  
An integration component key eld denes an integration eld as a key eld for a key in an integration object. Siebel
CRM implements the integration component key eld object as an intersection table between integration elds and
integration component keys.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Integration Object > Integration Component > Integration Component Key > Integration
Component Key Field

The following table describes properties that Siebel CRM uses with an integration component key eld.

Property Description

Field Name (R)
 

Species the name of integration component eld.
 

Name (R)
 

Species the name of the integration component key eld.
 

Sequence (O)
 

Species the order that Siebel CRM uses to process integration component key elds. This property
can contain only an integer.
 

Integration Component User Prop  
An integration component user prop sends a property value to C ++ code that implements special conguration for
an integration component. Siebel CRM persists the value that you congure for a user property in the Siebel runtime
repository.

For more information, see Object Types That You Must Not Modify.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Integration Object > Integration Component > Integration Component User Prop

The following table describes properties that Siebel CRM uses with an integration component user prop.

Property Description

Name (R)
 

Species the name of the integration component user prop.
 

Value (O)
 

Species the Value of the integration component user prop.
 

Integration Object  
An integration object provides a logical representation of external application data or of Siebel data that Siebel CRM
must map to an external application.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Integration Object

The following table describes properties that Siebel CRM uses with an integration object.

Property Description

Adapter Info (O)
 

Oracle uses this property to support the Integration Object Wizard.
 

Base Object Type (R)
 

Species one of several predened object types that this integration object references.
 

Business Object (O)
 

Species the name of the business object.
 

External Major Version (O)
 

Not used.
 

External Minor Version (O)
 

Not used.
 

External Name (R)
 

Species the name of the object that an external function can recognize.
 

Name (R)
 

Species the name of the integration object.
 

XML Tag (R)
 

Species the XML tag name that Siebel CRM creates for this object when it converts an object to an
XML document.
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Integration Object User Prop  
An integration object user prop sends a property value to C ++ code that implements special conguration for an
integration object. Siebel CRM persists the value that you congure for a user property in the Siebel runtime repository.

For more information, see Object Types That You Must Not Modify.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Integration Object > Integration Object User Prop

The following table describes properties that Siebel CRM uses with an integration object user prop.

Property Description

Name (R)
 

Species the name of the integration object user prop.
 

Value (O)
 

Species the value of the integration object user prop.
 

Link Object Type  
This topic describes the Link object type.

Link  
A link species the relationship between two business components. The relationship can be one-to-many (1:M), such
as parent and child, or many-to-many (M:M). For more information about links, see  Conguring Siebel Business
Applications .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Link

The following table describes properties that Siebel CRM uses with a link.

Property Description

Cascade Delete (O)
 

For more information, see Seing the Cascade Delete Property of a Link.
 

Child Business Component (R)
 

Species the name of a business component. The business component that the Parent Business
Component property species determines the data for the business component that the Child
Business Component property species.
 

Destination Field (R)
 

Species the name of a eld in the child business component that Siebel CRM uses to logically join to
the parent business component. The Destination Field property is required for a 1:M link.
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Property Description

 

Inter Child Column (R)
 

Species the name of a column in the intersection table that links this table to the child business
component. The name is case-sensitive. It must use the same format that it uses in the Siebel
database. The Inter Child Column property is required for a M:M link.
 

Inter Child Delete (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM deletes the association and the child record.

• FALSE. Siebel CRM deletes only the association for the child record. You use FALSE only with a
M:M link.

Inter Parent Column (R)
 

Species the name of a column in the intersection table that links this table to the parent business
component. The name is case-sensitive. It must use the same format that it uses in the Siebel
database. The Inter Parent Column property is required for a M:M link.
 

Inter Table (R)
 

Species the name of the intersection table. The name is case-sensitive. It must use the same format
that it uses in the Siebel database. The Inter Table property is required for a M:M link.
 

Name (R)
 

Species the name for the link. The name can contain spaces and must be unique among links. Other
objects use this name to reference this link. Siebel CRM manages this property. It uses the following
format:
 

 parent business component name/child business component name
 

For example:
 

Account/Account Contact

Note the following:
 

• You must not modify the value in the Name property unless necessary.

• You must not use the Calendar business component as the master or detail business component
in a link.

No Associate (O)
 

If TRUE, then Siebel CRM cannot create a new association through the link. It can add new detail
records. It does not display the association applet when it creates a new record for the child in a M:M
relationship. It requires the user to enter a new record. It does not allow the user to associate this new
record to an existing record.
 
If the current view uses Admin Mode, then Siebel CRM ignores this property.
 
You specify the No Associate property only for a M:M link.
 

No Delete (O)
 

If TRUE, then Siebel CRM does not delete child records through this link.
 

No Insert (O)
 

If TRUE, then Siebel CRM does not create new child records through this link. You specify the No Insert
property only for a 1:M link. For more information, see the No Associate property for this object type.
 

No Inter Delete (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM never deletes intersection table records.
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Property Description

• FALSE. Siebel CRM deletes intersection table records if it deletes a parent or a child record.

The No Inter Delete property applies only to a M:M relationship.
 

No Update (O)
 

If TRUE, then Siebel CRM does not update child records through this link.
 

Parent Business Component (R)
 

Species the name of the business component whose data determines the records that the child
business component gets. The Child Business Component property of this link species this child
business component.
 

Primary Id Field (O)
 

Species the name of the eld in the master business component that contains the row ID values that
reference the primary records in the detail business component.
 

Search Specication (O)
 

Species an expression that Siebel CRM uses to lter the records it gets. If the link is active, then it
applies this lter to the child business component.
 

Sort Spec (O)
 

Species an expression that Siebel CRM uses in an association list to order the detail records that it
gets. You use the Sort Spec property only for a M:M link.
 

Source Field (O)
 

Species the name of a eld in the parent business component that Siebel CRM uses to link to the
child business component. This source eld is a unique identier for rows that exist in the parent
business component. It is typically the eld that maps to the ROW_ID column in the table that the
parent business component references and that possesses the name Id.
 
Siebel CRM does not display this eld in the Fields list in the Object List Editor for the business
component. The Id eld displays only in the dropdown list for some properties, such as the Source
Field property in some object types, such as the link.
 
The default value for the Source Field property is Id. If this property is empty, then Siebel CRM uses Id.
 

Visibility Auto All (O)
 

You can use one of the following values:
 

• TRUE. The user can access all views and can view all records in the child business component.

• FALSE. The Visibility Type property of this link determines visibility.

Visibility Rule Applied (O)
 

Species how Siebel CRM applies visibility rules in a view that uses this link. Visibility seings in a view
apply to the applet that the Visibility Applet property species. If a master-detail relationship exists
between this applet and an applet that displays detail records, then you can use the Visibility Rule
Applied property to allow the user to view detail records that the user cannot normally view because of
visibility rules. The user cannot drill down to view the entire record.
 
You can use one of the following values. Siebel CRM does the following if the current master-detail
view references this link:
 

• Always. Allow visibility rules in the detail records even though the Visibility Applet and Visibility
Applet Type properties of this view do not use the active visibility.

• Never. Disable visibility rules in the detail records.

Visibility Type (O)
 

Species the visibility type if the business component displays as a child in the given link. For more
information, see the description of the Visibility Auto All property for this link.
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Seing the Cascade Delete Property of a Link  
The Cascade Delete property of a link species the action that Siebel CRM performs on detail business component
records of the link if Siebel CRM deletes the master. You can use one of the following values:

• CLEAR. Siebel CRM removes the foreign key reference.

• DELETE. Siebel CRM deletes the child record.

• NONE. Siebel CRM performs no operations on the child record.

You must set the Cascade Delete property to CLEAR in the following situations:

• The child business component in this link is also a child business component in another link.

• Another business component references the same table that a child business component references, and this
other business component is the child business component in another link. For example, assume the following
links exist:

◦ Contact/Action

◦ Contact/Activity Plan

Action and Activity Plan reference the same table. You must make sure Cascade Delete is CLEAR for each link.

Do not set the Cascade Delete property to NONE for a many-to-many link. Siebel CRM deletes the intersection record
for a many-to-many link but does not delete the child record. This child record might have other parents.

If multiple links exist that reference the same tables, then you must make sure that you set the Cascade Delete property
consistently among all of these links. If Siebel CRM deletes a record that is a foreign key of another table, then it might
or might not delete these references. If it does not delete these references, then row IDs might reference nonexistent
records. Siebel CRM might convert these foreign keys to No Match Row Id for a multivalue group.

Menu Object Types  
This topic describes the Menu object type and the object types that are children of this object type. It includes the
following topics:

• Menu

• Menu Item

• Menu Item Locale

Menu  
A menu denes a menu that the user can access.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Menu

The following table describes properties that Siebel CRM uses with a menu.

169



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

Name (R)
 

Species the name of the menu.
 

Menu Item  
A menu item references a command.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Menu > Menu Item

The following table describes properties that Siebel CRM uses with a menu item.

Property Description

Caption (O)
 

Species the text that Siebel CRM displays in the menu. For example:
 

&Insert Record

Command (O)
 

Species the name of a command object denition. This command species the method or accelerator
for the menu item. For example:
 

Create Record

Name (R)
 

Species the name of the menu item. For example:
 

Edit - Insert Record

Position (R)
 

Identies the position of the menu item. The top level positions are 1, 2, 3, and so on. The dot notation
indicates hierarchy. For example:
 

3.1

Restricted
 

For Oracle use only.
 

Menu Item Locale  
A menu item locale denes language overrides that Siebel CRM uses with a menu item.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Menu > Menu Item > Menu Item Locale

The following table describes properties that Siebel CRM uses with a menu item locale.
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Property Description

Caption (O)
 

Species the text that Siebel CRM displays in the menu.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Message Category Object Types  
This topic describes the Message Category object type and the object types that are children of this object type. It
includes the following topics:

• Message

• Message Category

• Message Locale

Message  
A message species the message that Siebel CRM displays in the client after it runs a query that the user requests.
Siebel CRM uses with this object type with a swe:messages tag of the Siebel Web Engine.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Message Category > Message

The following table describes properties that Siebel CRM uses with a message.

Property Description

Name (R)
 

Species the name of the message. For example:
 

Query Mode Prompt

Text (O)
 

Species the text of the message. For example:
 

Enter Query

Message Category  
A message category includes content for messages that Siebel CRM displays in the client, messages in the
swe:messages tag, other messages that the Siebel Web Engine uses, and error messages that you dene.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Message Category

The following table describes properties that Siebel CRM uses with a message category.

Property Description

Name (R)
 

Species the name of the message category. For example:
 

User Defined Errors

Message Locale  
A message locale denes the language overrides that Siebel CRM uses with a message.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Message Category > Message > Message Locale

The following table describes properties that Siebel CRM uses with a message locale.

Property Description

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Text (O)
 

Species the text of the message.
 

Pager Object Type  
This topic describes the Pager object type.

Pager Object  
A pager object denes properties of business components that Siebel CRM uses to populate the default data in the
Send Page applet.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Pager Object

The following table describes properties that Siebel CRM uses with a pager object.
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Property Description

Alpha Template (O)
 

Species the template that Siebel CRM uses to create default text to page an alphanumeric pager. It
can include placeholders for business components eld that Siebel CRM substitutes with real values
at run time. The value for the Alpha Template property can contain the name of any template le that
exists in the following user directory:
 

MSGTEMPL\language

 

Business Component (R)
 

Species the business component that includes the paging-related properties. You can specify any
business component that includes references to employees or elds that store data about pagers.
 

Employee Field (O)
 

Species the business component eld that contains the login name of the employee that Siebel CRM
must page. Siebel CRM locates this login name in the Employee business component that contains the
default phone number and pager ID.
 
If the Phone Field property and the PIN Field property contain values, then Siebel CRM ignores the
Employee Field property.
 

Name (S)
 

For Oracle use only. You must not modify this property.
 

Numeric Template (O)
 

Species the template that Siebel CRM uses to create the default message text it uses when it pages a
numeric pagers. It can include placeholders for business components eld that Siebel CRM substitutes
with real values at run time. The value for the Numeric Template property can contain the name of any
template le that exists in the following user directory:
 

MSGTEMPL\language
 

Phone Field (O)
 

Species the business component eld that contains the computer paging phone number that Siebel
CRM uses when it sends a page. This computer paging phone number is dierent from the personal
phone number assigned to some pagers. It is also dierent from the phone number to page a touch-
tone phone. Typically there is only one computer paging phone number available for each pager
company. This number must support the TAPI protocol that computer paging uses.
 

PIN Field (O)
 

Species the business component eld that contains the PIN (Personal Identication Number) or pager
ID of the pager that Siebel CRM must page. This number is typically a six or seven digit number that
identies a pager.
 

Pick List Object Type  
This topic describes the Pick List object type.

Pick List  
A pick list lists valid values for a control or list column. To specify source and destination elds, you use a pick map. You
do not specify source and destination elds in a pick list. For more information, see Pick Map.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Pick List

The following table describes properties that Siebel CRM uses with a pick list.

Property Description

Bounded (O)
 

If TRUE, then the user must use a value from the list of values that the drop-down list contains.
 

Business Component (R)
 

Species the name of the business component that Siebel CRM uses to populate values in the list of
values.
 

Long List (O)
 

If TRUE, then Siebel CRM aempts to position the cursor on the current value in a long list of values.
 
If the Long List property is TRUE, then the picklist returns a large set of values. To avoid aecting
performance when the user scrolls or positions the cursor on the current value in the eld, Siebel CRM
does not immediately update eld values for the current record.
 
If the picklist contains more than 500 records, then it is recommended that you set the Long List
property to TRUE.
 

Name (R)
 

Species the name of the picklist. The name must be unique among picklists. Other objects use this
name to reference this picklist. The name can contain spaces.
 

No Delete (O)
 

If TRUE, then the user cannot delete a value from this picklist.
 

No Insert (O)
 

If TRUE, then the user cannot insert a value in this picklist.
 

No Merge (O)
 

If TRUE, then the user cannot merge two existing picklist values into a single value.
 

No Update (O)
 

If TRUE, then the user cannot update a value in this picklist.
 

Search Specication (O)
 

Species the search specication that Siebel CRM uses for this picklist. This specication is addition
to the condition that the Search Specication property of the business component species. The
Business Component property of this picklist species this business component.
 

Sort Specication (O)
 

Species the sort specication that Siebel CRM uses for this picklist. This specication replaces the
condition that the Sort Specication property of the business component species. The Business
Component property of this picklist species this business component.
 

Static (O)
 

You can use one of the following values:
 

• TRUE. Use a static picklist. Get values for this picklist from a predened list of values. A static
picklist typically uses the PickList Generic or PickList Hierarchical business component.
These business components display data that an administrator enters in the List of Values
administration views. Siebel CRM displays a static picklist as a drop-down menu. For more
information, see  Siebel Developer's Reference .

• FALSE. Use a dynamic picklist. Get the values for this picklist from the business component that
the Business Component property species. Siebel CRM uses a pick applet dialog box to display a
dynamic picklist.
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Property Description

Type Field (O)
 

Species the name of a business component eld that Siebel CRM uses to get a set of records. It uses
this eld name with the Type Value property of this picklist.
 

Type Value (O)
 

Species the data value that Siebel CRM uses to get a set of records.
 

Visibility Auto All (O)
 

If TRUE, and if the user:
 

• Can access any All views, then Siebel CRM sets visibility for the picklist business component to All.

• Cannot access any All views, then the Visibility Type property determines visibility.

Visibility Type (O)
 

Species the visibility type if Siebel CRM uses values from the business component that this picklist
references. For more information, see the description for the Visibility Auto All property of this picklist.
 

Project Object Type  
This topic describes the Project object type.

Project  
A project organizes object denitions and allows you to lock objects. Every object denition in the repository except for
repositories or projects must belong to a project. If an object denition has a parent, then the child resides in the same
project as the parent. For example, a eld is a child of a business component.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Project

The following table describes properties that Siebel CRM uses with a project.

Property Description

Allow Object Locking
 

Species to allow you to lock an object, such as an applet or a business component.
 

Language Locked (S)
 

Species the language that Siebel CRM uses when it locks a record. It uses the current language that
Siebel Tools is using. For example, ENU, JPN, DEU.
 

Locked (O)
 

If TRUE, then this project is currently locked.
 

Locked By Name (O)
 

If the Locked property is TRUE, then the Locked By Name property displays the name of the person
who locked the project.
 

Locked Date (O)
 

If the Locked property is TRUE, then the Locked Date property displays the date and time when
someone locked the project.
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Property Description

Name (R)
 

Species a unique name for this project.
 

Owner Branch
 

Reserved for future use.
 

Report Object Type  
This topic describes the Report object type.

Report  
To get help from Oracle with conguring Report object types, you can create a service request (SR) on My Oracle
Support. Alternatively, you can phone Global Customer Support directly to create a service request or to get a status
update on your current SR. Support phone numbers are listed on My Oracle Support. You can also contact your Oracle
sales representative for Oracle Advanced Customer Services to request assistance from Oracle's Application Expert
Services.

The following object types are for Oracle use only:

• Report

• Report Field

• Report Locale

• Sub Report

• Sub Report Field

• View Report

• View Report Locale

Repository Object Type  
This topic describes the Repository object type.

Repository  
A repository includes tables in a database where Siebel CRM stores object denitions.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Repository
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The following table describes properties that Siebel CRM uses with a repository.

Property Description

Name (S)
 

Species the name of the repository.
 

Schema Maintenance Object Types  
This topic describes the Schema Maintenance object type and the object types that are children of this object type.

Schema Maintenance  
The following object types are for Oracle use only:

• Schema Maintenance Dependent Step

• Schema Maintenance Phase

• Schema Maintenance Phase Usage

• Schema Maintenance Platform Path

• Schema Maintenance Process

• Schema Maintenance Process Variable

• Schema Maintenance Step

• Schema Maintenance Step From

• Schema Maintenance Step Database Implementation

• Schema Maintenance Step Implementation

• Schema Maintenance Step To

Screen Object Types  
This topic describes the Screen object type and the object types that are children of this object type. It includes the
following topics:

• Screen

• Screen Locale

• Screen View

• Screen View Locale

Screen  
A screen organizes views.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Screen

The following table describes properties that Siebel CRM uses with a screen.

Property Description

Bitmap Category (O)(H)
 

Species the name of the bitmap category that contains the denitions of the bitmap objects that this
screen uses. For example, the Accounts bitmap category contains bitmap object denitions for the
following items:
 

• Logo bitmap that Siebel CRM displays at the top of the view bar in the Accounts screen.

• Screen Tab Icon bitmap that Siebel CRM displays on the tab of the Accounts screen.

The Accounts screen uses this Accounts bitmap category.
 

Default View (O)
 

Species the view that Siebel CRM displays if the user clicks a page tab for the screen. The view must
be an entry in the screen view of the current screen. For example:
 

Account List View

Help Identier (O)
 

Species a help ID for a screen that includes help. For example:
 

ID_SCREEN_ACCOUNTS

ICL Upgrade Path
 

For more information, see Common Object Properties.
 

Name (R)
 

Species the name of a screen. Other objects use this name to reference this screen. For example:
 

Accounts Screen

Unrestricted Viewbar (O)(H)
 

You can use one of the following values:
 

• TRUE. Siebel CRM displays all the views that the screen contains even if a view does not reference
the same business object that this screen references. It displays these views in the view bar.

• FALSE. Siebel CRM displays only the views that reference the same business object that this
screen references. If you require the thread bar to display these views, then do not set the
Unrestricted Viewbar property to FALSE.

Upgrade Behavior
 

For more information, see Common Object Properties.
 

Viewbar Text (O)
 

Species the label that Siebel CRM displays below the optional Logo bitmap in the view bar. For
example:
 

Accounts

Screen Locale  
A screen locale denes language overrides that Siebel CRM uses with a screen.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Screen > Screen Locale

The following table describes properties that Siebel CRM uses with a screen locale.

Property Description

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Viewbar Text (O)
 

Species the label that Siebel CRM displays below the optional Logo bitmap in the view bar.
 

Screen View  
A screen view denes the collection of views for a screen.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Screen > Screen View

The following table describes properties that Siebel CRM uses with a screen view.

Property Description

Category Default View (O)
 

Species the default view for this screen view. Siebel CRM uses the Category Default View property
only if the Type property of this screen view is Aggregate Category or Detail Category.
 
If the Category Default View does not contain a value, then Siebel CRM uses the rst available view for
the Category or the Default View that is dened for the screen.
 

Category Name (O) (R)
 

Species the name of the category that Siebel CRM uses to group similar views in this screen view.
If the Type property of this screen view is Aggregate Category or Detail Category, then the Category
Name property is required.
 

Client Restriction (O)
 

Species if Siebel CRM displays this screen view in a client. For example:
 

Mobile Client Only

Display In Page (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM displays this screen view in the client. If the Type property of this screen view is
Aggregate Category or Detail Category, then the Display In Page property must be TRUE.

• FALSE. Siebel CRM displays this screen view as hidden in the View Tab layout.

Display In Site Map (O)
 

If TRUE, then Siebel CRM displays this screen view in the Site Map in the client.
 

Menu Text (O)
 

Species the text that Siebel CRM displays in the Site Map for this screen view. For more information,
 see Seing the Menu Text and Viewbar Text Properties of a Screen View.
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Property Description

 

Object Manager Restriction (O)
 

You can use the following values:
 

• NULL. This screen view is available if the Application Object Manager runs on any server that
Siebel CRM supports.

• NT Only. This screen view is available only if the Application Object Manager runs on a Windows
server.

The UNIX Support property of the applet or business component class might not allow Siebel CRM to
display this screen view in a UNIX environment.
 

Parent Category (O) (R)
 

Species how Siebel CRM organizes a view in a category or how it associates a detail category with an
aggregate category. If the Type property of this screen view is:
 

• Detail View or Detail Category. The Parent Category property is required.

• Aggregate View. The Parent Category property is optional.

• Aggregate Category. The Parent Category property must be empty.

Sequence (O)
 

Species the order that Siebel CRM uses to display the view in the submenu of the screen view. You
can sequence the views that Siebel CRM displays on the view bar but not the categories. Siebel CRM
displays categories last in the list. This property can contain only an integer.
 

Status Text (O)
 

Not used.
 

Type (R)
 

Species the type of screen view. A screen view is one of the following:
 

• A view

• A group of views or categories

View (R)
 

Species the view that Siebel CRM includes in the screen view. For example:
 

Detail - Contacts View

Viewbar Text (O)
 

Species the text that Siebel CRM displays on a view tab, a drop-down list, or a link for a view or
category. For more information, see Seing the Menu Text and Viewbar Text Properties of a Screen
View.
 

Seing the Menu Text and Viewbar Text Properties of a Screen View  
In this example, the following screen views are of type Category Detail:

• Account Detail-A View

• Account Detail-B View

• Account Detail-C View

The following table describes an example that displays all these screen views in the Site Map and only displays screen
views A and B in the view bar.
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Screen View Type Category Menu Text Viewbar Text

Account Detail-A
 

Category Detail
 

Account Detail
 

Detail
 

Account Detail-B
 

Category Detail
 

Account Detail
 

Detail
 

Account Detail-C
 

Category Detail
 

Account Detail
 

Not applicable.
 

Screen View Locale  
A screen view locale denes language overrides that Siebel CRM uses with a screen view.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Screen > Screen View > Screen View Locale

The following table describes properties that Siebel CRM uses with a screen view locale.

Property Description

Menu Text (O)
 

Species the text that Siebel CRM displays in the Site Map for this View or Category.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Status Text (O)
 

Not used.
 

Viewbar Text (O)
 

Species the text that Siebel CRM displays on a view tab, drop down list, or link for a screen view or
category.
 

Server Component Object Types  
This topic describes the Server Component object type and the object types that are children of this object type. It
includes the following topics:

• Server Component Event Subtype

• Server Component Event Type

• Server Component Parameter

• Server Component State Value

• Server Component Statistic

• Server Component Subsystem
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• Server Component Type

Server Component Event Subtype  
A server component event subtype is a code reference that species an event.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Server Component Type > Server Component Event Type > Server Component Event Subtype

The following table describes properties that Siebel CRM uses with a server component event subtype.

Property Description

Code Symbol (S)
 

Species this server component event subtype as an enum, which is a short list of known values. This
conguration allows faster searching than using the full descriptive name.
 

Display Name (S)
 

Species the name of this server component event subtype that Siebel CRM displays in the Server
Manager.
 

Name (S)
 

Species the name of the object denition.
 

Server Component Event Type  
A server component event type species an event for a server component.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Server Component Type > Server Component Event Type

The following table describes properties that Siebel CRM uses with a server component event type.

Property Description

Code Symbol (S)
 

Species this server component event type as an enum, which is a short list of known values. This
conguration allows faster searching than using the full descriptive name.
 

Display Name (S)
 

Species the name of this server component event type that Siebel CRM displays in the Server
Manager.
 

Name (S) Species the name of the object denition.
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Property Description

   

Server Component Parameter  
A server component parameter species parameters in a server component type.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Server Component Type > Server Component Parameter

The following table describes properties that Siebel CRM uses with a server component parameter.

Property Description

Code Symbol (S)
 

Species this server component parameter type as an enum, which is a short list of known values. This
conguration allows faster searching than using the full descriptive name.
 

Component Denition Seable (S)
 

For more information, see the description for the Enterprise Seable property.
 

Component Seable (S)
 

For more information, see the description for the Enterprise Seable property.
 

Data Type (S)
 

Species the data type for the values this server component parameter contains.
 

Default Value (S)
 

Specify a default value for this server component parameter.
 

Display Name (S)
 

Species the name of this server component parameter event type that Siebel CRM displays in the
Server Manager.
 

Enterprise Seable (S)
 

If TRUE, then Siebel CRM sets this server component parameter for the entire enterprise. The seable
ags specify the levels at which Siebel CRM sets this parameter, from enterprise down through a server
task. For example, if the value for a server component parameter is set at level A, then all levels below
level A use this value.
 

Name (S)
 

Species the name of the object denition.
 

Performance Impact
 

Not used.
 

Pick List (S)
 

Species the name of the picklist.
 

Requires Component Recong (S)
 

If TRUE, then Siebel CRM can modify the conguration for a server component. This modication
aects server tasks that start after a modication occurs but allows existing server tasks to continue
running using the old conguration.
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Property Description

 
A new server task automatically uses the new conguration but these modications might not
aect some arguments until Siebel CRM recongures the server component. Seing the Requires
Component Recong property to TRUE allows Siebel CRM to update these arguments.
 

Requires Server Recong
 

Similar to the Requires Component Recong property except applies to the server.
 

Server Seable (S)
 

For more information, see the description for the Enterprise Seable property.
 

Task Seable (S)
 

For more information, see the description for the Enterprise Seable property.
 

Text Length (S)
 

Species the maximum text length in characters.
 

Visibility
 

Not used.
 

Server Component State Value  
A server component state value contains data about the current operation of a server task or server component.
A server task periodically updates state values that describe current processing, such as the current phase of an
operation. The state for a server component describes the state of the entire server component.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Server Component Type > Server Component State Value

The following table describes properties that Siebel CRM uses with a server component state value.

Property Description

Code Symbol (S)
 

Species this server component state value as an enum, which is a short list of known values. This
conguration allows faster searching than using the full descriptive name.
 

Data Type (S)
 

Species the data type of the values that this server component state value contains.
 

Display Name (S)
 

Species the name of the component state value type that Siebel CRM displays in the Server Manager.
 

Level (S)
 

Species the level that Siebel CRM uses for this server component state value.
 

Name (S)
 

Species the name of this server component state value.
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Property Description

Text Length (S)
 

Species the maximum text length in characters.
 

Visibility
 

Not used.
 

Server Component Statistic  
A server component statistic records statistics at the server task level for server component tasks. You can use these
statistics to monitor the progress and performance of a server component or to optimize system performance.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Server Component Type > Server Component Statistic

The following table describes properties that Siebel CRM uses with a server component statistic.

Property Description

Calculated (S)
 

If TRUE, then Siebel CRM calculates this server component statistic.
 

Calculated Value (S)
 

Species the script for the calculation.
 

Code Symbol (S)
 

Species this server component statistic as an enum, which is a short list of known values. This
conguration allows faster searching than using the full descriptive name.
 

Data Type (S)
 

Species the data type of the value that Siebel CRM saves for this server component statistic.
 

Display Name (S)
 

Species the name of the server component statistic that Siebel CRM displays in the Server Manager.
 

Name (S)
 

Species the name of this server component statistic.
 

Visibility
 

Not used.
 

Server Component Subsystem  
A server component subsystem denes a subsystem of the server component type object.

185



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Server Component Type > Server Component Subsystem

The following table describes properties that Siebel CRM uses with a server component subsystem.

Property Description

Name (S)
 

Species the name of this server component subsystem.
 

Subsystem (S)
 

Species the name of the subsystem.
 

Server Component Type  
A server component type supports multiple server component types. Each of these types performs a function or job.

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Server Component Type

The following table describes properties that Siebel CRM uses with a server component type.

Property Description

Background Mode
 

If TRUE, then a server component that uses this server component type can run in the background.
 

Batch Mode
 

If TRUE, then a server component that uses this server component type can run in batch.
 

Code Symbol (S)
 

Species this server component type as an enum, which is a short list of known values. This
conguration allows faster searching than using the full descriptive name.
 

Debug Only
 

If TRUE, then a server component that uses this server component type can run only in debug mode.
 

Display Name (S)
 

Species the name of this server component type that Siebel CRM displays in the Server Manager.
 

Interactive
 

If TRUE, then a server component that uses this server component type can interactive.
 

Key Based Routing (S)
 

If TRUE, then some batch mode components can control how Siebel CRM partitions and routes a
request. These batch mode components can register a key or a set of keys so that each key only gets
the requests that match the key.
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Property Description

 

Name (S)
 

Species the name of the object denition.
 

String Object Types  
This topic describes the String object type and the object types that are children of this object type. It includes the
following topics:

• String (H)

• String Map (H)

String (H)  
A string is for Oracle use only.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > String Map (H) > String

String Map (H)  
A string map is for Oracle use only.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > String Map

Symbolic String Object Types  
This topic describes the Symbolic String object type and the object types that are children of this object type. It includes
the following topics:

• Symbolic String (H)

• Symbolic String Locale

Symbolic String (H)  
A symbolic string includes text that Siebel CRM displays in the client. Many objects include a translatable string property,
such as the caption of a Control object. To get a string value, the string reference property of this object can reference
a symbolic string. For example, the Caption - String Reference property can reference a symbolic string. To support
separate languages, Siebel CRM can save the contents of a symbolic string in one or more child symbolic string locale
objects. For example, the SBL_ACCOUNTS-0910145428-0HN symbolic string might include two symbolic string locale
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children, where one child contains a display value for English, such as Account, and another child contains a display
value for German, such as Kunde.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Symbolic String

The following table describes properties that Siebel CRM uses with a symbolic string.

Property Description

Approval Flag (O)
 

For Oracle use only.
 

Current String Value
 

Species the text that Siebel CRM displays in the client. Siebel Tools automatically determines this
value. It uses the value that the String Value property of the child symbolic string locale contains. It
uses the symbolic string locale for the language that is currently active in Siebel Tools. For example, if
the Siebel Tools language mode is German, then Siebel Tools displays the following value in the Current
String Value property for the SBL_ACCOUNTS-0910145428-0HN symbolic string:
 

Kunde

If you modify the Siebel Tools language mode to English, then it displays the following value in the
Current String Value property:
 

Accounts

Although Siebel Tools calculates the value that it displays in this property, you can edit this value. If you
edit the value in the Current String Value property, then Siebel Tools modies the value that the String
Value property contains. This is a property of the child symbolic string locale for the language mode
that is currently active in Siebel Tools.
 

Denition (O)
 

Species the text of this symbolic string.
 

Glossary Flag (O)
 

For Oracle use only.
 

Name (R)
 

Species the name of this symbolic string. It must be unique among symbolic strings. Other objects
use this name to reference this symbolic string. The name of each predened symbolic string begins
with the SBL_ prex and contains an uppercase version of the ENU string value for this symbolic string.
For example, the following name is the ENU value for the Accounts symbolic string:
 

SBL_ACCOUNTS-0910145428-0HN

Type (O)
 

Species the type of symbolic string. Siebel CRM converts each predened symbolic string. It sets the
Type property for each of these symbolic strings to Conversion. This Type property can include one of
the following values:
 

• Conversion

• Private

Symbolic String Locale  
A symbolic string locale denes the language display values for a symbolic string.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Symbolic String (H) > Symbolic String Locale

The following table describes properties that Siebel CRM uses with a symbolic string locale.

Property Description

String Value (R)
 

Species the text string that Siebel CRM displays in the client for a language. For example:
 

Kunde

Symbolic String Name
 

Species the symbolic string that Siebel CRM uses to associate the string values that the symbolic
string locale contains with the parent symbolic string. The Symbolic String Name property can contain
the name of any existing symbolic string. For example:
 

SBL_#_OF_CONCURRENT_LICENSES-1004225906-00M

System Activity Object Object Types  
This topic describes the System Activity Object object type.

System Activity Object  
A system activity object denes the properties of a business component that Siebel CRM uses to create activities that
some commands require, such as the Send Mail or Send Page command.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > System Activity Object

The following table describes properties that Siebel CRM uses with a system activity object.

Property Description

Account Id Field (O)
 

Species the eld that contains the row ID of the account that Siebel CRM must associate with the
activity.
 

Business Component (R)
 

Species the business component that includes data that Siebel CRM requires to create an activity. For
example, assume the Service Request business component includes a system activity object. To create
an activity that sends a communication, Siebel CRM can use data in the service request, such as the
account Id.
 

Contact Id Field (O)
 

Species the eld that contains the row ID of the contact that Siebel CRM must associate with the
activity.
 

Defect Id Field (O)
 

Species the eld that contains a defect row ID value that Siebel CRM can use to populate the Activity
Defect Id eld of the new activity.
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Property Description

Opportunity Id Field (O)
 

Species the eld that contains the row ID of the opportunity that Siebel CRM must associate with the
activity.
 

Service Request Id Field (O)
 

Species the eld that contains the row ID of the service request that Siebel CRM must associate with
the activity.
 

Source Id Field (O)
 

Species the eld that contains a campaign row ID value that Siebel CRM can use to populate the
Campaign Id eld of the activity.
 

Table Object Types  
This topic describes the Table object type and the object types that are children of this object type. It includes the
following topics:

• Column

• Data Source (H)

• Index

• Index Column

• Table

• User Key

• User Key Aribute

• User Key Aribute Join

• User Key Aribute Tree Node

• User Key Column

Column  
A column corresponds to one column in a database table.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table > Column

The following table describes properties that Siebel CRM uses with a column.

Property Description

Alias (O)
 

Not used.
 

ASCII Only (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM uses only ASCII text in columns.
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Property Description

• FALSE. Siebel CRM does not use only ASCII text in columns.

Cascade Clear (O)
 

For Oracle use only.
 

Computation Expression (O)
 

Species a computation that Siebel CRM uses on a eld if it saves this eld to the Siebel database.
 
For example, to encrypt a value while Siebel CRM writes it to the Siebel database, you can use the
following value in the Computation Expression property:
 

SiebelEncrypt.RC2([column_name])

where:
 

• column_name identies the column that Siebel CRM must encrypt.

For example:
 

SiebelEncrypt.RC2([PAY_ACCNT_NUM])

You can use this property for Case-insensitive and Accent-Insensitive (CIAI) search functionality. For
example:
 

CIAI([column_name])

where:
 

• column_name identies a column that contains all uppercase, nonaccented characters. You can
then use this value in an index that allows Siebel CRM to search without respect to case or accent.

For example:
 

Account Name ([S_ORG_EXT.NAME])

where:
 

• NAME might reference a column that includes a value of La Française. Because this expression
is dicult search, CIAI uses the CIAI([NAME]) computation expression to save this value. If
Siebel CRM saves an account, then it updates the value in the column as LA FRANCAISE.

If you search for a string that is similar to la franca*, LA F*, then the Application Object Manager
uses this column to nd a match. It is not necessary for you to consider case or accent.
 

Default (O)
 

For Oracle use only.
 

Default Insensitivity (O)
 

Species to use a normal search or translate to CIAI mode. To view the values you can use, click the
Default Insensitivity property in Siebel Tools.
 

Denormalization Path (O)
 

For Oracle use only.
 

EIM Processing Column Flag (O)
 

For Oracle use only.
 

Encryption Key Specier
 

Species where to save the encryption key for an encrypted eld. This eld is only required for a
SiebelEncrypt computation expression. For more information, see the Computation Expression
property for this object type.
 

FK Column 1:M Rel Name (O)
 

For Oracle use only.
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Property Description

FK Column M:1 Rel Name (O)
 

For Oracle use only.
 

Force Case (O)
 

Species the case of the leers that the column can contain, such as Lower. To view the values you can
use, click the Force Case property in Siebel Tools.
 

Foreign Key Table (Foreign Key Table
Name) (O)
 

Species the table to which this column is a foreign key. EIM uses this value. You must leave this
property empty in an extension column.
 

Inactive
 

Species to make the column active or inactive. If TRUE, then Siebel CRM does not create this column
when it installs the server database.
 

LOV Bounded (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM must populate any eld that references this column with a value from the list
that the LOV Type property identies. It must rst import LOV data into the S_LST_OF_VAL table
and you must specify the LOV Type property. EIM can then examine the values it imports from
the list that the LOV Type property identies.

• FALSE. There is no restriction on the values that Siebel CRM populates in a eld that references
this column.

The LOV Bounded property is read-only for a column that comes predened with Siebel CRM. It is
editable for a column that you add through the Database Extension Designer.
 

LOV Type (O)
 

Species the list of values that Siebel CRM uses to validate this column. To dene this list of values, you
use the List Of Values administration views in the client.
 
The LOV Type property is read-only for a column that comes predened with Siebel CRM. It is editable
for a column that you add through the Database Extension Designer.
 
For more information, see the description for the LOV Bounded property.
 

Name (R)
 

Species the name for this column. This name must be unique in the table.
 

No Match Value (O)
 

Species the string that Siebel CRM uses if it cannot match the primary Id eld. You can congure this
property only for the primary key column of a table that an external business component references,
and only if this business component creates RowId values that might conict with the default No Match
Row Id string.
 
If the No Match Value property is empty, then Siebel CRM uses No Match Row Id as the default string.
 

Nullable (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM can save NULL in this column in the Siebel database.

• FALSE. Siebel CRM cannot save NULL in this column in the Siebel database.

Physical Type Name (Physical Type) (R)
 

Species the data type of the column in the Siebel database. You can use one of the following values:
 

• Character. Fixed-length text.

• Date. Date values only without time.

• Date Time. Date and time values in the same column.
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Property Description

• Long. Long text.

• Number. Any numeric data.

• Time. Time values only without the date.

• UTC Date Time. Time in Greenwich Mean Time (GMT).

• Varchar. Variable-length text.

Precision (R)
 

For more information, see About the Precision and Scale Properties.
 

Primary Child Col (S)
 

EIM uses this property. For Oracle use only.
 

Primary Child Column Name (O)
 

Species the name of the column that contains the primary ID value.
 

Primary Child Join Column Name (O)
 

Species the name of the child table column where Siebel CRM joins the record.
 

Primary Child Table Name (O)
 

Species the name of the table where Siebel CRM can locate the primary child.
 

Primary Inter Table Name (Primary Inter
Table) (O)
 

EIM uses this property. For Oracle use only.
 

Primary Join Column Name (O)
 

Species the name of the column that Siebel CRM uses to join the record.
 

Primary Key (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM uses this column as part of the primary key of the table.

• FALSE. Siebel CRM does not use this column as part of the primary key of the table.

Required (O)
 

You can use one of the following values:
 

• TRUE. Siebel CRM requires a value in this column. This requirement is true even if the Siebel
database allows an empty value in this column.

• FALSE. Siebel CRM does not require a value in this column.

Scale (O)
 

For more information, see About the Precision and Scale Properties.
 

Sequence (O)
 

Species the order that Siebel CRM uses to save the columns of a cluster index. This property can
contain only an integer. This property applies primarily with the MSSQL server. You can use it with
other servers.
 

Sequence Object (O)
 

Species the name of the RDBMS utility that creates a unique sequence number for the table column.
For Oracle use only.
 

Status
 

Species the state of the column, such as Active. To view the values you can use, click the Status
property in Siebel Tools.
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Property Description

System Field Mapping (O)
 

Species an alternative way to map the column to a system eld. You can congure this property only
for a table that an external business component uses. To view the values you can use, click the System
Field Mapping property in Siebel Tools.
 

Text Length (O)
 

Species the length in characters for a text or varchar column. The column size in Siebel Tools is not
the same as the column size in the physical database. For more information about this dierence, see
531960.1 (Article ID) on My Oracle Support.
 

Translation Table Name (O)
 

Species the name of the translation table.
 

Txn Log Code (O)
 

Not used.
 

Type (S)
 

Species the column type.
 

Use FKey (S)
 

You can use one of the following values:
 

• TRUE. To determine visibility, Siebel CRM uses this column as a foreign key during
synchronization.

• FALSE. Siebel CRM does not use this column as a foreign key. You must leave this column at the
default FALSE seing for an extension column.

User Key Sequence (O)
 

Species the sequence that Siebel CRM uses to place this column in the user key. For example, if you
set the User Key Sequence property for Column A to 1, then Siebel CRM places Column A in the rst
position in the user key.
 

User Name (R)
 

Species the user-friendly name for the column.
 

Valid Condition (O)
 

Species the expression that Siebel CRM uses to validate a column value.
 

Properties for Custom Extension Columns  
If you congure a custom extension column, then you must set only the following properties:

• Comments

• Default

• Foreign Key Table Name

• Inactive

• LOV Bounded

• LOV Type

• Name

• Nullable

• Physical Type

• Precision

• Scale
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• Text Length

Data Source (H)  
A data source species the data source that the Application Object Manager uses to connect to an external table. You
dene this object only for a table that does not reside in the Siebel database.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table > Data Source

The following table describes properties that Siebel CRM uses with a data source.

Property Description

Name (R)
 

Species the name of the data source. This name must match one of the following items:
 

• The value that the DataSources section species in the application conguration le

• The Alias name of an InfraDatasources server component type

Index  
An index creates a new index to improve performance of queries.

CAUTION:  If you create a new index, then use caution. An index can decrease performance and use
signicant disk space.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table > Index

The following table describes properties that Siebel CRM uses with an index.

Property Description

Alias (O)
 

Species the short name for the index.
 

Allow Reverse Scan (O)
 

If TRUE, then Siebel CRM creates the index with a backward page reference and a forward page
reference. This conguration allows Siebel CRM to read the index backwards. The Allow Reverse Scan
property applies only to a DB2 or a UDB database.
 

Based on Index
 

Species a replacement index. For example, assume the following occurs:
 

1. A NAME index exists on the S_ORG_EXT table.
2. A LOC index exists on the S_ORG_EXT_Un table.
3. You enable CIAI (Case-Insensitive and Accent-insensitive).
4. Siebel CRM creates new columns named NAME_CIAI and LOC_CIAI.
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Property Description

5. You create an index named S_ORG_EXT_Un_C1 and set the Based on Index property of this index
to S_ORG_EXT_Un.

6. In this situation, the Application Object Manager uses S_ORG_EXT_Un_C1 instead of S_ORG_EXT_
Un.

Cluster (O)
 

If TRUE, then Siebel CRM clusters the table on this index. For example, it physically saves the rows
in the order that the index columns specify. The Cluster property applies only to a DB2 or a UDB
database.
 

Cluster 2 (O)
 

If TRUE, then Siebel CRM appends this cluster key to all other indexes. The Cluster 2 property applies to
the MSSQL server. It is applicable only to unique indexes.
 

Name (R)
 

Species the unique name.
 

Number of Unique Columns (S)
 

If Siebel CRM populates this property, then the value it populates equals the number of columns that
participate in the uniqueness constraint.
 
Siebel CRM sets the Include Only property to TRUE for the columns that do not participate in the
uniqueness constraint. In this situation, the number of columns in the index is more than the value that
the Number of Unique Columns property contains.
 
The Number of Unique Columns property applies only to a DB2 or a UDB database. It is applicable only
to unique indexes.
 

Partition Indicator
 

Species the partition that Siebel CRM uses with some databases to indicate where to place the index.
 

Target Platform
 

Species the platform that Siebel CRM uses with some databases to indicate the platform.
 

Type (O)
 

Species the index type.
 

Unique (O)
 

If TRUE, then this index is unique. A unique index prevents multiple rows that include the same values
in each of the index columns.
 

User Name (R)
 

Species the user-friendly name for the index.
 

User Primary Key (O)
 

If TRUE, then EIM enforces uniqueness on this index. Siebel Enterprise Integration Manager (EIM) uses
this property.
 

Index Column  
An index column creates a new index column.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table > Index > Index Column

The following table describes properties that Siebel CRM uses with an index column.
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Property Description

Column Name (R)
 

Species the name of the column in the index.
 

Name (R)
 

Species the name of the index column.
 

Sequence (R)
 

Species the position of the index column in the index.
 

Sort Order (O)
 

Species how Siebel CRM sorts the values in the index column. Starting with Siebel CRM version 8.1,
 to populate the repository, Siebel CRM sets the Sort Order property to Asc as the default value. If the
index column is a Date type, then it sets the Sort Order property to Desc.
 

Table  
A table creates a new table to save additional aributes.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table

The following table describes properties that Siebel CRM uses with a table.

Property Description

Abbreviation 1 (O)
 
Abbreviation 2 (O)
 
Abbreviation 3 (O)
 
Abbreviation 4 (O)
 
Abbreviation 5 (O)
 
Abbreviation 6 (O)
 

Species an alternative abbreviation for the table. You must not modify the abbreviations that the EIM
Generator and wizard use to determine how to name interface table columns in foreign key mappings.
 

Alias (O)
 

Not used.
 

Append Data (O)
 

If TRUE, then Siebel CRM inserts any new rows it creates at the end of the table. If a clustered index
exists on this table, and if the Append Data property is TRUE, then Siebel CRM cannot access any new
rows that it appends to this table.
 

Base Table Name (R)
 

Species the name of the base table. If the Type property of this table is Ext or Journal, then Siebel
CRM extends or journals the table that the Base Table Name property species.
 

Dt Mapping Col Name Prex (S)
 

Species the default prex that Siebel CRM uses. If Siebel CRM creates an interface table column, then
it adds this prex to the name of this column.
 
For Oracle use only.
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Property Description

External API Write
 

If TRUE, then the following applies:
 

• An external API handles any insert, update, or delete in any external table.

• The BusComp_PreWriteRecord must include a script that publishes the insert, update, or delete to
this external API.

File (O)
 

If TRUE, then Siebel CRM uses this table to save le aachment data.
 

Group (O)
 

Species to group tables. Siebel CRM uses this property only for an IBM System 390. It places tables
in groups that correspond to dock objects. It groups these tables according to table size, access
frequency, and so on.
 

Key Generation Business Service
 

Species the business service that Siebel CRM uses to create the primary key for the business
component. If this property is empty, then Siebel CRM uses the default row Id generator for tables that
include a column that corresponds to the Id system eld.
 

Key Generation Service Method
 

Species the name of the business service method that Siebel CRM calls when it creates the primary
key for the business component.
 

Name (R)
 

Species a unique name for this table.
 

Node Type
 

Species the client type that can use this table. For example, if you set this property to Mobile Only,
 then Siebel CRM includes this table in the Remote client database but not on the Siebel Server.
 

Owner Organization Specier
 

Not used.
 

Parent Table Column1 Name (O)
 

Species the column that references the primary parent if this table is a child table or intersection table.
 

Parent Table Column2 Name (O)
 

Species the column that references the second parent if this table is an intersection table.
 

Status (O)
 

Species the current status of this table. It can include one of the following values:
 

• ACTIVE. Use this table in the current version of Siebel CRM.

• INACTIVE. Discontinue and do not support this table in the current version of Siebel CRM. You
must move any extension column that resides on an inactive table to another table. For example,
 you must the S_EMPLOYEE table to one of the following tables:

◦ S_CONTACT

◦ S_USER

◦ S_EMP_PER

• EOL (End of life). Do not use this table in the current version of Siebel CRM. You must delete this
table because Siebel CRM no longer uses it. For example, Siebel CRM no longer uses the S_*_IF
tables.

• NOT USED. Use this table in the current version of Siebel CRM. Siebel CRM objects do not use this
table in the current version but you can continue to use it. For example, you can use tables for
docking or EIM.
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Property Description

Type (S)
 

Species the type for this table.
 

User Name (R)
 

Species the name for this table.
 

Volatile (O)
 

If TRUE, then Siebel CRM does not use the statistics that the runstats utility creates on the Siebel
database for this table.
 

User Key  
A user key species a set of aribute columns and other information that species how Siebel Enterprise Integration
Manager (EIM) accesses table rows. For more information, see  Conguring Siebel Business Applications .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table > User Key

The following table describes properties that Siebel CRM uses with a user key.

Property Description

Inaccessible (S)
 

If TRUE, then EIM can access the user key.
 

Index Name (S)
 

Species the name of the index.
 

Name (S)
 

Species the name of the user key.
 

Source Interface Table Name (S)
 

Species the name of the source interface table for the user key.
 

User Key Type (S)
 

Species the type of user key of the object denition.
 

User Key Aribute  
A user key aribute species one user key aribute in the set of aribute columns that identify rows in the grandparent
table. Siebel Enterprise Integration Manager (EIM) uses this object type. For more information, see  Conguring Siebel
Business Applications .
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CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table > User Key > User Key Aribute

The following table describes properties that Siebel CRM uses with a user key aribute.

Property Description

Aribute Sequence (S)
 

Species the position of the aribute column in user key.
 

Name (S)
 

Species the name of the aribute column.
 

User Key Aribute Join  
A user key aribute join species a join operation that Siebel CRM uses to convert a user key aribute that is a foreign
key to another table into aribute column values in this table. Siebel Enterprise Integration Manager (EIM) uses this
object type. For more information, see  Conguring Siebel Business Applications .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table > User Key > User Key Aribute > User Key Aribute Join

The following table describes properties that Siebel CRM uses with a user key aribute join.

Property Description

Join Column Name (S)
 

Species the name of the column that Siebel CRM uses for the join.
 

Join Sequence (S)
 

Species the order that Siebel CRM uses to process the join. This property can contain only an integer.
 

Join Type (S)
 

Species the type of join that Siebel CRM uses.
 

Name (S)
 

Species the name of the columns that Siebel CRM uses in the join.
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User Key Aribute Tree Node  
A user key aribute tree node species the tree node for a user key aribute. Siebel Enterprise Integration Manager
(EIM) uses this object type. For more information, see  Conguring Siebel Business Applications .

CAUTION:  You must not modify this object type. Any modications can adversely aect performance.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table > User Key > User Key Aribute Tree Node

The following table describes properties that Siebel CRM uses with a user key aribute tree node.

Property Description

Join Column Name (S)
 

Species the name of the join column.
 

Join Sequence (S)
 

Species the order that Siebel CRM uses to process the join. This property can contain only an integer.
 

Name (S)
 

Species the name of the user key.
 

Previous Tree Node Name (S)
 

Species the name of the previous tree node.
 

Sub Node Table Name (S)
 

Species the name of the subnode table.
 

User Key Aribute Name (S)
 

Species the name of the user key aribute.
 

User Key Column  
A user key column species a column for the user key. Siebel Enterprise Integration Manager (EIM) uses this object type.
For more information, see  Conguring Siebel Business Applications .

CAUTION:  You must not modify this object type. Any modication you make might adversely aect Siebel
CRM.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Table > User Key > User Key Column

The following table describes properties that Siebel CRM uses with a user key column.
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Property Description

Column Name (S)
 

Species the name of the column from the user key index.
 

Column Sequence (S)
 

Species the order that Siebel CRM uses to process the join. This property can contain only an integer.
 

Name (S)
 

Species the name of the column from the user key index.
 

Task Object Types  
This topic describes the Task object type and the object types that are children of this object type. It includes the
following topics:

• Task

• Task Branch

• Task Branch Criteria

• Task Branch Criteria Value

• Task Chapter

• Task Chapter Locale

• Task Event

• Task Event IO Argument

• Task Locale

• Task Metric

• Task Property

• Task Step

• Task Step Context

• Task Step IO Argument

• Task Step Locale

Task  
A task denes a user interface that guides the user through task UI completion. A task UI can include one or more task
UI steps, such as a start step, subtask, decision point, or business service step.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task

The following table describes properties that Siebel CRM uses with a task.

Property Description

Allow Pause (R) You can use one of the following values:
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Property Description

   
TRUE. The user can pause this task.
 
FALSE. The user cannot pause this task.
 

Business Object (R)
 

Species the name of a business object. To choose this value, you use a drop-down list in Siebel Tools.
This list only includes business objects that include a primary business component.
 

Display Name (R)
 

Species the name that Siebel CRM displays in the task pane unless the Display Name - String Override
property of the task group includes a value. The Display Name - String Reference property determines
the value for the Display Name property. For more information about the String Reference property,
see Common Object Properties.
 

Inbox Disposition (R)
 

You can use one of the following values:
 

• Save A Record. Keep the inbox item that Siebel CRM creates for this task after this task nishes.

• Discard Record. Delete this inbox item after this task nishes.

• Do Not Care (Fastest). Create an inbox item after this task nishes only if the user has never
paused this task. This option minimizes the number of database operations that Siebel CRM must
perform to maintain the task UI inbox items.

Is Subtask (R)
 

Species if this task is a main task or a subtask. You can uses one of the following values:
 

• TRUE. This task is a subtask.

• FALSE. This task is a main task.

Name (S)
 

Species the name of this task. To set the value for this property, Siebel CRM uses the value that the
Task Name property contains.
 

On Conict (R)
 

Species how to resolve a conict that occurs while Siebel CRM writes data to the Siebel database. You
can uses one of the following values:
 

• Cancel Operation. Cancel the write operation and return the error.

• Continue Operation. Use the resolution conguration to resolve the conict and then continue the
write operation.

For information about resolving conicts, see  Siebel Business Process Framework: Task UI Guide .
 

Status (S)
 

Species the current status of this task. You can uses one of the following values:
 

• In Progress. Editing in progress.

• Completed. Editing completed and ready for activation.

• Not In Use. Not in use and can be deleted.

Task Name (R)
 

Species the internal name of this task that the task UI controller uses to identify this task.
 

Transactional (R)
 

Flag that indicates if this task is transactional. You can uses one of the following values:
 

• TRUE. This task is transactional.

• FALSE. This task is not transactional.
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Property Description

Transient BC (O)
 

Species the name of the transient business component associated with this task.
 

Version (S)
 

Species the version number of this task. This property is read-only. The default version is 0.
 

Task Branch  
A task branch connects two task steps. It controls the ow of a task UI.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Branch

The following table describes properties that Siebel CRM uses with a task branch.

Property Description

Label (O)
 

Species the text that Siebel CRM displays on this task branch in the Task Designer.
 

Name (R)
 

Species the name of this task branch.
 

Parent Name (S)
 

Species the name of the task step that contains this task branch.
 

Type (R)
 

Species the type of this task branch. You can use one of the following values:
 

• Condition. Use a condition for this task branch.

• Default. If no other conditions are met, then use this task branch. Siebel CRM ignores any
conditions that are dened for this task branch.

• Connector. Do not use any condition branching.

• Error Exception. Use exception handling. This connector type captures system errors. For
example, the Assignment Manager server component is not available.

• User Dened Exception. Use exception handling. This connector type captures errors that you
dene. For example, the user aempts to save an incomplete order.

Task Branch Criteria  
A task branch criteria species a list of conditions. At runtime, the task UI controller evaluates the task branch criteria. If
the outcome of this evaluation for a task branch is true, then the task UI uses the path that the task branch denes.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Branch > Task Branch Criteria

The following table describes properties that Siebel CRM uses with a task branch criteria.
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Property Description

Applet Field Name
 

Species the name of a control in an applet. If the Compare To property is Applet, then:
 

• The Applet Field Name property is required.

• The Field drop-down list in the Compose Condition Criteria dialog box displays the controls that
the applet contains.

Applet Name
 

Species the name of an applet. If the Compare To property is Applet, then the Object drop-down list in
the Compose Condition Criteria dialog box displays the applets you can choose.
 

Business Component
 

Species the name of a business component. The business object that this task references includes
this business component as a business object component.
 
If the Compare To property is Business Component, then the Object drop-down list in the Compose
Condition Criteria dialog box displays the business components that this business object references.
 

Business Component Field
 

Species the name of a business component eld. If the Compare To property is Business Component,
 then:
 

• The Business Component Field property is required.

• The Field drop-down list in the Compose Condition Criteria dialog box displays the elds that this
business component contains.

Compare To (R)
 

Species the object type that Siebel CRM uses to compare values.
 

Name (S)
 

Species the name of this task branch criteria.
 

Operation (R)
 

Species the comparison operation. For more information, see the topic about creating expressions in 
Siebel Business Process Framework: Workow Guide .
 

Parent Name (S)
 

Species the name of the parent task branch.
 

Preferred Sequence
 

Species the order that Siebel CRM uses to examine task branch criteria. For example, assume a task
includes branch A and branch B, and that the conditions for Branch A will handle most situations. To
reduce the amount of processing Siebel CRM must perform, you can specify to examine task branch
criteria for branch A rst. If task branch criteria for branch A is met, then Siebel CRM does not examine
task branch criteria for branch B.
 

Property Name (R)
 

Species the task property that Siebel CRM uses to determine the condition. The drop-down list
displays the properties of the task.
 

Task Branch Criteria Value  
A task branch criteria value is for Oracle use only.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Branch > Task Branch Criteria > Task Branch Criteria Value
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Task Chapter  
A task chapter groups task steps. When a task step runs, Siebel CRM displays the task step name and the chapter name
in the Current Task Pane.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Chapter

The following table describes properties that Siebel CRM uses with a task chapter.

Property Description

Color (R)
 

Species the color that Siebel CRM uses to display the task steps for a task chapter in the Task Designer
if the Show Chapter mode is enabled. You can set this color only in the Multi Value Property Window of
the parent task object.
 

Display Name (O)
 

Species a label for this task chapter that Siebel CRM displays in the Current Task pane. If the Display
Name property is empty, then Siebel CRM does not display this task chapter.
 

Name (R)
 

Species the name of this task chapter. It must be unique in a task.
 

Parent Name (S)
 

Species the name of the task that contains this chapter.
 

Sequence (R)
 

Species the order that Siebel CRM uses to display this task chapter in the current task pane with
respect to other task chapters that the parent task contains. This property can contain only an integer.
 

Task Chapter Locale  
A task chapter locale denes language overrides that Siebel CRM uses with the task chapter.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Chapter > Task Chapter Locale

The following table describes properties that Siebel CRM uses with a task chapter locale.

Property Description

Display Name (O)
 

Species the name that Siebel CRM displays for a task chapter for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU
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Task Event  
A task event denes the action that Siebel CRM performs if a task event occurs, such as Cancel, Delete, Pause, or
Resume.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Event

The following table describes properties that Siebel CRM uses with a task event.

Property Description

Business Service Method
 

Species the name of the business service method that Siebel CRM calls. If the Business Service Name
property contains a value, then the Business Service Method property is required.
 
The drop-down list for this property displays the business service method that the business service
contains.
 

Business Service Name
 

Species the name of the business service that Siebel CRM calls. If the Workow Process property is
empty, then the Business Service Name property is required.
 
The drop-down list for this property displays the business services that include a Hidden property that
is FALSE.
 

Name (R)
 

Species the name of this task event.
 

Parent Name (S)
 

Species the name of the parent task.
 

Workow Process
 

Species the name of the workow process that Siebel CRM calls. If the Business Service Name
property is empty, then the Workow Process property is required.
 

Task Event IO Argument  
A task event IO argument denes the input arguments and output arguments for an event handler.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Event > Task Event IO Argument

The following table describes properties that Siebel CRM uses with a task event IO argument.

Property Description

Argument (O)
 

Species the name of the output argument of the workow process or business service that the event
handler calls. If you set the Input/Output property of this task event IO argument to:
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Property Description

• Input. You must set the Argument property to the name of an input argument of the event
handler. The parent Task Event determines the values you can set.

• Output. You must set the Argument property to the name of an output argument of the event
handler. The parent Task Event determines the values you can set.

Business Component
 

Species the name of a business component that the business object references. The task references
this business object. If the Type property is Business Component, then the Business Component
property is required.
 

Business Component Field
 

Species the name of a business component eld. If the Type property is Business Component, then
the Business Component Field property is required. The dropdown list for this property displays the
elds that the business component contains.
 

Input/Output (R)
 

Species if the argument is an input argument or an output argument.
 

Name (S)
 

Species the name of this task event IO argument. The value you specify depends on one of the
following types of arguments:
 

• Input argument. You specify the input argument name of the business service method.

• Output argument. You leave this Name property empty.

If you choose a workow process as the event handler, then the value of this Name property must be
RowId or ProcessName.
 

Parent Name (S)
 

Species the name of the parent task event.
 

Preferred Sequence (O)
 

Not used. Siebel CRM ignores this property.
 

Property Name
 

Species the name of the task property that this task event IO argument references. If the Type
property is Task Property, then the Property Name property required.
 
The drop-down list for this property includes the task properties that the parent task contains.
 

Type (R)
 

Species the type of the argument. It can contain one of the following values:
 

• Business Component

• Literal

• Expression

• Task Property

Value (O)
 

Species a value for this task event IO argument. If the Type property is Literal or Expression, then the
Value property contains a literal value or an expression.
 

Task Locale  
A task locale denes language overrides that Siebel CRM uses with a task.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Locale

The following table describes properties that Siebel CRM uses with a task locale.

Property Description

Display Name (O)
 

Species the name that Siebel CRM displays for a task for a language.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Task Metric  
A task metric denes metrics that Siebel CRM collects while a task runs.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Metric

The following table describes properties that Siebel CRM uses with a task metric.

Property Description

Metric Name (R)
 

Species the name of the metric. The dropdown list for this property displays a list of predened
metrics.
 

Name (R)
 

Species the name of the object. Siebel CRM automatically sets the value of the Name property to the
value that the Metric Name property contains.
 

Parent Name
 

Species the name of the parent object. This property is read-only.
 

Property Name (R)
 

Species the name of a task property. Siebel CRM maps this task property to this task metric. The
dropdown list for the Property Name property displays a list of task properties that the task contains.
 

Task Property  
A task property denes a eld that Siebel CRM uses to save a value. It can use this value in a task step, in an input or
output argument, or to perform an evaluation.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Property
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The following table describes properties that Siebel CRM uses with a task property.

Property Description

Access Mode (R)
 

You can use one of the following values:
 

• Read. Siebel CRM can only read this task property.

• R/W. Siebel CRM can read and update this task property.

Data Type (R)
 

Species the type of data that Siebel CRM can save. You can use one of the following values:
 

• Binary. Save variant or binary data. If you choose Binary, then you must set the In/Out property of
this task property to None.

• Date. Save date data.

• Hierarchy. Save data that Enterprise Application Integration (EAI) can use in a property set.

• Integration Object. Save data that Enterprise Application Integration (EAI) can use in an
integration object.

• Number. Save numeric data.

• String. Save alphanumeric data.

• Strongly Typed Integration Object. Save data that Enterprise Application Integration (EAI) can use
in a strongly typed integration object.

Default (O)
 

Species the predefault value of this task property.
 

In/Out (R)
 

Species how to send the value that this task property contains. You can use one of the following
values:
 

• In. Send this value into the task.

• Out. Send this value out of the task.

• In/Out. Send this value into and out of the task.

• None. Use this value only in the task.

If the Data Type property is Binary, then you cannot set the In/Out property to In, Out, or In/Out.
 

Integration Object
 

Species the name of the integration object. If the Data Type property is Integration Object or Strongly
Typed Integration Object, then the Integration Object property is required. For example:
 

Account - Get Oracle Customer (Oracle)

Name (R)
 

Species the name of this task property.
 

Parent Name
 

Species the name of the parent object. This property is read-only.
 

Task Step  
A task step denes a unit of work that the task controller performs.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Step

The following table describes properties that Siebel CRM uses with a task step.

Property Description

Business Component
 

Species the name of a business component that the business object references. The task references
this business object.
 
If the Type property is Siebel Operation, then the Business Component is required.
 

Chapter (O)
 

Species the chapter that includes this task step. The drop-down list displays the chapters that the
parent task includes.
 

Defer Write Record (O)
 

Species when to save data. You can use one of the following values:
 

• TRUE. Do not write this data to the Siebel database until a Commit step.

• FALSE. Write this data to the Siebel database immediately.

Siebel CRM uses the Defer Write Record property only if the Type property is Siebel Operation.
 

Display Name (O)
 

Species the name that Siebel CRM displays in the Current Task Pane or the Context Pane.
 

Display Name Type (O)
 

Species to repeat the display name of the task views next to each other in the Current Task Pane or
the Context Task pane. You can use one of the following values:
 

• Normal. Repeat the display name.

• Unique. Display the display name only one time.

Name (S)
 

Species the name of this task step.
 

Operation
 

Species the type of the Siebel Operation that this task step uses.
 
If the Type property is Siebel Operation, then the Operation property is required.
 

Parent Name
 

Species the name of the parent object. This property is read-only.
 

Repeatable
 

Species to run this task step more than one time while the task runs. You can use one of the following
values:
 

• TRUE. Allow Siebel CRM to run this task step more than one time.

• FALSE. Allow Siebel CRM to run this task step only one time.

If the Type property is Business Service or Siebel Operation, then the Repeatable property is required.
 

Retain Applet Search Spec
 

Species to retain the applet search specication that runs in the current step when the current step
exits. You can use one of the following values:
 

• TRUE. Retain the applet search specication.

• FALSE. Delete the applet search specication.
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Property Description

If the Type property is Task View, then the Retain Applet Search Spec property is required.
 

Retain Task Search Spec
 

Species to retain the task search specication that runs in the current step when the current step
exits. You can use one of the following values:
 

• TRUE. Retain the task search specication.

• FALSE. Delete the task search specication.

If the Type property is Siebel Operation or Task View, then the Retain Task Search Spec property is
required.
 

Retain User Search Spec
 

Species to retain the user search specication that runs in the current step when the current step
exits. You can use one of the following values:
 

• TRUE. Retain the user search specication.

• FALSE. Delete the user search specication.

If the Type property is Task View, then the Retain Task Search Spec property is required.
 

SubTask Name
 

Species the name of the subtask. If the Type property is Subtask, then the SubTask Name property is
required.
 

Task View
 

Species the name of the task view. If the Type property is Task View, then the Task View property is
required.
 

Type (S)
 

Species the type of this task step. You can use one of the following values:
 

• Business Service. Call a business service.

• Commit. Commit data to the Siebel database.

• Decision Point. Do decision branching.

• End. End the task.

• Error. Cancel the task with error.

• Siebel Operation. Do a Siebel operation.

• Start. Start the task.

• Subtask. Call a subtask.

• Task View. Display a task view.

Task Step Context  
A task step context denes the context for a task step. To do this, it sets up a search specication for a business
component that the business object references. You can use a task step context only if the Type property of the task
step is Siebel Operation or Task View.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Step > Task Step Context

212



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

The following table describes properties that Siebel CRM uses with a task step context.

Property Description

Expression Business Component (O)
 

Species the name of the business component that the right operand of the expression references. For
example, consider the following expression:
 

[Account Id] = [Id] 

where:
 

• = is the operator

• [Account Id] is the left operand

• [Id] is the right operand

If the Expression Business Component is Account, then Siebel CRM treats the right operand as
[Account.Id]. In this example, Siebel CRM uses the following expression:
 

[Account.Account Id] = [Account.Id]

Filter Business Component (O)
 

Species the name of the business component that the left operand of the expression references. For
example, consider the following expression:
 

[Account Id] = [Id] 

If the Filter Business Component is Contact, then Siebel CRM treats the left operand as
[Contact.Account Id]. In this example, Siebel CRM uses the following expression:
 

[Contact.Account Id] = [Account.Id]

Is User Search Spec (R)
 

You can use one of the following values:
 

• TRUE. The search specication is a user search specication.

• FALSE. The search specication is a task search specication.

Name
 

Species the name of this task step context.
 

Search Specication (O)
 

Species the value of the search specication.
 

Type (R)
 

Species the type of this task step context. You can use one of the following values:
 

• Literal. This task step context uses a literal value.

• Expression. This task step context uses an expression.

Task Step IO Argument  
A task step IO argument identies the input and output arguments for a task step. Each task step accepts input from the
task and sends output back to the task.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Step > Task Step IO Argument
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The following table describes properties that Siebel CRM uses with a task step IO argument.

Property Description

Argument (R)
 

Species the name of this task step IO argument.
 

Business Component
 

Species the name of the business component in the business object of the task. If the Type property
is Business Component, then the Business Component property is required.
 

Business Component Field
 

Species the name of a business component eld. If the Type property is Business Component, then
the Business Component Field property is required.
 

Input/Output (R)
 

Species this task step IO argument as an input argument or an output argument.
 

Name (S)
 

Species the name of this task step IO argument.
 

Parent Name
 

Species the name of the parent object. This property is read-only.
 

Preferred Sequence (O)
 

Species the order that Siebel CRM uses when it evaluates multiple task step IO arguments for a single
task step. When the task step runs, Siebel CRM evaluates the task step IO argument that contains the
lowest preferred sequence rst.
 
Siebel CRM uses this preferred sequence only for an input argument. If the Input/Output property is:
 

• Input. Siebel CRM uses the Preferred Sequence property.

• Output. Siebel CRM ignores the Preferred Sequence property.

Property Name
 

Species the name of the task property that this task step IO argument references. If the Type property
is Task Property, then the Property Name property is required.
 

Type (R)
 

Species the type for this task step IO argument. You can use one of the following values:
 

• Business Component

• Literal

• Expression

• Output Argument

• Task Property

Value (O)
 

Species a value. If the Type property is Literal or Expression, then Siebel CRM uses the value that the
Value property contains.
 

Task Step Locale  
A task step locale denes language overrides that Siebel CRM uses with a task step.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Step > Task Step Locale

The following table describes properties that Siebel CRM uses with a task step locale.

Property Description

Display Name (O)
 

Species the name that Siebel CRM displays for a task step for a language.
 

Name (O)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Parent Name
 

Species the name of the parent object. This property is read-only.
 

Task Group Object Types  
This topic describes the Task Group object type and the object types that are children of this object type. It includes the
following topics:

• Task Group

• Task Group Item

• Task Group Locale

Task Group  
A task group denes a group of tasks that Siebel CRM displays on the Task Pane. For more information about
conguring task groups, see  Siebel Business Process Framework: Task UI Guide .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Group

The following table describes properties that Siebel CRM uses with a task group.

Property Description

Display Name (R)
 

Species the label that Siebel CRM displays in the Task Pane for this task group.
 

Required Context BC (R)
 

Species the business component that the tasks in this task group reference.
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Task Group Item  
A task group item species a task and the sequence that Siebel CRM uses to display it in a task group.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Group > Task Group Item

The following table describes properties that Siebel CRM uses with a task group item.

Property Description

Context Business Component
 

Species the business component that Siebel CRM uses to set the task context. For more information,
 see  Siebel Business Process Framework: Task UI Guide .
 

Name
 

Species the name for this task group item. Siebel CRM sets the value for this property to the name of
the Task, by default.
 

Sequence
 

Species the order that Siebel CRM uses to display the task in the parent task group. The value of this
property must be a number.
 

Task (R)
 

Species the task that Siebel CRM displays in the Task Pane. Adding a task to a task group item does
not automatically congure Siebel CRM to display it in the Task Pane. The following items must also be
true:
 

• The Siebel CRM application that uses this task group is currently running.

• The conguration in the Task Administration screens allows the user to access this task.

• The task is licensed for this module.

If the Context Required property of the task group is TRUE, then Siebel CRM displays data from the
business component that the task references. It displays this data in the current view.
 

Type
 

Species to call a command or a task if the user picks an item from the task list for the task group.
 

Task Group Locale  
A task group locale denes language overrides that Siebel CRM uses with a task group.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Task > Task Group > Task Group Locale

The following table describes properties that Siebel CRM uses with a task group locale.

Property Description

Display Name (O) Species the name that Siebel CRM displays for a task group for a language.
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Property Description

   

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Parent Name
 

Species the name of the parent object. This property is read-only.
 

Text Style Object Types  
This topic describes the Text Style object type.

Text Style (H)  
A text style species font information for controls, applets, views, or applications.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Text Style

The following table describes properties that Siebel CRM uses with a text style.

Property Description

Bold (O)
 

If TRUE, then this text style uses bold text.
 

Font Face (O)
 

Species the font face name for this text style. For example, Arial, Courier, and so forth. If you do
not specify this property, then Siebel CRM uses the default font that the object uses. For example,
 if a control uses a text style that does not specify a font face, then Siebel CRM uses the font that all
controls in the parent applet use.
 

Font Size (O)
 

Species the point size of the font that Siebel CRM uses. If you do not specify this property, then Siebel
CRM uses the default font size that the object uses. For example, if a control uses a text style that does
not specify font size, then Siebel CRM uses the font size that all controls in the parent applet use.
 
This value must use an integer.
 

Italic (O)
 

If TRUE, then this text style uses Italic text.
 

Name (R)
 

Species the name of this text style.
 

Underlined (O)
 

If TRUE, then this text style uses underlined text.
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Toolbar Object Types  
This topic describes the Toolbar object type and the object types that are children of this object type. It includes the
following topics:

• Toolbar

• Toolbar Item

• Toolbar Item Locale

• Toolbar Locale

Toolbar  
A toolbar denes a toolbar that the user can use in the client. Siebel CRM typically uses HTML toolbars where the
buons are static images and can be dimmed to indicate availability. Some applications, such as Siebel Call Center, use
toolbar icons that Siebel CRM modies in reply to an event, such as a blinking icon that indicates an incoming call. In this
situation, Siebel CRM uses a Java toolbar.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Toolbar

The following table describes properties that Siebel CRM uses with a toolbar.

Property Description

Class (O)
 

Species the name of the Java class that implements this toolbar. The value for this property is empty
for an HTML toolbar.
 

Client Restriction (O)(H)
 

Species to display this toolbar only in the mobile client.
 

Display Name (O)
 

Species the display name that Siebel CRM uses for this toolbar.
 

Name (R)
 

Species the name of this toolbar that Siebel CRM displays in the list in the Toolbars tab of the
Customize dialog box in the client.
 

Popup Indicator Bitmap (O)
 

Species the name of the bitmap icon that Siebel CRM displays in this toolbar.
 

Toolbar Item  
A toolbar item associates a command with a toolbar. This association places a toolbar icon on the toolbar. The toolbar
item properties determine how Siebel CRM places icons on a toolbar and the order that it uses to place these icons.
To override this conguration, the user can use the Customize dialog box in the client. Siebel CRM saves these
modications to a local preferences le.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Toolbar > Toolbar Item

The following table describes properties that Siebel CRM uses with a toolbar item.

Property Description

Command (R)
 

Species the name of the command that species the bitmap, method, and target for this toolbar item.
To insert a separator between icons, you can include one or more dashes (-) instead of the name of a
command.
 

Display Name (O)
 

Species the text name that Siebel CRM displays for this toolbar item. For example, to represent
advanced search, Siebel CRM displays the following text instead of a bitmap image:
 

Advanced Search

Group (O)
 

Species the group name. If you specify the Group property, then Siebel CRM uses a radio buon for
each toolbar item that this group contains. The user can choose only one radio buon at a time.
 

HTML Aributes (O)
 

Reserved for future use.
 

HTML Type (O)
 

Species the type of control that Siebel CRM displays in the toolbar for this toolbar item.
 

HTML Width (O)
 

Species the width of this toolbar item in pixels that Siebel CRM displays in the Siebel Web Client.
 

HTML Width - Language Override (O)
 

Species the width of this toolbar item in pixels that Siebel CRM displays in the Siebel Web Client if a
language or locale is active.
 

Name (R)
 

Species the name of this toolbar item.
 

Position (O)
 

Species the position of this toolbar item.
 

Position - Language Override (O)
 

Species the position of this toolbar item if a language or locale is active.
 

Target View Frame (O)
 

Species the HTML page that Siebel CRM loads into the frame that this property species.
 

Type (R)
 

Species the toolbar item type.
 

Width (R)
 

Species the width of this toolbar item.
 

Width - Language Override (O)
 

Species the width of this toolbar item if a language or locale is active.
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Toolbar Item Locale  
A toolbar item locale denes language overrides that Siebel CRM uses with a toolbar item.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Toolbar > Toolbar Item > Toolbar Item Locale

The following table describes properties that Siebel CRM uses with a toolbar item locale.

Property Description

Display Name (O)
 

Species the text name that Siebel CRM displays for this toolbar item. For example, to represent
advanced search, Siebel CRM displays the following text instead of a bitmap image:
 

Advanced Search

HTML Width (O)
 

Species the width of this toolbar item in pixels that Siebel CRM displays in the Siebel Web Client.
 

Name (O)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Position (O)
 

Species the position of this toolbar item.
 

Width (O)
 

Species the width of this toolbar item.
 

Toolbar Locale  
A toolbar locale denes language overrides that Siebel CRM uses with a toolbar.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Toolbar > Toolbar Locale

The following table describes properties that Siebel CRM uses with a toolbar locale.

Property Description

Display Name (O)
 

Species the text name that Siebel CRM displays for this toolbar. For example, to represent advanced
search, Siebel CRM displays the following text instead of a bitmap image:
 

Advanced Search

Name (O)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU
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Type Object Types  
This topic describes the Type object type and the object types that are children of this object type. It includes the
following topics:

• Aribute

• Type

Aribute  
An aribute species a column that contains data. Siebel Enterprise Integration Manager (EIM) uses this object type. For
more information, see  Siebel Developer's Reference .

CAUTION:  You must not modify this object type. Any modication you make might adversely aect Siebel
CRM.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Aribute > Aribute

The following table describes properties that Siebel CRM uses with an aribute.

Property Description

Category (S)
 

Species the group for the object properties that Siebel CRM displays on a property sheet. This
grouping helps the user to use a property sheet.
 

Column Name (S)
 

Species the name of the aribute column.
 

Language Override Aribute (S)
 

Species the order of aribute columns for a language or locale.
 

Name (S)
 

Species the name of an aribute column in the client.
 

No Compile (S)
 

You can use one of the following values:
 

• TRUE. Siebel CRM does not compile the object denition if you use the Tools menu in Siebel
Tools.

• FALSE. Siebel CRM compiles the object denition if you use the Tools menu in Siebel Tools.

Siebel Wins (S)
 

Species the aribute value to use if a conict occurs during an upgrade. You can use one of the
following values:
 

• TRUE. Siebel CRM maintains the value that Oracle provides.

• FALSE. Siebel CRM uses the existing property value.

For example, assume the value for the Search Specication property of the Action business component
in an existing release is:
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Property Description

[Type] <> 'Template'

Assume you modify this value to the following:
 

[Type] <> 'Template' AND [Type] <> 'ABC'

In a new release, assume Oracle modies this value to the following:
 

[Type] <> 'Template' AND [Type] <> 'XYZ'

If you upgrade Siebel CRM, then a conict occurs and Siebel CRM uses a value according to the
following value that the Siebel Wins property contains:
 

• TRUE. Siebel CRM uses the value that Oracle provides in the new release.

• FALSE. Siebel CRM uses the existing value.

Translatable (S)
 

Species one of the following values:
 

• TRUE. Siebel CRM can translate the aribute.

• FALSE. Siebel CRM cannot translate the aribute.

Type  
A type sets the type for object types in a repository.

CAUTION:  You must not modify this object type. Any modication you make might adversely aect Siebel
CRM.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Type

The following table describes properties that Siebel CRM uses with a type.

Property Description

Bitmap Category (S)
 

Not used.
 

Business Component (S)
 

Species the name of a business component.
 

Language Sub Type (S)
 

Species the name of an object type for a locale. For example, an applet locale is associated with the
Applet object property.
 

Name (S)
 

Species the name of this type.
 

No Compile (S)
 

If TRUE, and if you click Compile from the Tools menu in Siebel Tools, then Siebel Tools does not
compile this type.
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Property Description

Table Name (S)
 

Species the name of a table.
 

View Object Types  
This topic describes the View object type and the object types that are children of this object type. It includes the
following topics:

• View

• View Locale

• View Task Group

• View Task Group Locale

• View User Prop (H)

• View Web Template

• View Web Template Item

• View Web Template Item Locale

View  
A view denes a visual representation of business object data.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > View

The following table describes properties that Siebel CRM uses with a view.

Property Description

Add To History (O)
 

If TRUE, then species to include this view in the historical list of views that the user navigates during a
session. To access this history, the user clicks the browser Back buon.
 

Admin Mode Flag (O)
 

For more information, see Seing the Admin Mode Flag Property of a View
 

Background Bitmap (O)(H)
 

Species the bitmap that Siebel CRM uses as the background for this view.
 

Bitmap Category (O)(H)
 

Not used.
 

Business Object (R)
 

Species the name of the business object that this view references.
 

Container Web Page (O)(H)
 

Species the container page to that contains this view. If this property includes a value, then it
overrides the value in the Container Web Page property of an application.
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Property Description

Default Applet Focus
 

Species the applet that Siebel CRM highlights the rst time it displays this view. If this property is
empty, then it highlights the rst applet that it displays in this view, starting at the upper left corner of
this view.
 

Disable PDQ
 

If TRUE, then Siebel CRM does not allow the user to create a default predened query (PDQ).
 

Drop Sectors (R)(H)
 

Species the pair of sectors that Siebel CRM drops in six sector mode for any resolution that is less
than 1024 by 768. You can use one of the following values:
 

• 0and4

• 1and5

• 2and6

• 3and7

Explicit Logon (O)
 

If TRUE, then the user must explicitly log in through the logon Web page to view this view.
 

Help Identier (O)
 

Species a topic name for context-sensitive help. This name is a string that includes all uppercase
characters and no empty space. For example:
 

ID_VIEW_OPPORTUNITY_LIST

 

HTML Bitmap (O)
 

Species the icon that Siebel CRM displays as a link to this view.
 

HTML Popup Dimension (O)
 

Species the dimensions of the pop-up window, in pixels. The value for this property must include a
lowercase x and no spaces. For example:
 

640x480

Name (R)
 

Species the name of this view. Objects use this name to reference this view.
 

No Borders (O)(H)
 

If TRUE, then Siebel CRM does not display borders around the applets that this view displays.
 

Sector0 Applet (R)(H)
 

Species the applet that Siebel CRM displays in sector 0 of this view.
 

Sector1 Applet (R)(H)
 

Species the applet that Siebel CRM displays in sector 1 of this view.
 

Sector2 Applet (R)(H)
 

Species the applet that Siebel CRM displays in sector 2 of this view.
 

Sector3 Applet (R)(H)
 

Species the applet that Siebel CRM displays in sector 3 of this view.
 

Sector4 Applet (R)(H)
 

Species the applet that Siebel CRM displays in sector 4 of this view.
 

Sector5 Applet (R)(H)
 

Species the applet that Siebel CRM displays in sector 5 of this view.
 

Sector6 Applet (R)(H) Species the applet that Siebel CRM displays in sector 6 of this view.
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Property Description

   

Sector7 Applet (R)(H)
 

Species the applet that Siebel CRM displays in sector 7 of this view.
 

Secure (O)
 

If TRUE, then the Siebel Web Engine does the following:
 

• Species the HTTPS protocol for all URLs that it creates to this view.

• Veries that the current request uses the HTTPS protocol. This conguration prevents a user from
typing HTTP instead of HTTPS in the URL window of the browser to access a secure view.

The browser and the Web server handle HTTPS. The Siebel Web Engine only species to use HTTPS
for a view. You must make sure HTTPS is enabled on any server that Siebel CRM expects to provide a
secure view.
 

Status Text (O)(H)
 

Not used.
 

Task
 

Species the default task that this view uses.
 

Text Style (O)(H)
 

Species the text style that Siebel CRM uses by default for all controls in the applets that this view uses.
Siebel CRM uses this text style only if the control or applet does not explicitly specify a text style.
 

Thread Applet (O)
 

Species the name of an applet. A eld in this applet provides the data that Siebel CRM uses as part of
the thread title. The Thread Field property identies this eld.
 

Thread Field (O)
 

Species the name of the eld of the thread applet. This eld provides the data that Siebel CRM uses
as part of the thread title.
 

Thread Title (O)
 

Species the text that Siebel CRM uses for the thread title label.
 

Title (O)
 

Species the browser history that Siebel CRM uses to display the names of views that the user has
accessed. Siebel CRM uses this history if the user clicks the browser Back or Forward buon.
 

Vertical Line Position (O)(H)
 

Species the position that Siebel CRM uses when it displays a dividing line between applets in sectors
0 to 3 and applets in sectors 4 to 7. The Vertical Line Position property can include a value between 0
and 12, where:
 

• 0. Positions the vertical line to the extreme left.

• 12. Positions the vertical line to the extreme right.

• 6. Positions the vertical line in the middle.

The default value is 6.
 
This property is useful for a view that contains a tree applet that must occupy only about one-third
of the width of the area that the user can view. In this situation, it is recommended that you set the
Vertical Line Position property to a value of 4 through 8. If you do not, then Siebel CRM might stretch
or compress an applet to such an extent that it is dicult to view.
 

Visibility Applet (O)
 

Species the applet in this view that controls visibility. Typically this applet is one of the following:
 

• The list applet in a list-form view.

• The master applet in a master-detail view.
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Property Description

You must set the Visibility Applet property to the master applet of this view.
 
For more information, see Seing the Visibility Applet Properties of a View.
 

Visibility Applet Type (O)
 

Species the visibility mode that Siebel CRM applies to the applet that the Visibility Applet property
species. The Applet Visibility Type property of the view Web template overrides the Visibility Applet
Type property. For more information, see Seing the Visibility Applet Properties of a View.
 

Seing the Admin Mode Flag Property of a View  
The Account Administration view, Opportunity Administration view, and Product Administration view are examples of
Admin mode views. If the Admin Mode Flag Property is TRUE, then Siebel CRM uses this view in Admin mode. It does
the following:

• Ignores any insert or update visibility rules that exist for this view. You set the Admin Mode Flag to TRUE only
for an administrative view.

• If pop-up visibility is set for the business component that provides data to this view, then Siebel CRM uses this
pop-up visibility.

• Ignores the visibility type for the business component unless this type is Organization.

• Ignores any no insert, no merge, and no update seings that exist on a business component that provides
data to this view. Admin mode does not aect these restrictions that are set on the applet or if the Read Only
property of a eld is TRUE.

• Allows the user to display every record, even if no primary team member is set for a record. This visibility is
dierent from All visibility where Siebel CRM only displays records that include a primary team member.

If the Admin Mode property is TRUE, then a conict might occur in the following situations:

• Visibility is congured on a multivalue link or multivalue eld on the business component that provides data to
this view.

• The Force Active property is set on this business component or on this multivalue eld.

Seing the Visibility Applet Properties of a View  
If the user uses the Show drop-down list to navigate between views, and if the seings for the Visibility Applet property
and the Visibility Applet Type property are dierent between these views, and if the conguration of the business
components and the search specications is consistent between these views, then Siebel CRM keeps the query context
and record focus from the previous view.

If the user uses the Site Map or the Screen Tabs to navigate between views, and if the seings for the Visibility Applet
property and the Visibility Applet Type property are dierent between these views, then Siebel CRM applies the most
restrictive visibility conguration. In this situation, it typically uses the Personal or Sales Rep visibility, depending on the
visibility seings of the business component and the Thread Applet property of the view.

View Locale  
A view locale denes language overrides that Siebel CRM uses with a view.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > View > View Locale

The following table describes properties that Siebel CRM uses with a view locale.

Property Description

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Status Text (O) (H)
 

Not used.
 

Thread Title (O)
 

Species the text that Siebel CRM displays as the thread title label.
 

Title (O)
 

Species the text string that Siebel CRM displays in the title bar. Siebel CRM applies a prex to this title
depending on the following seings in the application conguration le:
 

• The CaptionPrex parameter species a prex. Siebel CRM uses this prex.

• The CaptionPrex parameter does not specify a value. It uses the value that the ApplicationTitle
parameter species.

• The CaptionPrex parameter and the ApplicationTitle parameter do not specify a value. It uses
the following value as the prex text:

Siebel applications

For example, If the value of the Title property is My Accounts, and if the prex text is Siebel Sales, and
if this view is active, then Siebel CRM displays the following text in the title bar:
 

Siebel Sales - My Accounts

View Task Group  
A view task group lists task groups and child tasks in the Task Pane. For more information, see  Siebel Business Process
Framework: Task UI Guide .

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > View > View Task Group

The following table describes properties that Siebel CRM uses with a view task group.

Property Description

Application
 

Species the Siebel CRM application where Siebel CRM displays this task group. If empty, then Siebel
CRM displays this task group for any application.
 

Sequence
 

Species the order that Siebel CRM uses to display task groups in the Task Pane. This value is a
number.
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View Task Group Locale  
A view task group locale denes language overrides that Siebel CRM uses with a view task group.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > View > View Task Group > View Task Group Locale

The following table describes properties that Siebel CRM uses with a view task group locale.

Property Description

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Sequence (O)
 

Species the name that Siebel CRM displays for a view task group for a language.
 

Task Group
 

Species the task group that Siebel CRM displays in the Task Pane for this view.
 

View User Prop (H)  
A view user prop sends a value to the C++ code that implements specialized view conguration. Siebel CRM persists the
value that you congure for a user property in the Siebel runtime repository. For more information, see Object Types
That You Must Not Modify.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > View > View User Prop

The following table describes properties that Siebel CRM uses with a view user prop.

Property Description

Name
 

For Oracle use only.
 

Value
 

For Oracle use only.
 

View Web Template  
A view web template denes the layout of the applets in the view.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > View > View Web Template

The following table describes properties that Siebel CRM uses with a view web template.

Property Description

Name (R)
 

Species the name of the view web template.
 

User Layout (O)
 

If TRUE, then the user can modify the layout in the view.
 

Web Template (R)
 

Species the web template that Siebel CRM uses to display the view.
 

View Web Template Item  
A view web template item maps applet controls to placeholder IDs in the web template.

Used by the Siebel Web Engine to map swe:applet tag to applets.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > View > View Web Template > View Web Template Item

The following table describes properties that Siebel CRM uses with a view web template item.

Property Description

Applet (R)
 

Species the name of the applet that Siebel CRM maps to the ID.
 

Applet Mode (O)
 

Species the applet mode. You can use one of the following values:
 

• Base

• Edit

• Edit List

• Query

Applet Visibility Type (O)
 

Species the applet visibility. This property overrides the Visibility Applet Type property of the view.
 

Display Size (O)
 

Species to minimize or maximize the applet. If the Display Size property is Always Maximized, then
the user cannot minimize the applet. Siebel CRM typically uses this property with an applet that it
displays on a home page.
 

Display Visibility (O)
 

Species if the applet is visible or hidden. If the Display Visibility property is Always Show, then the
user cannot hide the applet. Siebel CRM typically uses this property with an applet that it displays on a
home page.
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Property Description

Expression
 

Species how to limit the way Siebel CRM displays a control in a Siebel CRM application. It is similar to
a search specication or query condition. The Expression property is typically empty and Siebel CRM
does limit how it displays the control. For more information, see the topic about application mappings
in  Conguring Siebel Business Applications .
 

Item Identier (R)
 

Species the ID of the swe:applet tag in the Web Template.
 

Item Identier - Language Override (O)
 

Species the ID of the swe:applet tag in the web template if a language or locale is active.
 

Move Range (O)
 

Species how far the user can move an applet. For example, assume the following:
 

• An application home page includes two columns.

• The rst applet uses the Column1 move range.

• The second applet uses the Column2 move range.

In this situation, the user can do the following:
 

• Move any applet that uses the Column1 move range only in the rst column.

• Move any applet that uses the Column2 move range only in the second column.

If the Move Range property is empty, then the user cannot move the applet. For example, the Move
Range property that Siebel CRM uses for the salutation applet on the home page is typically empty.
 

Name (R)
 

Species the name of this view web template item.
 

Namespace (O)
 

Species the qualier that Siebel CRM uses for the item identier. For example, if the swe:applet tag
that Siebel CRM uses for this mapping resides in a swe:idgroup tag, then the Namespace property
species the ID of the idgroup tag.
 

Namespace - Language Override (O)
 

Species the qualier for the item identier if a language or locale is active.
 

Position (O)
 

Species the hierarchical relationship that Siebel CRM uses between the applets in the view.
 

View Web Template Item Locale  
A view web template item locale denes the language override that Siebel CRM uses with a view web template item.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > View > View Web Template > View Web Template Item > View Web Template Item Locale

The following table describes properties that Siebel CRM uses with a view web template item locale.

Property Description

Item Identier (O) Species the ID of the swe:applet tag in the web template.
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Property Description

   

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses.
 

Namespace (O)
 

Species the qualier that Siebel CRM uses for the item identier. For example, if the swe:applet tag
that Siebel CRM uses for this mapping resides in a swe:idgroup tag, then the Namespace property
species the ID of the idgroup tag.
 

Web Page Object Types  
This topic describes the Web Page object type and the object types that are children of this object type. It includes the
following topics:

• Web Page

• Web Page Item

• Web Page Item Locale

• Web Page Item Parameter

• Web Page Locale (H)

Web Page  
A web page species the Web page that Siebel CRM uses as a container for a view.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Web Page

The following table describes properties that Siebel CRM uses with a web page.

Property Description

Do Not Use Container (O)
 

You can use one of the following values:
 

• TRUE. Display the template le for this page with the applications container web page.

• FALSE. Display the template le for this page without the applications container web page.

Name (R)
 

Species the name of the web page.
 

Title
 

Not used.
 

Web Template (R)
 

Species the name of the web template that Siebel CRM associates with this Web page.
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Web Page Item  
A web page item identies the object that Siebel CRM displays on a web page. It is similar to a control in an applet
but Siebel CRM uses it outside the context of an applet on a Web page. Siebel CRM maps a web page item to a
swe:pageitem tag in the Web page.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Web Page > Web Page Item

The following table describes properties that Siebel CRM uses with a web page item.

Property Description

Caption (O)
 

Species the display name of this web page item.
 

HTML Aributes (O)
 

Species to add HTML tag aributes to the HTML tags that the client creates to display the web page
item.
 

Item Identier (R)
 

Species the ID of the swe:pageitem tag.
 

Item Identier - Language Override (O)
 

Species the ID of the swe:pageitem tag if a language or locale is active.
 

Method Invoked (O)
 

Species the method that Siebel CRM calls.
 

Name (R)
 

Species the name of the web page item.
 

Namespace (O)
 

Species the qualier that Siebel CRM uses for the item identier. For example, if the
swe:pageitem tag that Siebel CRM uses for this mapping resides in a swe:idgroup tag, then the
Namespace property species the ID of the idgroup tag.
 

Namespace - Language Override (O)
 

Species the qualier for the item identier if a language or locale is active.
 

Show Popup (O)
 

You can use one of the following values:
 

• TRUE. Open a browser window before calling the method.

• FALSE. Call the method before opening a browser window.

Target View Frame (O)
 

Species the HTML page that Siebel CRM loads into the frame that the Target View Frame property
species.
 

Type (R)
 

Species how to display this web page item on the HTML page.
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Web Page Item Locale  
A web page item locale denes language overrides that Siebel CRM uses with a web page item.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Web Page > Web Page Item > Web Page Item Locale

The following table describes properties that Siebel CRM uses with a web page item locale.

Property Description

Caption (O)
 

Species the display name of this web page item.
 

Item Identier (O)
 

Species the ID of the swe:pageitem tag.
 

Name (R)
 

Species the abbreviation for the language that the Siebel CRM application uses. For example:
 

ENU

Namespace (O)
 

Species the qualier that Siebel CRM uses for the item identier. For example, if the
swe:pageitem tag that Siebel CRM uses for this mapping resides in a swe:idgroup tag, then the
Namespace property species the ID of the idgroup tag.
 

Web Page Item Parameter  
A web page item parameter varies depending on the web page item. For example, if the Method Invoked property of a
web page item is GoToView, then the web page item parameter identies a view and the value is the name of this view.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Web Page > Web Page Item > Web Page Item Parameter

The following table describes properties that Siebel CRM uses with a web page item parameter.

Property Description

Name (R)
 

Species the name of the web page item parameter.
 

Value (R)
 

Species the value of the web page item parameter.
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Web Page Locale (H)  
A web page locale denes language overrides that Siebel CRM uses with a web page.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Web Page > Web Page Locale

The following table describes properties that Siebel CRM uses with a web page locale.

Property Description

Name (R)
 

Species the name of the object.
 

Title (O)
 

Species the text that Siebel CRM uses for the title of the Web page for a language.
 

Web Template  
A web template denes a repository description that Siebel CRM uses for the Web template. Other objects that use a
web template reference the web template name. Applets, views, and web pages are examples of these objects.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Web Template

The following table describes properties that Siebel CRM uses with a web template.

Property Description

Name (R)
 

Species the name of the web template.
 

Type (R)
 

Species the web template type.
 

Workow Policy Column Object Type  
This topic describes the Workow Policy Column object type.

Workow Policy Column  
A workow policy column identies a column that Siebel CRM monitors in the Siebel database or an extension column.
It also species the picklist that Siebel CRM uses for this column. One or more workow processes can use the same
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workow policy column. It is recommended that you do not modify any property of a predened workow policy
column. If your implementation requires customization, then you can add a new workow policy column.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Column

The following table describes properties that Siebel CRM uses with a workow policy column.

Property Description

Applet (O)
 

Species the pick applet that Siebel CRM uses to display the picklist in the Workow Policies view.
 

Column Name (R)
 

Species the name of a column from the picklist of columns that exist in the table that the Table Name
property species.
 

Name (R)
 

Species the name of this workow policy column. Siebel CRM displays this name in the Conditions list
in the Workow Policies view.
 

PickList (O)
 

Species the picklist that Siebel CRM displays in the Workow Policy Detail view for this column. The
user who creates the policy uses this picklist to choose the comparison value for this workow policy
column. For more information, see  Conguring Siebel Business Applications .
 

Source Field (O)
 

Species the business component eld of the picklist that provides the source for the comparison
value. This is a eld name that resides in the picklist that the PickList property species.
 

Table Name (R)
 

Species the name of the Siebel database table that contains this workow policy column.
 

Workow Policy Object Types  
This topic describes the Workow Policy object type and the object types that are children of this object type. It includes
the following topics:

• Assignment Object

• Assignment Object Extension

• Assignment User Prop

• Dynamic Candidate (H)

• Dynamic Candidate Aribute (H)

• Dynamic Candidate Component (H)

• Dynamic Candidate Component Col (H)

• Dynamic Candidate Locale (H)

• Dynamic Drilldown Destination

• Workow Policy Component

• Workow Policy Component Col
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• Workow Policy Object

Assignment Object  
An assignment object does the following:

• Species how to assign a business entity to a candidate

• Species how to update Siebel CRM data to complete an assignment

• Species other assignment arguments

A workow policy object includes column mappings in child workow policy components and grandchild workow
policy component columns. An assignment aribute column can specify these mappings. It does this to determine if a
match exists between a candidate and a business entity. It also monitors values that Siebel CRM modies so that Siebel
CRM can do a dynamic assignment.

You must check in modications you make. For more information, see Checking In Assignment Objects.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object > Assignment Object

The following table describes properties that Siebel CRM uses with an assignment object. Siebel Tools uses dierent
labels for some assignment object properties.It also includes only the label that displays in the Properties Window. For
more information, see How Siebel Tools Uses Dierent Labels for Assignment Object Properties.

Property Description

Add Team Members (O)
 

You can use one of the following values:
 

• TRUE. Assignment Manager deletes existing team members from the teams and existing
assignment rules in the assignment rule intersection table that no longer qualify.

• FALSE. Assignment Manager never deletes existing team members from the assignment object
even if they no longer qualify.

Assignment Date Column (O)
 

Species the datetime stamp Siebel CRM uses to indicate the last time it assigned a record. This
property can contain only the following value:
 

ASGN_DT

Assignment Mode (O)
 

Determines how Assignment Manager assigns an object according to organization or person. You can
use one of the following values:
 

• Independent. Assigns any person and organization regardless of if a relationship exists between
this person and organization.

• Person-Oriented. Assigns a person and then assigns only organizations to which this person
belongs.

• Organization-Oriented. Assigns an organization and then assigns a person who belongs in this
organization.

• Organization and Person-Oriented. Identies all qualied people and all qualied organizations.
It then assigns a person and an organization only if a relationship exists between this person and
the organization.

Assignment Scoring Mode (R)
 

Species the mode that Siebel CRM uses to determine an assignment. You can use one of the following
values:
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Property Description

• Person-based. Set the assignment rule score to the score of the highest-scoring candidate. This is
the default value.

• Organization-based. Set the assignment rule score to the score of the highest-scoring
organization.

Auto Reassign (R)
 

You can use one of the following values:
 

• TRUE. Assignment Manager automatically reassigns assignment objects if assignment aribute
values are modied and if policies are dened. This is the default value.

• FALSE. Assignment Manager does not automatically reassign assignment objects.

If the Generate Triggers server component creates triggers for the active assignment policy, and if
the Auto Reassign property is FALSE, then it does not create any triggers for the update. Assignment
occurs only one time when Siebel CRM inserts the record. If you modify this property after you run a
Generate Triggers server component job, then you must regenerate triggers.
 

Calendar Activity Additional Fields (O)
 

Species a string that Siebel CRM uses for an activity that it assigns according to availability. This string
uses the following format:
 

 parent field, field 1, value1, field 2, value2

 

For example, you can specify the following elds for the Service Request object:
 

• Activity SR Id

• Type

• ToDo

If the user creates a new activity, then Siebel CRM uses these eld values for this new activity.
 
For more information about assignments that Siebel CRM makes according to availability, see  Siebel
Assignment Manager Administration Guide .
 

Calendar Create Activity (O)
 

If Siebel CRM assigns an object according to availability, then you can use one of the following values:
 

• TRUE. Assignment Manager can create an activity in an employee calendar.

• FALSE. Assignment Manager cannot create an activity in an employee calendar. FALSE is the
default value.

Siebel CRM assigns an object dierently depending on if the object is an activity:
 

• An Activity. If an assignment rule qualies an employee, and if the Check Employee Calendar
property of this assignment rule includes a check mark, and if no other employee qualies for this
assignment rule, then Siebel CRM reuses the same activity.

• Not an activity. Siebel CRM creates a new activity for each employee who qualies. It sets the
parent activity for all activities to the original activity Id.

Calendar Duration Column (O)
 

Species the column in the assignment object primary table that references the object duration. If
Siebel CRM assigns an object according to availability, then you must specify this property.
 

Calendar Early Start Time Column (O)
 

Species the column in the assignment object primary table that references the early start time of the
object.
 
This column contains the earliest date and time that an activity can start. The time range from
Calendar Early Start Time to Calendar Start Time denes the time range that the activity can start.
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Property Description

 
If you do not specify a value, then the activity can start any time before the value that the Calendar
Start Time Column property contains.
 
If Siebel CRM assigns an object according to availability, then you must specify this property.
 

Calendar Start Time Column (O)
 

Species the column in the assignment object primary table that references the start time of the
object.
 
This column contains the latest time that an activity can start. The time range from Calendar Early
Start Time to Calendar Start Time denes the time range that the activity can start.
 
If Siebel CRM assigns an object according to availability, then you must specify this property.
 

Default Employee (O)
 

Species the login ID of the default employee.
 
Assignment Manager assigns this employee if a conict occurs and it cannot choose the correct set of
employees. A conict occurs if no assignment rules match or if two rules qualify with the same score.
 
If you do not specify this property, then Assignment Manager sets the owner Id eld in the object row
to No Match Row Id.
 

Default Group (O)
 

Not used.
 

Default Org (O)
 

Species the name of the default organization. Assignment Manager assigns this organization if a
conict occurs and it cannot choose the correct set of organizations. A conict occurs if no assignment
rules match or if two rules qualify with the same score.
 
If you do not specify this property, then Assignment Manager sets the owner Id eld in the object row
to No Match Row Id.
 

Default Position (O)
 

Species the name of the default position. Assignment Manager assigns this position if a conict
occurs and it cannot choose the correct set of positions. A conict occurs if no assignment rules match
or if two rules qualify with the same score.
 
If you do not specify this property, then Assignment Manager sets the owner Id eld in the object row
to No Match Row Id.
 

Employee Column (O)
 

Species the name of the column in the employee intersection table that references rows in the
employee table (S_EMPLOYEE). If the Employee Table property is not empty, then this property is
required.
 

Employee Denorm Column (O)
 

Species the name of a column in the employee intersection table. This column determines if the
Assignment Manager can assign an employee in a denormalization program.
 

Employee Key Column (O)
 

Species the name of the column that contains the key values of the employees that Siebel CRM
assigns to the team at runtime. If the UseKeyValue server component parameter is True, then the
Employee Key Column is required.
 

Employee Manual Column (O)
 

Species the name of a column in the employee intersection table. This column determines if a user
can manually assign an employee.
 

238



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

Employee Primary Column (O)
 

Species the name of a column in the primary table. This column contains the primary employee on a
team or a single-owner employee. A single-owner employee is a type of assignment where Assignment
Manager can assign only one candidate to an object.
 
If you specify a value in the Employee Primary Column, and if you do not specify a value in the
Employee Table, then Siebel CRM enables the assignment object for employees in the single-owner
mode.
 
If the assignment rule is a single-owner rule, or if the Set Primary Employee property is TRUE, then the
Employee Primary Column property is required.
 

Employee Primary Column List (O)
 

Species a comma-separated list of column names in the employee intersection table that Assignment
Manager must copy if Siebel CRM modies the primary employee. To copy the old primary employee
to the new primary employee, Assignment Manager copies values from these columns.
 

Employee Primary Denorm Column (O)
 

Species the name of a column in the primary table. This column determines if Assignment Manager
can assign a primary employee in denormalization mode.
 
If the assignment rule is a single-owner rule, or if the Set Primary Employee property is TRUE, then the
Employee Primary Denorm Column property is required.
 

Employee Primary Manual Column (O)
 

Species the name of a column in the primary table. This column determines if a user can manually
assign a primary employee.
 
If the assignment rule is a single-owner rule, or if the Set Primary Employee property is TRUE, then the
Employee Primary Manual Column property is required.
 

Employee Primary System Column (O)
 

Species the name of a column in the primary table. This column determines if Assignment Manager
can assign a primary employee in denormalization mode.
 
If the assignment rule is a single-owner rule, or if the Set Primary Employee property is TRUE, then the
Employee Primary System Column property is required.
 

Employee System Column (O)
 

Species the name of a column in the employee intersection table. This column determines if
Assignment Manager can assign an employee in non-Denormalization mode.
 
If the Employee Table property is not empty, then the Employee System Column property is required.
 

Employee Table (O)
 

Species the name of the employee intersection table. If Assignment Manager can assign the
assignment object to multiple employees, then this intersection table contains the set of employee IDs
that it assigns to the assignment object IDs.
 
If Assignment Manager assigns objects according to team, then the Employee Table property is
required.
 

Employee Team Score Column (O)
 

Species the name of the column in the team table that contains scores for each member of an
employee team. This property can reference any column that contains a number.
 

Exclude Column (O)
 

Species the name of the lock assignment column in the primary table, which is a column in the
primary table of the assignment object that Siebel CRM can use to prevent Assignment Manager from
processing some rows.
 
Most of the assignment object tables include an ASGN_USR_EXCLD_FLG column. Siebel CRM displays
this column in the client as a eld named Lock Assignment for some objects. If Siebel CRM does not
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Property Description

display this column for an assignment object, then you can query the Siebel database for the ASGN_
USR_EXCLD_FLG column in the appropriate table.
 
You typically set the value for this column through a business component, not through Assignment
Manager. For example, if the user creates a new activity, then Siebel CRM automatically adds a check
mark in the Lock Assignment checkbox for this activity. The user must remove this check mark before
Siebel CRM can assign this activity.
 

Group Column (R)
 

Species the name of a row ID column in the rule intersection table that references rows in the
assignment rule table (S_ASGN_GRP).
 
This column provides a foreign key to the assignment rule table. This key uniquely identies a rule for
each relationship between an assignment entity and a rule.
 
If the Rule Table property is not empty, then the Group Column property is required.
 

Group Denorm Column (O)
 

Species the name of a column in the rule intersection table. This column determines if Assignment
Manager can use the assignment rule in denormalization mode.
 

Group Manual Column (O)
 

Species the name of a column in the rule intersection table. This column determines if a user can
manually use the assignment rule.
 

Group Primary Column (O)
 

Species the name of a column in the primary table. This column contains the primary or single-owner
rule.
 
If the Set Primary Rule property is TRUE, then the Group Primary Column property is required.
 

Group Primary Column List (O)
 

Species a comma-separated list of column names in the rule intersection table that Assignment
Manager copies if Siebel CRM modies the primary rule. It copies values from these columns from the
old primary rule to the new primary rule.
 

Group Primary Denorm Column (O)
 

Species the name of a column in the primary table. This column determines if Assignment Manager
can use the primary rule in denormalization mode.
 
If the assignment rule is a single-owner rule, or if the Set Primary Group property is TRUE, then the
Group Primary Denorm Column property is required.
 

Group Primary Manual Column (O)
 

Species the name of a column in the primary table. This column determines if a user can manually
use the primary rule.
 
If the assignment rule is a single-owner rule, or if the Set Primary Group property is TRUE, then the
Group Primary Manual Column property is required.
 

Group Primary System Column (O)
 

Species the name of a column in the primary table. This column determines if Assignment Manager
can assign the primary rule in denormalization mode.
 
If the assignment rule is a single-owner rule, or if the Set Primary Group property is TRUE, then the
Group Primary System Column property is required.
 

Group System Column (O)
 

Species the name of a column in the rule intersection table. This column determines if Assignment
Manager can assign the rule in denormalization mode.
 

Group Table (O) Species the name of the rule intersection table.
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Ignore Assignment Aributes (R)
 

You can use one of the following values:
 

• TRUE. Assignment Manager ignores assignment criteria that are not relevant to the assignment
object. For example, if an assignment rule species Service Request Priority as a criterion, and if
Assignment Manager assigns opportunities and accounts, then it ignores this criterion. Service
Request Priority is an assignment aribute that is relevant only to a service request.

• FALSE. Assignment Manager evaluates all assignment criteria.

Keep Creator (R)
 

You can use one of the following values:
 

• TRUE. Assignment Manager cannot delete the creator of the assignment object from the team.

• FALSE. Assignment Manager can delete the creator.

Keep Man Asgn Primary Employee (O)
 

If Assignment Manager assigns an object according to team, then you can use one of the following
values:
 

• TRUE. If the user explicitly sets the primary employee of a team, then Assignment Manager does
not set this employee. Instead, it adds a check mark to the Primary Person Manual property of the
primary table that the assignment object references.

• FALSE. Assignment Manager sets the primary employee of a team.

Keep Man Asgn Primary Group (O)
 

If Assignment Manager assigns an object according to team, then you can use one of the following
values:
 

• TRUE. If the user explicitly sets the primary assignment rule for a team, then Assignment
Manager does not set this rule. Instead, it adds a check mark to the Primary Assignment Rule
Manual property of the primary table that the assignment object references.

• FALSE. Assignment Manager sets the primary assignment rule even if the user already manually
assigned it.

Keep Man Asgn Primary Org (O)
 

You can use one of the following values:
 

• TRUE. If you dene the Org Primary Manual Column property for an assignment object, and if the
value in the column that this property references contains a Y, then Assignment Manager does
not reassign the primary organization.

• FALSE. Assignment Manager does examine the Org Primary Manual Column property.

Keep Man Asgn Primary Position (O)
 

If Assignment Manager assigns an object according to team, then you can use one of the following
values:
 

• TRUE. If the user explicitly sets the primary position for a team, then Assignment Manager does
not set this position. Instead, it adds a check mark to the Primary Person Manual property of the
primary table that the assignment object references.

• FALSE. Assignment Manager sets the primary position.

Keep User Assigned (R)
 

If Assignment Manager assigns an object according to a team, then you can use one of the following
values:
 

• TRUE. Assignment Manager keeps manually assigned employees, positions, and assignment
rules. In this situation, a position that a user adds to an account sales team is an example of
a person. A territory that a user adds to a territory list for an opportunity is an example of an
assignment rule.

241



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

• FALSE. An automatic assignment operation can replace a manually assigned employee, position,
 or assignment rule.

To determine if a user manually assigned an object, Assignment Manager examines the value of the
Team Manual Column property.
 

Max Number Per Role (O)
 

Not used.
 

Name (R)
 

Species the name of the assignment object. This property uniquely identies the assignment object
in the repository. It provides the name that Siebel CRM displays in the picklist and multivalue group
applet for assignment rules in administration views.
 

Org Column (R)
 

Species the name of the column in the organization intersection table that references rows in the
organization table.
 
If the Org Table property is not empty, then the Org Column is required.
 

Org Denorm Column (O)
 

Species the name of a column in the organization intersection table. This column determines if
Assignment Manager can assign an organization in denormalization mode.
 

Org Key Column
 

Species the name of a column. This column contains the key values of the organizations that
Assignment Manager assigns to the team at runtime.
 
If the UseKeyValue server component parameter is True, then the Org Key Column property is required.
 

Org Manual Column (O)
 

Species the name of a column in the organization intersection table. This column species if the user
can manually assign an organization.
 

Org Primary Column (O)
 

Species the name of a column in the primary table. This column contains the primary organization for
a team or a single-owner organization.
 
If you specify a value in the Org Primary Column property, and if you do not specify a value in the Org
Table property, then Siebel CRM enables the assignment object for organizations that Assignment
Manager assigns in single-owner mode.
 
If the assignment rule is a single-owner rule, or if the Set Primary Org property is TRUE, then the Org
Primary Column property is required.
 

Org Primary Column List (O)
 

Species a comma-separated list of column names in the organization intersection table. If Siebel CRM
modies the primary organization, then Assignment Manager copies values from these columns from
the old primary organization to the new primary organization.
 

Org Primary Denorm Column (O)
 

Species the name of a column in the primary table. This column determines if Assignment Manager
can assign the primary organization in denormalization mode.
 
If the assignment rule is a single-owner rule, or if the Set Primary Org property is TRUE, then the Org
Primary Denorm Column property is required.
 

Org Primary Manual Column (O)
 

Species the name of a column in the primary table. This column determines if the user can manually
assign the primary organization.
 
If the assignment rule is a single-owner rule, or if the Set Primary Org property is TRUE, then the Org
Primary Manual Column property is required.
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Org Primary System Column (O)
 

Species the name of a column in the primary table. This column determines if Assignment Manager
can assign the primary organization in denormalization mode.
 
If the assignment rule is a single-owner rule, or if the Org Primary System Column property is TRUE,
then the Org Primary Manual Column property is required.
 

Org System Column (O)
 

Species the name of a column in the organization intersection table. This column determines if a user
can manually assign an organization.
 

Org Table (O)
 

Species the name of the organization intersection table. If Assignment Manager can assign
the assignment object to multiple organizations, then this intersection table contains the set of
organization IDs that it assigns to assignment object IDs.
 
If Assignment Manager assigns objects according to team, then the Org Table property is required.
 

Org Team Score Column (O)
 

Species the name of a column in the team table. This column contains scores for each member of an
organization team. This property can reference any column that can contain a number.
 

Position Column (R)
 

Species the name of a column in the position intersection table. This column references rows in the
position table (S_POSTN).
 
If the Position Table property is not empty, then the Position Column property is required.
 

Position Denorm Column (O)
 

Species the name of a column in the position intersection table. This column determines if the
denorm program can assign a position.
 
If the Position Table property is not empty, then the Position Denorm Column property is required.
 

Position Key Column
 

Species the name of a column. This column contains the key values of the employees that
Assignment Manager assigns to the team at runtime.
 
If the UseKeyValue server component parameter is True, then the Position Key Column property is
required.
 

Position Manual Column (O)
 

Species the name of a column in the position intersection table. This column determines if the user
can manually assign a position.
 
If the Position Table property is not empty, then the Position Manual Column property is required.
 

Position Primary Column (O)
 

Species the name of a column in the primary table. This column contains the primary position for
teams or it contains a single-owner position.
 
If the assignment rule is a single-position rule, or if the Set Primary Position property is TRUE, then the
Position Primary Column property is required.
 

Position Primary Column List (O)
 

Species a comma-separated list of column names in the position intersection table. If Siebel CRM
modies the primary position, then Assignment Manager copies values from these columns from the
old primary position to the new primary position.
 

Position Primary Denorm Column (O)
 

Species the name of a column in the primary table. This column determines if the denorm program
assigns the primary position.
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If the assignment rule is a single-position rule, or if the Set Primary Position property is TRUE, then the
Position Primary Denorm Column property is required.
 

Position Primary Manual Column (O)
 

Species the name of a column in the primary table. This column determines if the user can manually
assign a primary position.
 
If the assignment rule is a single-position rule, or if the Set Primary Position property is TRUE, then the
Position Primary Manual Column property is required.
 

Position Primary System Column (O)
 

Species the name of a column in the primary table. This column determines if Siebel CRM assigns the
primary position.
 
If the assignment rule is a single-position rule, or if the Set Primary Position property is TRUE, then the
Position Primary System Column property is required.
 

Position System Column (O)
 

Species the name of a column in the position intersection table. This column determines if Siebel
CRM assigns a position.
 
This property is required if the Position Table property is not empty.
 

Position Table (O)
 

Species the name of the position intersection table. If Assignment Manager can assign the
assignment object to multiple positions, then this intersection table column contains the set of position
IDs that it assigns to the assignment object IDs.
 
If Assignment Manager assigns objects according to a team, then the Position Table property is
required.
 

Position Team Score Column (O)
 

Species the name of a column in the team table. This column contains scores for each member of a
position team. This property can reference any column that can contain a number.
 

Primary Table (R)
 

Species the name of a primary table. The business component references this table. For example, S_
ORG_EXT is the primary table for the Account assignment object.
 

Set Primary Employee (O)
 

Species the primary employee. This employee is typically the employee who possesses the highest
score in the assignment rule that possesses the highest score. You can use one of the following values:
 

• TRUE. Assignment Manager chooses and sets the primary employee.

• FALSE. Assignment Manager does not choose and set the primary employee.

Set Primary Group (O)
 

Species the primary assignment rule. This rule is typically the rule that possesses the highest score in
the assignment rule. You can use one of the following values:
 

• TRUE. Assignment Manager chooses and sets the primary position.

• FALSE. Assignment Manager does not choose or set the primary position.

Set Primary Org (O)
 

Species the primary organization rule. This organization is typically the organization that possesses
the highest score in the assignment rule. You can use one of the following values:
 

• TRUE. Assignment Manager chooses and sets the primary organization.

• FALSE. Assignment Manager does not choose or set the primary organization.
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Set Primary Position (O)
 

Species the primary position. This position is typically the position that possesses the highest score in
the assignment rule. You can use one of the following values:
 

• TRUE. Assignment Manager chooses and sets the primary position.

• FALSE. Assignment Manager does not choose or set the primary position.

Skill Item Table (O)
 

Species the name of the skill item table that contains skills for the assignment object. This table must
be a child table of the table that the Skill Table property species. The Skill Id column is a foreign key
column to the skill table.
 

Skill Table (O)
 

Species the name of the table that contains skills for an assignment object.
 

Team
 

You can use one of the following values:
 

• TRUE. To determine the assignment criterion, Siebel CRM uses a column in the team table.

• FALSE. To determine the assignment criterion, Siebel CRM does not use a column in the team
table.

Siebel CRM uses this property for dynamic candidates.
 

How Siebel Tools Uses Dierent Labels for Assignment Object Properties  
The following table describes how the labels that Siebel Tools displays in the Properties Window are dierent from the
labels that it displays for the same property in the Object List Editor.

Label in the Properties Window Label in the Object List Editor

Add Team Members
 

Replace Team Members
 

Default Org
 

Default Organization
 

Employee Denorm Column
 

Employee Team Denorm Column
 

Employee Manual Column
 

Employee Team Manual Column
 

Employee Primary Column List
 

Employee Team Copy Columns
 

Employee System Column
 

Employee Team System Column
 

Exclude Column
 

Lock Assignment Column
 

Group Column
 

Rule Column
 

Group Denorm Column
 

Rule Team Denorm Column
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Label in the Properties Window Label in the Object List Editor

Group Manual Column
 

Rule Team Manual Column
 

Group Primary Column
 

Rule Primary Column
 

Group Primary Column List
 

Rule Team Copy Columns
 

Group Primary Denorm Column
 

Rule Primary Denorm Column
 

Group Primary Manual Column
 

Rule Primary Manual Column
 

Group Primary System Column
 

Rule Primary System Column
 

Group System Column
 

Rule Team System Column
 

Group Table
 

Rule Table
 

Ignore Assignment Aributes
 

Ignore Extra Aributes
 

Keep Man Asgn Primary Employee
 

Keep Manual Primary Employee
 

Keep Man Asgn Primary Group
 

Keep Manual Primary Rule
 

Keep Man Asgn Primary Position
 

Keep Manual Primary Position
 

Keep User Assigned
 

Keep Manual Assigned
 

Org Column
 

Organization Column
 

Org Table
 

Organization Table
 

Position Denorm Column
 

Position Team Denorm Column
 

Position Manual Column
 

Position Team Manual Column
 

Position Primary Column List
 

Position Team Copy Columns
 

Position System Column
 

Position Team System Column
 

Set Primary Group
 

Set Primary Rule
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Assignment Object Extension  
An assignment object extension identies the columns that Siebel CRM uses to determine the following items:

• Candidates it adds or drops

• Tables it uses for reporting

• Column it uses as the key column

• Columns it use for the position, employee, or organization

An assignment object extension contains the results tables. It does this only if Siebel CRM runs in reporting mode.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object > Assignment Object Extension

The following table describes properties that Siebel CRM uses with an assignment object extension.

Property Description

Employee Reporting Column (O)
 

Species the name of the column in the employee reporting intersection table that references rows in
the employee table.
 
If the Employee Table property is not empty then the Employee Reporting Column property is required.
 

Employee Reporting Deletion Column
 

Species the column that contains data about the employees that Siebel CRM removes from a team.
This property applies only in snapshot mode or delta reporting mode.
 

Employee Reporting Insertion Column
 

Species the column that contains data about the employees that Siebel CRM adds to a team. This
property applies only in snapshot mode or delta reporting mode.
 

Employee Reporting Key Column (O)
 

Species the column that contains the key values of the employees that Siebel CRM assigns to a team
at runtime.
 
If the UseKeyValue server component parameter is TRUE, then the Employee Reporting Key Column
property is required.
 

Employee Reporting Table (O)
 

Species the name of the employee reporting intersection table. If Siebel CRM can assign the
assignment object to multiple employees, then this intersection table contains the set of employee IDs
that it assigns to the assignment object IDs.
 

Name (R)
 

Species the name of the assignment object extension. This name must match the name of the
assignment object.
 

Org Reporting Column (O)
 

Species the column in the organization reporting intersection table that references rows in the
organization table.
 
If the Organization Table property is not empty, then the Org Reporting Column property is required.
 

Org Reporting Deletion Column
 

Species the column that Siebel CRM uses to save data about the organizations that it removes from a
team. This property applies only in snapshot mode or delta reporting mode.
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Org Reporting Insertion Column
 

Species the column that contains data about organizations that Siebel CRM adds to a team. This
property applies only in snapshot mode or delta reporting mode.
 

Org Reporting Key Column (O)
 

Species the column that contains the key values of the organizations that Siebel CRM assigns to a
team at runtime.
 
If you specify this property, then you must set the UseKeyValue server component parameter to True.
 

Org Reporting Table (O)
 

Species the name of the organization reporting intersection table. If Siebel CRM can assign
the assignment object to multiple organizations, then this intersection table contains the set of
organization IDs that it assigns to the assignment object IDs.
 

Position Reporting Column (O)
 

Species the column in the position reporting intersection table that references rows in the position
table.
 
If the Position Table property is not empty, then the Position Reporting Column property is required.
 

Position Reporting Deletion Column
 

Species the column that identies the positions that Siebel CRM removes from a team. This property
applies only in snapshot mode or delta reporting mode.
 

Position Reporting Insertion Column
 

Species the column that Marks the positions that are added to the team. This property applies only in
snapshot mode or delta reporting mode.
 

Position Reporting Key Column (O)
 

Species the column that contains the key values of the positions that Siebel CRM assigns to a team at
runtime.
 
If you specify this property, then you must set the UseKeyValue server component parameter to True.
 

Position Reporting Table (O)
 

Species the name of the position reporting intersection table. If Siebel CRM can assign the
assignment object to multiple positions, then this intersection table contains the set of position IDs
that it assigns to the assignment object IDs.
 

Assignment User Prop  
An assignment user prop sends a property value to the C++ code that implements specialized conguration. Siebel CRM
persists the value that you congure for a user property in the Siebel runtime repository.

You can use the following types of assignment user properties:

• PositionTeamDenormN, where N is any number. If Siebel CRM replaces one position with another position from
the same rule, then you can use a PositionTeamDenormN property to copy additional columns. For example,
you must replace an existing sales representative on an account team with another representative. For more
information, see the topic about conguring an assignment object to copy additional columns to the team table
in  Siebel Assignment Manager Administration Guide .

• User properties for assignment according to availability. For more information, see  Siebel Assignment Manager
Administration Guide .
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A Column user property takes precedence over a corresponding Value user property. For example, if you dene a
Breakable Flag Column user property and a Breakable Flag Value user property, then the Breakable Flag Column user
property takes precedence. Assignment Manager uses the following order of precedence:

1. Column user property
2. Value user property
3. Calendar Activity Additional Fields property

For more information, see Object Types That You Must Not Modify.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object > Assignment Object > Assignment User Prop

The following table describes properties that Siebel CRM uses with an assignment user prop.

Property Description

Name
 

Species the name of the user property.
 

Value (R)
 

Species the value of the user property.
 

Dynamic Candidate (H)  
A dynamic candidate denes employee, position, and organization candidates for an assignment rule that Siebel CRM
dynamically species from an aribute on the object.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object > Assignment Object > Dynamic Candidate

The following table describes properties that Siebel CRM uses with a dynamic candidate.

Property Description

Aribute Id Column
 

Not used.
 

Aribute Table
 

Not used.
 

Display Name (O)
 

Species the display name for the dynamic candidate.
 
The symbolic string must be created before seing the display name.
 

Name
 

Species the name for this object.
 

Object Id Column
 

Not used.
 

Score Column
 

Not used.
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Property Description

Team Table
 

Not used.
 

Team Table Aribute Id Column
 

Not used.
 

Team Table Candidate Id Column
 

Not used.
 

Team Type
 

Species the candidate team to use employee, organization, or position.
 

Dynamic Candidate Aribute (H)  
A dynamic candidate aribute applies to Siebel CRM versions earlier than version 7.8. For version 7.8 and later, see
Dynamic Candidate Component (H) and Dynamic Candidate Component Col (H).

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Assignment Object > Dynamic Candidate (H) > Dynamic Candidate Aribute

The following table describes properties that Siebel CRM uses with a dynamic candidate aribute.

Property Description

Assignment Criterion
 

Not used.
 

Team Aribute Column
 

Not used.
 

Dynamic Candidate Component (H)  
A dynamic candidate component denes a list of joins from the assignment object to the candidate table.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object > Assignment Object > Dynamic Candidate (H) > Dynamic Candidate
Component

The following table describes properties that Siebel CRM uses with a dynamic candidate component.

Property Description

Additional Join Spec
 

Species an additional join.
 

Candidate Id Column
 

Species the column in the Team table that contains the Id of the candidate employee, position, or
organization.
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Candidate Table
 

Species to use the name of the source table that occurs at the last level of a join. If Candidate Table is
TRUE, then the Candidate Id Column property is required.
 
This property was named Team Table in Siebel CRM versions prior to version 7.8.
 

Primary
 

This property can include one of the following values:
 

• TRUE. Siebel CRM uses the primary table for the join. The primary table is the table that contains
the assignment object. For example, assume a record in the S_ORG_EXT table is marked as the
primary for an account, contact, and position dynamic candidate. In this situation, Assignment
Manager determines that Siebel CRM must use the S_ORG_EXT table as the rst table in the join.

• FALSE. The Target Column Name property and the Target Component Name property are
required.

Score Column
 

Species the column in the Team table that contains the scores of the candidates.
 

Source Column Name (R)
 

Species the column in the source table that relates to another dynamic candidate component.
 

Source Table Name (R)
 

Species the table that the dynamic candidate component references.
 

Target Column Name
 

Species the column in the target component that maintains a relationship with the column in the
source column of the source table for this record. When Siebel CRM creates the SQL code, the inner
join source table that the source column references on the source table equals the target column of the
source table from the target component.
 

Target Component Name
 

Species the target dynamic candidate component that joins to the source table in this dynamic
candidate component.
 

Dynamic Candidate Component Col (H)  
A dynamic candidate component col maps columns in a source table at a level in a join to an assignment according to
team criterion.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object > Assignment Object > Dynamic Candidate (H) > Dynamic Candidate
Component (H) > Dynamic Candidate Component Col

The following table describes properties that Siebel CRM uses with a dynamic candidate component col.

Property Description

Assignment Criteria Aribute Name
 

Species the name of the assignment criteria aribute that Siebel CRM compares to the value in the
Aribute Column Name property.
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Assignment Criteria Name
 

Species the name of the assignment criteria. If you set the Assignment Criteria Aribute Name
property, then Siebel CRM automatically populates the Assignment Criteria Name property.
 

Aribute Column Name (R)
 

Species the name of the column in the source table.
 

Copy Column Name
 

Species the name of the column stamped on the team table if working in operational mode.
 

Reporting Copy Column Name
 

Species the name of the column stamped on the name reporting table if working in reporting mode.
 

Dynamic Candidate Locale (H)  
A dynamic candidate locale denes language overrides that Siebel CRM uses with a dynamic candidate.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object > Assignment Object > Dynamic Candidate (H) > Dynamic Candidate
Locale

The following table describes properties that Siebel CRM uses with a dynamic candidate locale.

Property Description

Display Name (O)
 

Species the display name for the dynamic candidate locale object.
 

Dynamic Drilldown Destination  
A dynamic drilldown destination congures dynamic drilldown conguration for a drilldown eld and the corresponding
list column or control.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Applet > Drilldown Object > Dynamic Drilldown Destination

The following table describes properties that Siebel CRM uses with a dynamic drilldown destination.

Property Description

Destination Drilldown Object (O)
 

Species the name of the drilldown object in the same applet that the drilldown displays if the eld
specied in the Field property matches the value specied in the Value property.
 

Field (O)
 

Species the Type eld in the business component that the applet references. Siebel CRM examines
this eld in the current record to determine if the value that it contains matches the seing in the Value
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property of the dynamic drilldown destination. If the value matches, then the drilldown displays the
drilldown object that the Destination Drilldown Object property species.
 

Name (R)
 

Species a name that uniquely identies each dynamic drilldown destination object denition in the
parent drilldown object.
 

Sequence (O)
 

Species the order that Siebel CRM uses to search for the children of one drilldown object. It performs
this search from lowest to highest according to the integer value that this property contains.
 

Value (O)
 

Species the value that Siebel CRM must match with the Type eld.
 

Dierences Between Static and Dynamic Drilldowns  
The drilldown object denition in a static drilldown or a dynamic drilldown identies a drilldown eld and a view. These
properties specify the list column or control that includes drilldown capabilities and the destination view if the user
clicks the drilldown. In a dynamic drilldown, the drilldown object also includes dynamic drilldown destination object
denitions. Each of these denitions references the Type eld in the business component and species a value that
Siebel CRM uses to examine the value in this eld. If Siebel CRM nds a match in a dynamic drilldown destination, then
it uses a dierent drilldown object that typically resides in a dierent destination view.

To use a dynamic drilldown, the user must be assigned a responsibility that allows this user to view the default
drilldown. For example, assume Applet A on View B uses a dynamic drilldown and that View C is the default view for this
drilldown. To make sure this drilldown works property, the user must be assigned a responsibility that allows the user to
use View B and View C.

Workow Policy Component  
A workow policy component identies a database table and species a relationship with another table that the
workow process references. A primary workow policy component is a workow policy component that all other
workow policy components directly or indirectly reference. To dene the workow conditions that are available for
monitoring in the workow policy object, you can use these workow policy components.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object > Workow Policy Component

The following table describes properties that Siebel CRM uses with a workow policy component.

Property Description

Join Spec (O)
 

Species a join between this workow policy component and the target workow policy component.
 
If the existing join references an intersection table that would result in Siebel CRM returning multiple
rows, then you specify the Join Spec property. The join that the Join Spec property references restricts
the join so that Siebel CRM returns only one row at a time. The expression that the Join Spec property
contains is equivalent to an additional WHERE clause in SQL. It uses the following format:
 

 workflow_component.foreign_key = 
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Property Description

business_component.primary_key

 

For example, the following join specication occurs in the Primary Opportunity/Position workow
policy component in the Opportunity workow process:
 

 [Primary Opportunity/Position].OPTY_ID = 
[Opportunity].ROW_ID 

 

You must enclose the component name with square brackets.
 

Name (R)
 

Species the name of this workow policy component.
 

Primary (O)
 

If TRUE, then this workow policy component is the primary workow policy component for the parent
workow policy object. Each workow policy object must include one and only one primary workow
policy component.
 
For example, the Primary property of the Account workow policy component of the predened
Account workow policy object is TRUE. This conguration denes the Account workow policy
component as the primary. Other workow policy components in the Account workow policy object
are not primary workow policy components.
 

Source Column Name (O)
 

Species the column in the source table that another workow policy component references. The
drop-down list for this property displays columns from the table that the Source Table Name property
species.
 

Source Table Name (R)
 

Species the table that this workow policy component references.
 

Target Column Name (O)
 

Species the column in the target workow policy component that Siebel CRM joins to the source
column in this workow policy component. The drop-down list for this property displays columns of
the table that the target workow policy component species.
 

Target Component Name (O)
 

Species the target workow policy component. The drop-down list for this property displays a list of
workow policy components for the current workow policy object.
 

Workow Policy Component Col  
A workow policy component col identies a column that Siebel CRM can monitor from the parent workow policy
component.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object > Workow Policy Component > Workow Policy Component Col

The following table describes properties that Siebel CRM uses with a workow policy component col.
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Property Description

Alias
 

Species the name of the column that Siebel CRM displays in the Conditions Field picklist in the
Workow Policies view.
 

Name (R)
 

Species the name of the workow policy component col that Siebel CRM displays in the Conditions
applet in the Workow Policy Detail view. This property defaults to the same value that the Workow
Column Name property contains.
 

Workow Column Name (R)
 

Species the name of the column that Siebel CRM monitors in the workow policy component. This
name must specify the object denition of an existing workow policy column.
 

Workow Object Name (R)
 

Species the name of the workow policy object for this workow policy component col.
 

Workow Policy Object  
A workow policy object groups workow policy component objects and workow policy component columns that
Siebel CRM can monitor in the same workow policy object.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Object

The following table describes properties that Siebel CRM uses with a workow policy object.

Property Description

Name (R)
 

Species the name of this workow policy object.
 

Workow Policy Program Object Types  
This topic describes the Workow Policy Program object type and the object types that are children of this object type. It
includes the following topics:

• Workow Policy Program

• Workow Policy Program Arg

Workow Policy Program  
A workow policy program species the name and type of a workow policy program or action that Siebel CRM can use
in reply to meeting a workow policy condition. Siebel CRM displays the workow policy programs in the drop-down
list of the Actions Applet eld in the Workow Policy Detail view. You can use predened workow policy programs that
already congure variables except for the message text, or you can create a custom workow policy program.
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This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Program

The following table describes properties that Siebel CRM uses with a workow policy program.

Property Description

Name (R)
 

Species the name of the action that Siebel CRM performs.
 

Type (R)
 

Species one of the following types of actions:
 

• DB Operation. For more information, see Seing the DB Operation.

• External Program. Run an external program in Windows.

• Send Message. Compose and send an automatic email message.

• Send Page. Send a page to a pager.

• Send Broadcast Message. Send a broadcast message to a group of users.

In some situations, if Siebel CRM modies data, then it must also modify some other data. To congure
this data dependency, you can do one of the following:
 

• Use the Application Object Manager, business components, and run-time events.

• Use a database operation in a workow policy object that modies records at the database level.

It is recommended that you use this database operation only if this data dependency aects database
records instead of business components. For example, if Siebel CRM must update one database record
if it inserts another database record regardless of the business components that reference these
database records, or if no business component references these records.
 

Workow Object (O)
 

Species the name of the workow policy object.
 

Seing the DB Operation  
In some situations, if Siebel CRM modies data, then it must also modify some other data. Siebel CRM typically
implements this data dependency at the Object Manager layer through business components and run-time events.
Database operations that workow policies run provide an alternative that works at the Siebel database record level.

It is recommended that you congure Siebel CRM to use DB Operation only if the data dependency is centered around
database records rather than business components. For example, if Siebel CRM must update one database record if it
inserts another database record, then you can use DB Operation regardless of the business components that the two
database records belong to, or whether the two database records belong to a business component at all.

Using Variables In a Message  
To make content more specic, you can use variables in the messages. This conguration also allows you to use the
same message for more than one workow policy object. For example:

The severity level for SR from account is value and has been open for 2 hours.

CAUTION:  You must not modify or create an SQL statement or message that uses variables that other SQL
statements set. For help with this conguration, see Object Types That You Must Not Modify.
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Workow Policy Program Arg  
A workow policy program arg denes recipients, database actions, and substitutions. Each workow policy program
typically contains several workow policy program arguments.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Policy Program > Workow Policy Program Arg

The following table describes properties that Siebel CRM uses with a workow policy program arg.

Property Description

Applet (O)
 

Species the picklist applet.
 

Default Value (O)
 

Species a text value. This text depends on the type of workow policy program arg. For example,
 an SQL statement, the text of a message, or the email address of a recipient. The maximum length is
2000 characters.
 

CAUTION:
Siebel CRM does not allow some kinds of text in the Default Value property of a workow
policy program arg. You must not include trailing spaces, newline, or escape characters. Using
these characters might cause problems, such as a Workow Monitor Agent failure at run
time. You must create or modify a workow policy program arg only with caution. For more
information, see  Siebel Business Process Framework: Workow Guide .
 

Name (R)
 

For more information, see Seing the Name Property of a Workow Policy Program Arg.
 

Picklist (O)
 

Species the object denition of a picklist.
 

Required (O)
 

If TRUE, then data entry is required.
 

Source Field (O)
 

Species the picklist source eld.
 

Visible (O)
 

If TRUE, then Siebel CRM displays the data that this argument provides.
 

Seing the Default Value Property of a Workow Policy Program Arg  
To run a workow policy program, the Siebel Server retrieves data from the Siebel database through an ODBC
connection. The ODBC driver returns a date format that might be dierent from the format that the Siebel database
uses. If you set the Default Value property of a workow policy program arg, and if this workow policy program arg
references a time or date eld, then you must use one of the following formats. This conguration makes sure the date
formats are compatible:

• Date Column: 2001-03-16

• Time Column: 19:26:26
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• Date and Time Column: 2001-04-05 21:25:00

Seing the Name Property of a Workow Policy Program Arg  
To familiarize yourself with how Siebel CRM uses a workow policy program argument, you can examine some of the
predened arguments. For example, in the Workow Policy Programs list, you can query the Name property for Run
External Program. This topic describes some of the workow policy program arguments that this object references. Note
the following:

• You enter the value manually in the Name property of the workow policy program arg.

• If you run a database operation with Insert as the Operation Type, then you can choose a Default Value, New
Row ID that provides the value for the ROW_Id eld for the inserted row.

The following table describes values for workow policy program arguments that are common to a workow policy
program.

Argument Description Value You Can Enter

Primary Id
 

Species the row ID of the violating row on which the
workow policy program runs.
 

Empty.
 

Primary Table
 

Species the base table where this workow policy
program arg applies an action. The base table can be
unrelated to ‘the record of the primary ID. For example,
 the violating row resides in a child table and Siebel CRM
must insert or update a record in the parent table. It can
also update a table that is not related to the primary ID
table. For example, to create a broadcast message when
a monitored value in the opportunity becomes true.
 

The name of a table in the repository, as
compared to the business object that a
workow process references. Siebel CRM
uses the business object that a workow
process references to monitor values but
not to code an action program.
 

Update Row ID
 

Species the row ID of a table other than the primary
table of the workow policy object. You can congure
Siebel CRM to associate a workow policy action with a
workow policy object that updates a table.
 
Siebel CRM uses the Update Row ID property only if the
Operation Type is set to Update.
 

The row ID that Siebel CRM must update.
 

Operation Type
 

Species to perform an update operation or insert
operation.
 

You can use one of the following values:
 

• Update

• Insert

Field Name
 

Species the Name of the column in the base table that
this operation updates. This value is one of two eld
column pairs.
 

You can use one of the following values:
 

• Text

• Variable

• Function

New Row ID
 

Species the row ID of the row that Siebel CRM must
insert. Siebel CRM automatically populate this property
with this row ID.
 

Empty.
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Argument Description Value You Can Enter

Field Name (Column)
 

Species the eld name using the following format:
 

 Field_nameColumn

 

where:
 

• Field name is the eld name of the rst column pair

This is the second of two column pairs.
 

Field name in the base table. This value
cannot contain leading spaces.
 

Sql Statement
 

Species the data from the Siebel database that Siebel
CRM uses to populate substitutions when it performs an
action.
 

Valid SQL query statement for one of the
following RDBMS that your implementation
uses:
 

• Oracle

• MS SQL

• Informix

• Sybase

Sql Statement Inputs
 

Species the name of a column in the base table on
which Siebel CRM performs an operation.
 

Not applicable.
 

Sql Statement Outputs
 

Species a variable for the values that the SQL Statement
argument chooses.
 

Name of the variable.
 

Sending Multiple Variables to SQL Program Arguments  
Multiple variables can be sent into SQL program arguments.

To send multiple variables to SQL program arguments

1. In the Workow Policy Program Arguments list, choose Sql Statement Inputs.
2. Enter the variable names into the Default Value property.

Use the following format:

 [variable1], [variable2], [variable n]

 

Arguments for a Workow Policy Program that Sends a Message  
The following table describes workow policy program arguments that the Send Email workow policy program
references. These arguments are specic to sending a message. To view these arguments, you can query the Name
property for Send Email.
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Value in Name Property Usage Value

Email Message
 

Species the body of the email message.
 

Text with available substitutions.
 

Email Message Repeated
 

Species the text that Siebel CRM repeats when it
uses the Consolidate feature.
 

Text with available substitutions.
 

Email Subject
 

Species the text in the subject line of the email
message.
 

Text.
 

Send to Contact
 

Species the contacts who are available in Siebel
CRM.
 

Not applicable.
 

Send to Position
 

Species the list of the positions that are available in
Siebel CRM.
 

Not applicable.
 

Send to Employee
 

Species the list of employees who are available in
Siebel CRM.
 

Not applicable.
 

Arguments for a Workow Policy Program that Sends a Page  
The following table describes workow policy program arguments that are specic to some workow policy programs
that send a page.

Value in Name Property Usage Value

Send to Contact
 

Species the contacts who are available in Siebel
CRM.
 

Picklist of contacts.
 

Send to Employee
 

Species the list of employees who are available in
Siebel CRM.
 

Picklist of employees.
 

Send to Position
 

Species the list of the positions that are available in
Siebel CRM.
 

Picklist of positions.
 

Send to Relative
 

Species to send to an individual or group of
individuals who are related to the workow process
object.
 

Not applicable.
 

Alpha Numeric Page Message
 

Species the body of the text message.
 

Text with available substitutions.
 

Numeric Page Message
 

Species the body of the numeric message.
 

Text with available substitutions.
 

Arguments for a Workow Policy Program that Runs an External Program  
The following table describes workow policy program arguments that are specic to some workow policy programs
that run an external program.
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Value in Name Property Usage Value

Command Line
 

Species the parameters that Siebel CRM sends to the
executable.
 

Not applicable.
 

Executable Name
 

Species the full path to the executable that Siebel CRM
runs.
 

Not applicable.
 

Executable Type
 

Species the mode the Workow Action Agent uses to run
the external program.
 

You can use one of the
following values:
 

• Wait

• No wait

Workow Process Object Types  
This topic describes the Workow Process object type and the object types that are children of this object type. It
includes the following topics:

• WF Branch Connector (H)

• WF Branch Criteria (H)

• WF Branch Criteria Value (H)

• WF Process Metric

• WF Process Prop

• WF Step

• WF Step Branch (H)

• WF Step I/O Argument (H)

• WF Step Recipient (H)

• Workow Process

WF Branch Connector (H)  
A WF branch connector is a link that connects two steps.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process > WF Step > WF Step Branch (H) > WF Branch Connector

The following table describes properties that Siebel CRM uses with a WF branch connector.

Property Description

From Step Name
 

Species the name of the step where this WF branch connector begins.
 

Layout Species the coordinates of this WF branch connector on the Workow Designer.
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Property Description

   

Name
 

Species the name of this WF branch connector. It is recommended that you use a descriptive name
that is consistent with your overall naming strategy and that is meaningful to you.
 

To Step Name
 

Species the name of the step where this WF branch connector ends.
 

WF Branch Criteria (H)  
A WF branch criteria species a list of conditions. At runtime, the workow engine evaluates these conditions and then
congures the workow process to use the branch that meets the condition.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process > WF Step > WF Step Branch (H) > WF Branch Criteria

The following table describes properties that Siebel CRM uses with a WF branch criteria.

Property Description

Applet Field Name
 

Species the name of a eld that includes the data that Siebel CRM compares. If the Compare To
property is Applet, then the Applet Field Name property is required.
 

Applet Name
 

Species the name of the applet that includes the eld that Siebel CRM compares. If the Compare To
property is Applet, then the Applet Name property is required.
 

Business Component
 

Species the name of a business component that the business object references. The Business Object
property of the workow process references this business object. If the Compare to value is Business
Component or Expression, then the Business Component property is required.
 

Business Component Field
 

Species the name of a business component eld. If the Compare to value is Business Component,
 then the Business Component Field property is required.
 

Compare To (R)
 

Species the object that contains the comparison value.
 

Edit
 

If TRUE, then the user can edit this WF branch criteria.
 

Item Type Name
 

Species the assignment criterion record for an assignment criteria. For more information, see  Siebel
Assignment Manager Administration Guide .
 

Name
 

Species the name of this WF branch criteria.
 

Operation
 

Species the comparison operation. You can specify one of the following values:
 

• All Must Match. All of the values must match exactly, including case.
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Property Description

• All Must Match (ignore case). All of the values must match without regard to case.

• Between. Value must occur between a range of values.

• Greater Than. Value must be greater than the comparison value.

• Is Not Null. Value cannot be empty.

• Is Null. Value must be empty.

• Less Than. Value must be less than the comparison value.

• None Can Match. None of the values can match exactly, including case.

• None Can Match (ignore case). None of the values can match without regard to case.

• Not Between. Value cannot occur between a range of values.

• One Must Match. One or more values must match exactly, including case.

• One Must Match (ignore case). One or more values must match without regard to case.

• This Must Match. The current value must match exactly, including case.

• This Must Match (ignore case). The current value must match without regard to case.

Property Name (R)
 

Species a property of a business process. To determine the condition, Siebel CRM uses the value of
the property that the Property Name species.
 

Sequence (S)
 

Species the order that Siebel CRM uses to evaluate the criteria. Siebel CRM uses this sequence during
an upgrade.
 

WF Branch Criteria Value (H)  
A WF branch criteria value is for Oracle use only.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process > WF Step > WF Step Branch (H) > WF Branch Criteria (H) > WF Branch
Criteria Value

WF Process Metric  
A WF process metric denes a metric that Siebel CRM collects while the workow process runs.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process > WF Process Metric

The following table describes properties that Siebel CRM uses with a WF process metric.

Property Description

Metric Name (R)
 

Species the name of this WF process metric. The drop-down list for this property displays a list of
predened metrics.
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Property Description

 

Name (R)
 

Species the name of the object. Siebel CRM sets a predefault value for this name to the Metric Name.
 

Property Name (R)
 

Species the name of a property of the workow process. Siebel CRM maps this WF process metric to
the property that the Property Name property species.
 

WF Process Prop  
A WF process prop stores values that Siebel CRM uses in a workow step, input argument, or output argument, or to
perform an evaluation.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process > WF Process Prop

The following table describes properties that Siebel CRM uses with a WF process property. Siebel Tools also displays
these properties as elds in the Multi-Value Property Window. For more information, see  Siebel Business Process
Framework: Workow Guide .

Property Description

Access Mode
 

Reserved for future use.
 

Business Component (O)
 

Species the name of the business component that contains the virtual eld that the Virtual Field
property species.
 
The drop-down list for this property displays the business components that the business object
references. The Business Object property of the workow process references this object.
 

Business Object (O)
 

Species the name of the business object that the parent workow process references. This property
is read-only. The drop-down list for this property displays only the business objects that include a
primary business component.
 

Correlator Flag
 

If TRUE, then this WF process prop works as a correlator, which is business data that identies the
recipient of the incoming message. For more information, see the topic about the Workow User Event
Service business service in  Siebel Business Process Framework: Workow Guide .
 

Data Type
 

Species the type of data that Siebel CRM can save. You can use one of the following values:
 

• Alias. Sets the size limit for a default value, not a run-time value. The default value is 250
characters.

• Binary. Species to use variant or binary information, usually for XML data. You must assign a
binary type the None value in the In/Out property.

• Date. Species to use dates.
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Property Description

• Hierarchy. Species to use a data type that Siebel Enterprise Application Integration uses to store
data from a property set. For more information, see  Overview: Siebel Enterprise Application
Integration .

• Integration Object. Species to store integration objects. Integration objects use the Hierarchy
data type.

• Number. Species to use numeric data. It sets the size limit for the default value, not the run-time
value. The default value is 22 digits.

• String. Species to use alphanumeric data, typically for UTF-16 data. It sets the size limit for the
default value, not the run-time value. The default value is 250 characters.

• Strongly Typed Integration Obj. Species to use a special data type to display a workow process
as a Siebel inbound web service. Siebel business services use this property when creating WSDLs.

Siebel CRM treats values in the Strongly Typed Integration Obj property and the Integration Object
property as the same data type for a workow process or for a business service.
 

Default Date
 

Species the starting value if this WF process prop is a date type.
 

Default Number
 

Species the starting value if this WF process prop is a numeric type.
 

Default String
 

Species the starting value if this WF process prop is a string type. You can enter text in this property.
If you enter the following value, then Siebel CRM initializes the value of this WF process prop with the
value in the Value eld of the workow input property set:
 

<Value>

Display Name
 

Species the name that Siebel CRM displays in a view.
 

In/Out
 

Species how to send the value that this WF process prop contains. You can use one of the following
values:
 

• In. Send this value into the workow process.

• Out. Send this value out of the workow process.

• In/Out. Send this value into and out of the workow process.

• None. Use this value only in the workow process.

If the Data Type property is Binary, then you cannot set the In/Out property to In, Out, or In/Out.
 

Integration Object
 

Species the data type that Enterprise Application Integration (EAI) uses to save data from an
integration object. For example:
 

Account - Get Oracle Customer (Oracle)

Name
 

Species the name of the process property.
 

Virtual Field (O)
 

Species the name of the business component eld that Siebel CRM maps to the workow process
property. The drop-down list for the Virtual Field property displays business component elds. It
displays only calculated elds that do not contain a calculated value. The workow process does not
specify this calculation.
 
A workow process does not require you to specify a business component eld as a virtual eld. An
applet can reference a virtual eld in the same way that it references a nonvirtual eld.
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Property Description

 

WF Step  
A WF step denes a step in a workow process.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process > WF Step

The following table describes properties that Siebel CRM uses with a WF step.

Property Description

Allow Retry Flag
 

Not used.
 

Business Component (O)(R)
 

Species the business component eld that Siebel CRM uses to determine the condition.
 
If the Compare to value is Business Component, then the Business Component property is required.
 

Business Service Method
 

Species the name of the business service method that Siebel CRM calls.
 

Business Service Name
 

Species the name of the business service that Siebel CRM calls. The drop-down list for this property
displays business services that include a Hidden property is FALSE.
 

Error Code
 

Species a number that identies a string in the Siebel database that contains the error message.
 

Error Message
 

Species the text of the error message. If you choose a value in the Error Code property, then Siebel
Tools automatically enters a value in the Error Message property.
 

Maximum Iterations
 

Species the maximum number of times Siebel CRM can run this step in a workow process instance.
If it reaches the maximum number of iterations, then it creates an Object Manager error and the
workow process returns an In Error status. If you require the process to run to completion, then you
must congure an object to catch and handle the error, such as an error workow process or exception
branch.
 

Name
 

Species a descriptive name that includes the following characteristics:
 

• Consistent with your overall naming strategy

• Meaningful to the designer of the process

• Unique

If you create a new WF step, then Siebel Tools automatically assigns a name depending on the type of
step and a sequence number. You can modify this name or leave it as is.
 

Operation
 

Species the comparison operation. You can use one of the following values:
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Property Description

• Delete

• Insert

• NextRecord

• PrevRecord

• Query

• QueryBiDirectional

• Update

• Upsert

Processing Mode (O)
 

Species the mode that Siebel CRM uses to run the workow process if a runtime event triggers this
workow process, You can use one of the following values:
 

• Local Synchronous. Runs the workow process in the Application Object Manager. This value is
the default value.

• Remote Synchronous. Sends a synchronous request to the Workow Process Manager server
component to run the workow process.

• Remote Asynchronous. Sends an asynchronous request to the Workow Process Manager server
component to run the workow process.

Subprocess Name
 

Species the name of the subprocess step.
 

Type
 

Species the type of WF step. Siebel Tools automatically enters this value when you create a new step
in the Process Designer. This value is a read only property.
 

Update Snapshot
 

If this property contains a check mark, and if Siebel CRM reaches this step in the workow process at
run time, then it uses a snapshot of the workow process state. It does this so that it can can recover
the state if a system failure occurs.
 

User Interact View
 

Species the name of the Siebel view that Siebel CRM displays.
 

Properties of Dierent Types of Workow Process Steps  
This topic describes properties of the various steps and connectors in a workow process.

The following table describes properties of the start step.

Start Property Value

Name
 

Start
 

Parent Name
 

Workow name:version
 

Processing Mode
 

Local Synchronous
 

The following table describes properties of the business service step.

267



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Business Service Property Value

Allow Retry Flag
 

FALSE
 

Business Service Name
 

Choose the business service name from the picklist.
 

Business Service Method
 

Choose the business service method from the picklist.
 

Name
 

Business service 0. You can modify this value, as necessary.
 

Parent Name
 

Workow name:version
 

The following table describes properties of the decision point step.

Decision Point Property Value

Name
 

Decision Point 0. You can modify this value, as necessary.
 

Parent Name
 

Workow name:version
 

The following table describes properties of the subprocess step.

Sub Process Property Value

Name
 

Sub Process 0. You can modify this value, as necessary.
 

Sub Process Name
 

Choose the name of the subprocess from the picklist. Siebel CRM only displays subprocesses in this
picklist that include a status of Complete.
 

The following table describes properties of the Siebel operation step.

Siebel Operation Property Value

Allow Retry Flag
 

FALSE
 

Business Component
 

Choose the business component name from the picklist.
 

Name
 

Siebel Operation 0. You can modify this value, as necessary.
 

Operation
 

Choose the operation from the list.
 

Parent Name Workow name:version
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Siebel Operation Property Value

   

The following table describes properties of the task step.

Task Property Value

Name
 

Task 0. You can modify this value, as necessary.
 

Task Name
 

Choose the task name from the picklist.
 

The following table describes properties of the user interact step.

User Interact Property Value

Name
 

User Interact 0. You can modify this value, as necessary.
 

Parent Name
 

Workow name:version
 

User Interact View
 

Choose the view name from the picklist.
 

The following table describes properties of the wait step.

Wait Property Value

Business Service Method
 

Sleep
 

Business Service Name
 

Workow Utilities
 

Maximum Iterations
 

Not applicable
 

Name
 

Wait 0. You can modify this value, as necessary.
 

Parent Name
 

Workow name:version
 

The following table describes properties of the stop step.

Stop Property Value

Error Code
 

Choose the error code from the picklist.
 

Error Message If you choose the Error code, then Siebel Tools populates the Error Message property.
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Stop Property Value

   

Name
 

Stop 0. You can modify this value, as necessary.
 

Parent Name
 

Workow name:version
 

The following table describes properties of the end step.

Stop Property Value

Name
 

End 0. You can modify this value, as necessary.
 

Parent Name
 

Workow name:version
 

The following table describes properties of the error exception connector.

Error Exception Connector Properties Value

Inactive
 

FALSE
 

Name
 

Error Exception 0. You can modify this value, as necessary.
 

Parent Name
 

Siebel CRM enters this value from step name.
 

Type
 

Error Exception
 

User Event Name
 

Leave this eld empty.
 

User Event Storage
 

Leave this eld empty.
 

User Event Timeout
 

0
 

WF Step Branch (H)  
A WF step branch connects two workow steps. It controls the data and process ow of a workow process.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process > WF Step > WF Step Branch

The following table describes properties that Siebel CRM uses with a WF step branch.
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Property Description

Event (O) (R)
 

Species the event that this WF step branch supports. The set of events is dierent for dierent object
types. If the Event Object Type property is not empty, then the Event property is required.
 

Event Cancel Flag (O)
 

Species how Siebel CRM handles a cancel runtime event after the workow process nishes. This
property applies only to an event that Siebel CRM can cancel. It is similar to the CancelOperation in a
script.
 
If the Event Cancel Flag property is FALSE, then Siebel CRM creates the following error when the
workow process runs:
 

The specialized method method_name is not supported on 
this business component.

Event Object (O) (R)
 

Species the event that Siebel CRM applies to this WF step branch. The values that you can set in the
Event Object property depends on the value that you choose in the Event Object Type property. For
example, if you set the Event Object Type to BusComp, then you choose only a business component in
the Event Object property, such as Account.
 

Event Object Type (O)
 

Species the type of object that this WF step branch references, such as business component. If the
Event Object Type property is not empty, then the Event Object property is required.
 

Event Visibility
 

Species to use a run-time event that Siebel CRM creates in the current local session or in another
enterprise session. It uses this event to resume a workow process instance that is waiting. If the
workow process is:
 

• Persistent. You can set the Event Visibility property to Enterprise or Local. In most situations if a
workow process must wait for an event, then it must be persistent and you use Enterprise.

• Not persistent. If it is not required that the workow process be persistent, then it is
recommended that you set the Event Visibility property to Local. If Event Visibility is Enterprise,
then a run-time event searches for a matching workow process instance. This conguration can
aect performance.

Name
 

Species the name of this WF step branch. To import or export the workow process, the name must
be unique. If it is not unique, then you cannot commit the record.
 

Subevent (O)
 

Species the name of the method or eld in a business component that Siebel CRM monitors. You
set the Subevent property only if the Object Type property is BusComp or Applet and the event is
InvokeMethod or SetFieldValue.
 
For InvokeMethod, you specify the name of the method that Siebel CRM calls. For SetFieldValue, you
specify the name of the eld that Siebel CRM sets.
 

Type
 

Species the type of WF step branch. You can use one of the following values:
 

• Condition. Use a condition for this task branch.

• Default. If no other conditions are met, then use this task branch. Siebel CRM ignores any
conditions that are dened for this task branch.

• Connector. Do not use any condition branching.

• Error Exception. Use exception handling. This connector type captures system errors. For
example, the Assignment Manager server component is not available.

• User Dened Exception. Use exception handling. This connector type captures errors that you
dene. For example, the user aempts to save an incomplete order.
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Property Description

User Event Name
 

Species a name that describes the user event. You must dene a name that is unique and that is
suciently long so that it remains unique for the Siebel enterprise. For example:
 

Order Placed-Begin Processing Event for Service Request 
Automation-Version 2

User Event Storage
 

Species the process property that Siebel CRM uses as the destination for the payload on the incoming
user event. This value can be a process property. The correlator must mark this process property.
 

User Event Timeout (Days)
 

Species the number days that a workow process waits for a user event to resume operation. If the
user event resides on a wait step, then you use this property. Do not set this property on a wait step.
 

WF Step I/O Argument (H)  
A WF step I/O argument identies the input and output arguments that a workow process step uses. Each step accepts
input from the workow process and sends output to the workow process.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process > WF Step > WF Step I/O Argument

The following table describes properties that Siebel CRM uses with a WF step I/O argument.

Property Description

Business Component
 

Species the name of a business component that the business object references. The workow process
references this business object.
 

Business Component Field
 

Species the name of a business component eld.
 

Input Flag
 

Species if the eld is an input argument, output argument, or a search specication. This property is
read only.
 

Name
 

Species text that describes the purpose of this step I/O argument.
 

Output Arg
 

Species the name of the output argument from the business service. The drop-down list for this
property includes the output arguments that exist for the method you choose. Siebel CRM displays
arguments in this list that include the following:
 

• Dened as an argument on a business service method

• The Hidden ag is FALSE

• Type is Output or Input/Outputp>

Preferred Sequence
 

Species the order that Siebel CRM uses for this WF step I/O argument. For Oracle internal use only.
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Property Description

Property Name (R)
 

Species the name of the process property that Siebel CRM uses to save the value of this WF step I/O
argument.
 

Sequence
 

Species the order that Siebel CRM uses for this WF step I/O argument for upgrade purposes.
 

Type (R)
 

Species the type of argument.
 

Value/Search Specication
 

Species a search specication. If the Type property is Expression, then enter the Value/Search
Specication property must contain an expression. For example:
 

[Status] LIKE '*Open*'

The Expression business component evaluates this expression.
 

WF Step Recipient (H)  
A WF step recipient use a step recipient to assign a workow process to a user. This assignment occurs according to
login name. This login name can be a literal value, contained in a process property, or the result of an expression.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process > WF Step > WF Step Recipient

The following table describes properties that Siebel CRM uses with a WF step recipient.

Property Description

Business Component Field
 

Species the name of a business component eld.
 

Business Component Name
 

Species the name of a business component that the business object references. The workow process
references this business object.
 

Expression
 

Species an expression that evaluates a value. it evaluates the expression that the Value column
contains. If this expression references a business component eld, then you must enter the name
of the business component that contains this eld. You enter this value in the Business Component
column.
 

Name (R)
 

Species the name of this WF step recipient.
 

Process Property Name (R)
 

Species the name of a process property.
 

Recipient Name
 

Species the login name of the user.
 

Recipient Type Code
 

Species the type of this WF step recipient. You can choose only User.
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Property Description

Value Type Code
 

Species the value type code of this WF step recipient.
 

Workow Process  
A workow process allows you to use a familiar owcharting interface to dene the business processes that your
company uses. A workow process includes one or more process steps, such as start steps, subprocesses, decision
points, and tasks.

This object type occurs in the following location in the object hierarchy:

• Siebel Objects > Workow Process

The following table describes properties that Siebel CRM uses with a workow process.

Property Description

Auto Persist
 

If TRUE, then this workow process is persistent.
 

Business Object
 

Species the name of the business object that this workow process references. Optional. The drop-
down list for this property displays only business objects that include a primary business component.
 

Eective End Date
 

Species a date that Siebel CRM uses to retire this workow process. For example, you can set the start
date to a future date and set the end date for the existing version to the same date. Siebel CRM uses
the new version starting on this date.
 

Eective Start Date
 

Species a date that Siebel CRM uses to start using this workow process.
 

Error Process Name
 

Species the name of a workow process. If the workow process on which you specify the Error
Process Name property encounters an error, then it runs the workow process that you dene in this
property.
 

Group
 

Species the name of a group. This group allows you to group similar workow processes according to
your criteria, such as all the workow processes that support a particular business process. To dene
this group, you use the List of Values view in the Application Administration screen in the client.
 
This property only applies to workow processes before Siebel CRM version 7.7. Starting with version
7.7, it is recommended that you do not use this property. You can use the Project property instead.
 

Name (R)
 

Species a name for this workow process.
 

Pass By Ref Hierarchy
 

If TRUE, and if this workow process is a subprocess of another workow process, then Siebel CRM
uses a reference to send any modications it makes in this workow process to the parent workow
process. This property can reduce the amount of memory that a workow process requires because
Siebel CRM sends data through a reference instead of sending a value.
 

Process Name Species a name that describes the work that this workow process performs.

274



Siebel
Object Types Reference

Chapter 3
Siebel Object Types Reference

Property Description

   

Replication Level
 

Species how Siebel CRM synchronizes this workow process with a Mobile Web Client. You can use
one of the following values:
 

• All. Synchronize this workow process to all Remote users and to all regional nodes of the Siebel
Server.

• Regional. Synchronize this workow process only to regional nodes.

• None. Do not synchronize this workow process.

State Management Type
 

For more information, see State Management Type Property of a Workow Process.
 

Status
 

Displays the current status of this workow process.
 

Version
 

Displays the version number of this workow process. The default version is 0. Siebel Tools increments
this version number by one each time you revise this workow process.
 

Web Service Enabled (O)
 

If TRUE, then Siebel CRM exposes this workow process as a Web service and can independently call
it. Seing this property to TRUE does not automatically implement the workow Web service. Dening
the workow process for a Web service does not set this property to TRUE.
 

Workow Mode
 

Species the mode that denes the runtime conguration of this workow process.
 

State Management Type Property of a Workow Process  
The State Management Type property species the type of business service request that Siebel CRM sends while this
workow process runs. A stateless business service does not depend on a state that is specic to the business service.
You can set this property to one of the following values:

• Stateful. The Object Manager does not release a stateful or cached business service that the workow process
calls if the user pauses or nishes an instance of this workow process. The Object Manager waits for the object
that called the Workow Engine to release the cached business service. To release this business service, the
caller can use methods from the Web Channel Dedicated Block Service business service.

• Stateless. The Object Manager releases a stateful or cached business service that a workow process calls if the
user pauses or nishes an instance of this workow process.

Every business service that this workow process instance calls must be stateful or stateless.

The session state for the Object Manager requires a business service to contain a state management type. You must
dene a business service as Stateless or Stateful, or as a business service that the the Siebel Server manages.

For more information, see the following.and  Siebel Business Process Framework: Workow Guide .

How the Workow Mode Aects the State Manage Type
Siebel CRM sets the State Management Type property of a workow process to Stateful, by default It does this to
preserve the behavior for releases that occur earlier than Siebel CRM 8.1. If a workow process runs through Web
Channel, then it might be necessary to modify the State Management Type to Stateless to take advantage of the session
pooling that the Object Manager provides.
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The following table describes how the Workow Mode property of a workow process aects the State Management
Type property.

Workow Mode State Management
Type

Description

Service Flow
 

Stateless
 

A service workow process cannot contain a user interact step or wait step.
Siebel CRM runs the entire workow process before the Object Manager can
release the session back to the session pool.
 

Interactive Flow
 

Stateless
 

An interactive workow process can move between sessions through the
Universal Inbox. The State Management Type property is relevant only if the
workow process runs through Web Channel. An interactive workow process
runs in a user interactive session so the State Management Type does not aect
the behavior of an interactive workow.
 

Long Running Flow
 

Stateless
 

The Workow Engine allows a long-running workow process to run between
sessions even if the user pauses this workow process.
 
It is recommended that you do not dene a long-running workow process
to call a stateful business service because Siebel CRM loses the state of this
business service if the instance of a long-running workow process moves from
one user session to another user session.
 

7.0 Flow
 

Stateful
 

Do not modify this seing unless you are sure none of the business services
that the workow process calls directly or indirectly is a stateful business
service.
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